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Updates:

Version 1.0:

 

YAHOO!  The biggest DROMED tutorial on the web is HERE!

 

Version 1.1:

 

Corrected spelling and grammar

 

Version 1.2:

 

Corrected additional spelling and grammar

Removed excessive “Next”s, and “Now”s

Added “FnordLocks”, “Objectives: KOs”, “Objectives: Kills”, “Undercover-Style Missions”, “Assassins-Style Missions”, “Dynamic Lights”, “Reverse and Final”, “Updates”, “How to Get Effects Started at the Mission’s Beginning/Loops”, and “U, V, and Scale – Aligning Textures”

Removed the tips concerning upping the maxes…my mission CRASHED because of this (used to be in “Troubleshooting”)

Added a note about DarkLoader and DROMED working together in the “Starting Up” section…read this, it’s important

Added a note in “Conversations”, about roombrushing actors…read this, it’s important

 

Version 1.3:

 

Fixed more grammar and spelling

Started a new conversation listing convention, updated throughout

Page count at letter-size is now: 89

Added: “Garrett and Dynamic Lights”, “Blueroom Conversations”, and “Saving Precious Object IDs”

Updated: “Assassins-Style Missions” extensively

Added: “M-KnockedOut”, “M-ResettingLockbox”, and “M-NeverEfficient” to the list of useful MetaProperties in the “MetaProperties” section

Fixed the “Don’t Inherit” mistake…I had people checking it when they shouldn’t have…see “Useful Scripts” for more info…this update affects the following sections: “Lockboxes”, “Undercover-Style Missions”, “Useful Scripts”, and “Switches and Buttons”

Fixed the “TerrPathInit” link problem in “Elevators”, I’d forgotten to tell about the crucial link data…thanks goes to fellow T1/G loyalist EmperorSteele

Updated “Inventory”

 

Version 1.4:

 

Fixed a problem in “Dynamic Lights” and “Garrett and Dynamic Lights”, where in the gamesys in multi-mission packs were adversely affected!

Clarified a few issues in “Garrett and Dynamic Lights”, I’d suggest a re-read

Page count at letter-size is now: 107…YEAH!!!!  I hit 3 digits!

Fixed a problem in “FnordLocks”

Totally re-did “Sources and Receptrons”, now info is easier to find, and generally more abundant!

Added the “Gates” section…some useful information here

Added “Triggering From Inventory Frobbing”, provoked by my own bad experiences with this certain subject

Added “Candles”…seeing how there was such uproar about them on TEG a couple days ago

Added “The Player and the StartingPoint”, which contains important information about referencing to the avatar “Garrett” in-game!

Added “CamVator Sequences”

Fixed “Elevators”…AGAIN!

Added some info in: “Containers”

Fixed “The Infamous AIWatchObj Link”

Fixed data on “SecureDoor” script, and added documentation of the “M-SecureDoor” metaproperty

Added the “Tweq” section.

 

Starting Up

 

Before you can do any DROMEDing of any kind, you must, obviously, download and install DROMED.

 

Please note that this tutorial deals with DROMED 1.32, not DedX or DROMED 2, although most of the methods mentioned here could most likely be carried over into the aforementioned programs.

 

Note: My tutorial aspires to cover EVERY aspect of DROMED 1.32.  Even though most of the methods mentioned here could be crossed-over, this tutorial certainly doesn’t cover all the features that are available to Thief 2.

 

You can download DROMED from http://www.thief-thecircle.com.

 

Before you even THINK about installing DROMED, ensure that ALL FMs are uninstalled, by going into DarkLoader and “Install Only” “Thief 1 Campaign”.  (Only applicable if you actually have DarkLoader installed on the copy of Thief you’re looking to use for DROMEDing…I suggest a separate install for DROMED, but if you don’t have enough HD space, just make sure all FMs are un-installed before you fire-up DROMED…unless you’re using the “DROMED” button in DarkLoader, in which case, don’t bother un-installing.)

 

Open the ZIP archive, which contains DROMED, and unzip all the files to your “Thief” directory.  You will be asked about overwriting, when the first on pops up, hit “Yes to all”, once this is done, go into your “Thief” directory, find “DROMED.exe”, right-click on it, and hit “Create Shortcut”.  Now cut this shortcut, and place it wherever you want, start menu, desktop…

 

There are a couple of essentials you should download, these can be found at DROMED Central (http://www.thief-thecircle.com/dromed/) under “Tools” or “Essentials”.

 

These essentials are:

 

KoMaG’s custom menus for DROMED 1, Thief Objective Wizard, Thief Book Wizard, Thief Text File Wizard, and Thief Mission Zipper.  Download them all, and install them as per their readmes.

 

There, start-up DROMED, and get ready to create some FMs!

 

What’s all this?

 

Okay, do NOT PANIC!  DROMED is an extremely simple editor, but looks daunting.  Mainly because of the blacks and purples, rather than the blues and grays we’re used to!

 

You’ll see that we have a box down in the lower-right-hand corner.  That’s the “command box”.  You type commands there, we’ll use only a few commands, but they’re crucial!

 

You’ll also see, in the middle of the screen, four boxes, labeled “right”, “3D”, “Top”, and “Front”.  Okay, the top view is the one you’ll be using most, it’s known as the “Plan view” by most DROMEDers.  You’ll see in the three 2D boxes (Front, Top, and Right), that there’s a box, which occupies 4x4x4 grid squares.  Okay.  This is a good time to tell you exactly what this box is…it’s a “brush”.

 

A brush is anything in the DROMED (or Thief) world, which is created and manipulated!  There are many different types of brushes, the basic ones are:

 

TERRAIN:

 

-Fill Air: Fills encompassed space with air.

-Fill Solid: Fills encompassed space with solid.

-Fill Water: Fills encompassed space with water.

-Flood: Turns all air in encompassed space into water.

-Solid-Water: Turns all solid in encompassed space into water.

-Air-Solid: Turns all air in encompassed space into solid.

-Solid-air: Turns all solid in encompassed space into air.

-Evaporate: Turns all water in encompassed space into air.

-Blockable: Useless

 

OBJECT:

 

-Physical: Normal objects.

-Lights: Objects that give off light.

-Fnords: Invisible objects that create effects.

-SFX: Visible particle effects.

-Sound: Sounds (not usually created, but they are referred to via links quite often).

 

ROOM:

 

-Default: Ordinary roombrush (allows for sound propagation).

-Other: Roombrushes you create to create effects, such as ControlDevice links, or automaps.

 

AREA:

 

Area: Allows for manipulation of individual areas within area brushes.  Extremely useful for complex levels.  Surround an area and hit “Me Only” to see only the brushes contained within that area brush!  Click on any area brush and hit “Show All” to see your whole level again.

 

FLOW:

 

Flow: Allows for the precise manipulation of water (e.g.: Water that flows, water that is lava, green or blue).  See “Flow Brushes” for more info.

 

These brushes can be created by clicking on the buttons in the lower-center of the screen, labeled according to the type.  In order to create the different types of TERRAIN brushes, when you click on “Brush” (Terrain), use the arrows to the left and right of “OP” to change the brushes operation…this can be done by selecting an already created brush, or by setting this before creation!

 

The type of OBJECT to be created by an OBJECT brush can be changed by hitting EDITORS-OBJECT HIERARCHY, then selecting a type of object (archetype) and hitting “Create”, now drag to create this type of object!

 

Manipulation

 

Okay, we now understand WHAT we see, but, once we’ve created it, how do we move it?  Okay, here goes.

 

You can move brushes many ways.  The most precise being X,Y,Z,W,D,H,H,P,B.

 

These are the values you see on the lower-left of your screen…we’ll work right to left, top to bottom explaining these values!

 

X – The brush’s current X-axis co-ordinates (should NEVER BE ZERO!  THIS IS CRUCIAL!)

Y – The brush’s current Y-axis co-ordinates (should NEVER BE ZERO!  THIS IS CRUCIAL!)

Z – The brush’s current Z-axis co-ordinates (should NEVER BE ZERO!  THIS IS CRUCIAL!)

H – The brush’s current heading in degrees

P – The brush’s current pitch in degrees

B – The brush’s current bank in degrees

W – The brush’s current width in approximate feet (should NEVER EXCEED 250!)

D – The brush’s current depth in approximate feet (should NEVER EXCEED 250!)

H – The brush’s current height in approximate feet (should NEVER EXCEED 250!)

 

There!  Now, you’ll notice that above all this, there is an indicator that reads: Grid Size: 16.  Okay, this is your grid size, which denotes snap size.  Try not to work below 11, and don’t work above 16, after that it gets too big!

 

Okay, here are your Number-Grid-Snap sizes.  Number is the number size of the grid…16 for example, grid is the size of the visible grids, and snap is the smallest dimension you can have with that snap size, 11-16 are provided:

 

Number
Grid
Snap

 

16
4
8

15
2
4

14
1
2

13
0.5
1

12
0.25
0.5

11
0.125
0.25

 

As you can see, you’ll rarely need lower than 11.  And remember that object-type brushes DO NOT SNAP!

And never turn snap off, if you do, you’ll get tons of errors because the lines aren’t snapped!

 

Okay, now you’ve made so many cubes that you’re bored of cubes, and you want to make different shapes!

 

So, let’s create more shapes!  Go to Shapes, and click on a shape, now you can create that shape!

 

Here are the shapes supported by the DARK ENGINE:

 

Cube

Cylinder

Wedge

Decahedron (10 sided geometric shape)

Pyramid

 

Okay, so you’ve tried creating a cylinder, but ended up with a “cube” rotated 45 degrees.  That’s just not right!  So, with “cylinder” shape selected, hit Shapes-Sides in Shape, and type “10”, now drag to create!  There, a 10-sided cylinder.

 

Tip: Don’t have more than 10-sides in your cylinders…if you have more than that, the DARK ENGINE spends too much time processing the sides, and you get slowdowns.  Think about the people with slow PCs.

 

Note: You can add extra sides to Cylinders and Pyramids.

 

“Align by side” and “Align by vertice” determine how DROMED snaps the brushes…if “Align by side”, DROMED will snap the sides of the brush, “Align by vertice” will make DROMED snap the vertices of the shape.

 

Okay, so, you now want to move your brushes, or manually resize them (imagine THAT!).  Here are the DROMED hotkeys:

 

Shift – Hold and drag to move a brush

Ctrl – Hold and drag to resize a brush

Alt – Hold and move to rotate a brush

 

W – Move your camera (the little purple thing) forward

X – Move your camera backwards

A – Rotate your camera left (the purple line indicates where you’re facing)

D – Rotate your camera right

R – Look up

V – Look down

F – Center view

1 – Bank left

3 – Bank right

2 – Center banking

Q – Strafe left

R – Strafe Right

Z – Strafe Up

C – Strafe Down

Comma – Select next brush face

Period – Select previous brush face

Right Click – Bring up the menu (when over one of the views), allows you to teleport camera, hide the grid, etc.

Enter/Return – Implement a typed command

- - Zoom all views (except 3D) out.

+ - Zoom all views (except 3D) in.  (Do not use SHIFT to activate this command)

Delete – Deletes the selected brush.

 

There, those are the hotkeys you’ll be using.

 

General Know-How

 

Okay.  First, let’s tackle the little problem of realizing the textures!

 

If you look to the center-bottom of your DROMED window, you’ll see a picture of this funky texture called: “Jorge”.  Now, if you hit Alt+T, you’ll bring up the “Texture Palette”, which is where all the loaded textures are kept.

 

When the palette appears, there will be one texture: “Jorge”, and four buttons: “Sky”, “Put on Brush”, “Remove from Level”, and “Done”.  Let’s see what each of these five buttons does.

 

Jorge – This is a texture, click this and click “Put on Brush” to put the texture on the selected brush face.

Sky – This is the sky texture.

Put on Brush – This button puts the selected texture on the selected brush face.

Remove from Level – Remove the selected texture from your level.

Done – Closes the palette.

 

Okay, now we need more textures!  Click in the command window and type: “add_family core” (no quotes), then hit ENTER.  Now at the bottom of your screen it should say: “Family Loaded”.  Now hit Alt+T and you’ll see that tons more textures are available!

 

Now, it’s good to know the command to load a texture family, which is “add_family XXX”, but it’s easier to use KoMaG’s custom menus to our advantage.  Click “Textures 1” and hit “Rescore”.  This will load the texture family “Rescore” into the palette.  Now, if you don’t like a texture family, and want to get rid of it, type “remove_family XXX” into the command window and hit ENTER.

 

Now, let’s say you’ve loaded two or three families, but you’ve only used a couple textures from each.  Now, you’re palette is nearly full, and you need more textures!  Oh no!  What’ll you DO!

 

Merely type the following in the command window and hit ENTER: “compress_family all”.  There, now if you open your palette, only the textures used in the level will be there!  Feel free to load another family!

 

Now, there’s something VERY IMPORTANT that we must do before we go any further.  Our level won’t work properly if we don’t load the scripts!  So, type (in the command window): “script_load convict” and hit ENTER.  At the bottom of your screen you should see: “Module Loaded”.  We’ve now loaded all the scripts Thief uses into your level.  There, now we’re free to go on!

 

Note: GayleSaver’s Custom Scripts are not covered by this tutorial.

 

Really Getting Started

 

Okay, now we’ve learned hotkeys, learned about textures and objects, brushes also, we’ve also covered creating and manipulating, but how do we actually make a level?  Okay, let’s go!

 

First, there’s a command you should know about.  Until you add light sources, you’ll want to completely illuminate your terrain brushes so you can look at them until you get around to light sourcing, so, type this into the command window and hit ENTER: “light_bright”.

 

Okay, now we want to get a look around us.  Right-click on the 3D window and hold the right mouse button down, now drag the mouse pointer down to: “Solid World”, and release.

 

Don’t scream and yell if noting happens.  Tap “W” once so you move (and activate light_bright), now, nothing will happen (in the 3D box, at least).

 

Now go up to Tools-Portalize.  Portalizing calculates all the brushes. While objects and changes to objects appear in the world instantly, in order for changes to brushes to appear (texturing excluded), you must portalize.  That’s what we’re doing!

 

Remember that the more brushes you have, the longer portalizing takes!  Since we only have the default brush, a 16x16x16 Jorge brush, this shouldn’t take very long.

 

Once portalizing is done, you’re 3D view should light up, and show a 16x16x16 expanse of air textured with Jorge.  You can move around if you like, but it’s not like there’s much to see!

 

Why don’t we do something cool to show off our texturing prowess?  Okay, look down to the “Face” indicator; it should say “Default”, which means all the faces that HAVEN’T been set to a different texture.  (You can set a face, say “Top” back to default by selecting it and typing “-1” in the texture box (remember that you don’t include the quotes).)  Okay, since we have the core texture family loaded, we should have some options to choose from.

 

Hit Alt-T and select a texture that looks outdoorsy.  Hit “Put on Brush” and “Done”.  There!  You’re room has magically been transformed!

 

Now, I said earlier that this is going to be outdoorsy.  So, it needs a sky!  Hit comma until the “Face” indicator reads “Top”.  Then hit Alt-T, select “Sky”, hit “Put on Brush”, and hit “Done” or Alt-T to close the palette!

 

There!  A perfectly good outdoor area, but it’s a bit small!

 

Before we go any further, we need to get this default brush AWAY from the incriminating 0,0,0 world co-ordinates (I’m sure I mentioned this earlier).  I good value is 500,500,500, so, implement this!

 

Zoom out until you can see your brush, then teleport into it on all 3 2D views.  Now let’s make this brush bigger!  A courtyard should be HUGE!  Make the brush 32x32x32.  There, now portalize!

 

You’re probably wondering, “How does Garrett know to start out in this brush?”

 

The answer, sorry to say, is HE DOESN’T.  If you don’t have a “StartingPoint”, Garrett will automatically start out at the co-ordinates 0,0,0, and won’t be physical!  He’ll be able to walk through objects; go unnoticed by the AI, it’d be a catastrophe!  So, let’s rectify this little problem of ours!

 

Go into the “Object Hierarchy”, and hit the plus arrows beside the following things (all in levels beneath the last): Fnord.  Now select “Marker” (the words, not the plus sign), and hit “Create”.

 

There, object brush type is now Marker!

 

Drag to create the marker, and then use SHIFT to position the newly created Marker in the center of your room.  Now, if you look down, you’ll see that the window in the center-bottom reads: “A Marker (1)”, or any other suitably low number, like “2”.  This number is the OBJECT NUMBER!  Object numbers are important for linking, and for you.  It’s recommended you don’t have more than 2000 objects.  That may sound like a lot, but it really isn’t.

 

We don’t want our StartingPoint to be called “A Marker”.  No, that’s stupid!  So, hit the “Properties” button below the object’s name and number.  This should bring up a daunting dialog!

 

We’ll learn more about properties later.  For now, click on the top property, which is the object’s name and number, then hit “Edit”.  Type “StartingPoint” in the pop-up dialog, then hit Enter, and dismiss the properties box.

 

Now our StartingPoint is called just that!

 

Click the “Links” button.  This should bring up an empty box.  That’s because our marker isn’t linked to anything!  But, we must link it to Garrett himself!

 

Hit “Add”.  Then fill out the ensuing box like this:

 

Flavour:
PlayerFactory

From:
StartingPoint

To:
Garrett

 

Now hit “OK”.

 

Let’s figure this out, okay?  The “Flavour” of a link is the type.  There are HUNDREDS of links!  Links make objects react to one another.  For example, a link makes the buttons at Ramirez’s trigger the alarm!  “From” is the object or archetype the link originates from, and “To” is the object or archetype the link goes to!

 

Let’s dismiss the links window for now.  We no longer require its services!

 

One last thing, click on the StartingPoint, and hit “Properties”.  Now Add-S-Scripts, in the first box type “VictoryCheck”, then hit enter, and hit “OK” to dismiss the properties box.

 

We’re going to let you go in-game.  Which means you’ll pop into game mode.  Please note that in order to get back into the editor you’ll have to hit Alt-E.  Also note that you’ll have NO WEAPONS OR INVENTORY ITEMS.  There will be NO SOUND!

 

Okay, go in-game by pressing Alt+G!

 

There, wasn’t that enjoyable?  I’ll bet you wish there was a bit more to explore, don’t you?

 

Expanding

 

Why don’t we create some more rooms?  You know how!  Adjust the grid size accordingly, and make sure that you leave some space between rooms.  If you don’t, there will be no walls, and that will look VERY funky.

 

Okay, now you have several rooms!  Congratulations!  But…if you pop in-game, you can’t actually get into them…very weird!

 

Let’s make doors.  First, we need some doorways.  So, set the grid size to “15” and create a brush that is 4x4x8.  This assumes, of course, that your walls are four feet thick.  If they’re bigger or smaller, adjust the brushes depth or width accordingly!

 

Now, position this brush level with the floor, and between two rooms.  Texture it, and portalize!  There, a beautiful doorway…without a door?

 

Remember to use Heading (H) in degrees if your doorway isn’t oriented correctly with the wall!

 

Let’s create a door!  Go into Object Hierarchy-Physical-TerrainLike-Doors-SpinnyDoor-4x8 door-MetalDoor21, hit “Create” and then “OK”.

 

Now create this door, fiddle with its heading until it faces properly, and position it inside the doorway, so that the door’s left and right align with the brush’s left and right, and so that the door’s top and bottom align with the same faces in the brush.  And remember, if your door opens the wrong way, you can always turn its heading +180.

 

Pop in-game.  The door works, no?  If the door disappears into the wall, just use SHIFT and move it a little away from the wall it disappeared into.  If you zoom in you can work with more precision…

 

There, you have a door!  Why don’t you try out different types of doors?  Go ahead, I can wait!  (Remember that if the door is smaller or bigger than 4x8, you’ll have to adjust the doorway size and portalize!)

 

Okay, so you’re finished playing, and you want to know more?  Good thing I know more than just about doors and brushes!

 

Now, why don’t we lock a door?  Hmm?  We’ll give Garrett the key later, but now we want to make the door locked AND unlockable…yes, that’s right, you can make a door that can’t be unlocked…but don’t be cruel by hiding treasure behind those doors, use those to add realism while not taking up your time…most useful in city maps!

 

Okay, open up the door’s properties, and Add-Engine Features-Locked.  Check the box and hit ENTER.

 

Now your door is locked, and unlockable…that was simple, wasn’t it?

 

Let’s add the property to assign a key to a door!  Add-Engine Features-KeyDst, leave MasterBit alone, make RegionMask “1”, and make LockID a number of your choosing.

 

Flow Brushes

 

Normally, if you create a water brush, all you’ll see is Jorge.  That’s not very fun, is it?

 

So, let’s learn about FLOW BRUSHES!

 

First, create a little pool of water.

 

Good, now encompass the water with a flow brush.

 

An important note: Flow brushes and solid brushes may not share the same center point!

 

Okay, there are two bonuses to flow brushes: 1. You can make the water blue, green, or lava!

 

Now, hit “Edit Group”.  In “Texture Name” type “bl”.  There, blue water!

 

The second bonus is water current!  Use the boxes that read:

 

X change/sec

Y change/sec

Z change/sec

 

This is the current, in feet per second!  Z is up and down, down is a negative number, X is north and south, north is a negative number (North is “up” on-screen in the “Top” or “Plan” view), and Y is east and west, west is negative.

 

Garrett’s Inventory and Weapons

 

Let’s create some weapons to give Garrett.  Find them in the hierarchy and create them around your marker.

 

Done?  Now, link them all to the StartingPoint with a “Contains” flavour link.

 

Now, if you gave Garrett arrows or inventory items, you should realize that there’s a better way to give Garrett 45 broadheads than by creating 45 separate objects and linking them all to the StartingPoint!

 

Quite simply, pull up the Properties window, and Add-Engine Features-Stack Count.  In the pop-up, type the number you want that object to be worth, and hit ENTER.  Then “OK” the properties window!  Remember, this can be done with ANYTHING.  Carrots, treasure, arrows, flash bombs…anything.

 

Note: On crystal arrows: If you want Garrett to have a moss arrow to start off with, give him an EarthArrow object.  If you want him to pick up a moss arrow, create an EarthCrystal, found under Physical-Tulz-Crystals.  Simply put, Garrett should receive arrows to start off, should pick up crystals.  Doing it the other way around, or just giving crystals or arrows, causes…you guessed it!  Thief crashes.  So predictable!

 

That wasn’t so hard, was it?

 

Inventory

 

So, you don’t want keys to appear in your inventory as just: “Key”.  Well, here’s the solution.  But first, ask yourself:

 

Do you plan to include multi-language support?

 

If you answered:

 

Yes

 

Then go open strings.crf in your “Thief” directory, and extract objnames.str to “Thief\Strings\English\”

 

Now open up objnames.str in notepad, and, at the bottom of the list, type:

 

Name_XXX:“YYY”

 

Make XXX one word that describes your object, and that is not included anywhere else in as a title in objnames.str.  So, MyBasementKey would work.  YYY is what you want that object to be named.

 

Now, go back into your level, and open up the properties for the object you want to name.  Add-Inventory-Inventory Name, and type Name_XXX in the field that appears.

 

If you answered:

 

No

 

Then open up the object’s properties, and Add-Inventory-Inventory Name and type: Name:“XXX” where XXX is the name you want the object to be.

 

Now, say you’ve created a scroll (See “Readable Items”), and you want the player to be able to buy it…for 1000 loot.  If you don’t slap a price on it, it will appear as FREE!  No, Thieves don’t get free info.  So, Add-Inventory-Purchase Price, and type in the amount!

 

You’ve got this scroll, with a name and a price…but it’s got no description?  So, open up strings.crf and extract objdescs.str to “Thief\Strings\English\”

 

Now insert your description at the bottom, and Add-Inventory-Long Description.

 

For more info on creating stores, see “Creating a Store”.

 

To change the frob distance of an object, Add>Inventory>Max Pick Distance, and set it to a number in feet.

 

To change an object to/from junk to an item or weapon, Add>Inventory>Type, and select the appropriate type.

 

To make it so you can’t drop an item, Add>Inventory>Can’t Drop This, and set to “TRUE”.

 

We continue

 

Okay, now let’s create that key I promised you.  Create a Physical-Key-Key1.  Remember that of the keys, only the numbered keys are really keys.  The KeeperKey is that weird-looking key that unlocks the Lost City.

 

Now, create the key and link it to Garrett.

 

We have to assign it to the door we locked.  Open it’s properties and Add-Engine Features-KeySrc.  Fill out this dialog EXACTLY as you filled out the door’s KeyDst.

 

There!  Go in-game, and unlock the door!

 

Resizing objects

 

You may or may not have already tried resizing an object…and failed.  If you resize a Physical-Furniture-Tables-Table to, say 60x20x3, you can walk straight through most of the table!  Aah!

 

Don’t panic…like most things, there’s a quick solution!

 

Open up the table’s properties, and adjust Physical-Dimensions, and adjust these values to the appropriate setting!

 

Please note that DROMED treats all objects as squares…which is why they appear this way on-screen!

 

Sound

 

By now, you’re probably REALLY angry at me, because your level is MUTE.  That can be rectified!  Select each of the brushes in your level in turn and press Shift+Insert.  A little purple box should spring up to encompass each of them. Now, once you’re done, click on one of the them, and press “Compile”.  Now go to each roombrush in turn and (if you wish) assign it an EAX value.  The following are the EAX values assignable.  Remember that in order to assign an EAX value, press Ctrl+the function button numbered to the EAX setting.  For example, Small Dead is EAX setting “1”.  To assign it to a roombrush (once you’ve “compiled”), hit Ctrl+F1.

 

Here’s the chart:

 

1
Small Dead

2
Small Normal

3
Small Live

4
Large Dead

5
Large Normal

6
Large Live

7
Dead Hallway

8
Normal Hallway

9
Live Hallway

10
Tunnels

11
Caverns

12
Sewers

 

There!  Now you have an EAXed, roombrushed level!  Now, before we go in-game, we must process the room database and the AI Room Database!  Hit Tools-Build Room Database, and Tools-Build AI Room Database, then go in-game.

 

Isn’t the sound wonderful?  Enjoy it, and use it!

 

And remember, each time you change a setting on a roombrush, build the AI Room Database and the Room Database.

 

Saving

 

Save often!  Create a directory inside your “Thief” directory named after your mission.  Every time you save, save under a different number.  Say your mission is called “BaffTaff” (which my mission is), save like this “BaffTaff_1.mis”, “BaffTaff_2.mis”, on and on…

 

Doors

 

How, you wonder, does something become a door?  Well, first it needs a script, then it needs a property.

 

Let’s explain it!

 

Create a BaffBanner.  It’s in the decorative archetype.  Now, let’s turn this simple BaffBanner into an opening-closing rotating door.

 

Open the properties, Add-S-Scripts.  Type “StdDoor” in the first box, then hit ENTER.

 

There, that’s your script.  If you want the door to be locked, and have lock sounds, add another script in the line below.  “LockSounds”, there, that wasn’t so hard!

 

Now, the property!  Add-Door-Rotating.

 

This box may look daunting, but we don’t want much out of it!  Door speed interests us, open angle and closed angle interest us, Clockwise?, and Axis interests us.

 

The clockwise? check box is fairly straightforward!  If you want the door to open clockwise, check it, if you want it to open counterclockwise, uncheck!

 

Now, axis.  The default is Z-axis, change it if it suits you!

 

The open angle is relative to the angle the door is at.  So if the door’s heading is 70, the open angle will be 70+it’s value.  If the door opens counterclockwise, the open angle should be 90, if it opens clockwise, the open angle should be 270.  Closed angle is usually 0.

 

Now, implement all this, and hit ENTER.

 

Now, there’s one more property we need.  We need to tell DROMED that we want the StdDoor script to activate when the banner’s frobbed.  So, Add-Engine Features-FrobInfo.  It’s all set to [None].  Change WorldAction to “Script” by checking “Script” in the drop-down menu.

 

There, go in-game and try it out…it works, doesn’t it?

 

Now, create a bed.  Now, make sure you don’t use the “Bed” archetype, because those crash DROMED.  Use “BedParts”, those work!

 

Now, add the “StdDoor” script, “LockSounds” if needed, and add the FrobInfo.  Now, here’s the uniqueness of a translating door!

 

Add-Door-Translating.  This dialog is similar, but not the same.  The axis’ work the same, but there’s no “Clockwise?”.  The closed value is usually 0, and the open value is how far along the chosen axis you want the object to slide before stopping.  If you want the object to move the opposite direction, use a negative value.

 

There, check it out!  Wonderful stuff, huh?

 

Switches and Buttons

 

Switches and Buttons are special objects that are used in many instances to create effects.  They emit ControlDevice signals.  Buttons emit one-type of ControlDevice signal (“TurnOn”), which is useful for activating one-way effects, such as alarms, or DestroyTraps.

 

Switches, however, use on/off ControlDevices, which is useful for things that must be turned on AND off.  Such as doors or lights.

 

ControlDevices are a complex subject, but I will try and make you well informed as I can.

 

The following are the scripts I know of the produce ControlDevice signals:

 

StdLever

On/Off (default on switches)

StdButton

Single Fire (default on buttons)

TrigSlain

Triggers a single fire when something is slain

TrigUnlock

Triggers on/off based on a lock’s state

TrigDoorOpen

Triggers on/off when a door opens/closes (uncheck “Don’t Inherit”, see “Useful Scripts”)

TrigRoomPlayer

Triggers when a player enters a room.

TrigWorldFocus

Triggers when the object is focused on in-game.

 

You can also use alert responses and conversations to trigger ControlDevices, but that’s discussed later!  And remember, on/off ControlDevices can, in theory, operate single fire objects.  For example, a switch can trigger a DestroyTrap on its first frobbing, but after that will be useless.

 

Tip: If you find that you must frob a switch twice to get something to work, try linking the switch to an inverter, and an inverter to the target object(s).  An inverter reverses the sense of links passing through it.

 

Remember, if you’re using a switch to open/close a door, make the door’s WorldAction FrobInfo: “Script,Ignore”, so you can’t bypass the switch by frobbing the door directly…especially portcullises, a frobbable portcullis is cheesy, period! 

 

Also remember that a switch’s state can be changed by ControlDevice linking to it.  For example, if you want two switches to stay in the same state as the other, always, link them back and forth to each other, then link one (only one) to the target object.  Chain as many switches as you like!  Remember that for this to look realistic, both switches must start off in the same state, otherwise you’ll have to frob either one twice to get the other to change states.

 

You can “reverse” a switch so that it sends an “Off” ControlDevice initially, and, so that it appears “down” rather than “up” by opening it’s properties, selecting: “JointsState”, hitting “Edit”, and changing AnimS from “[None]” to “On”.

 

You can “lock” a switch by locking it and giving it “KeyDst”, “PickCfg” (see “Lockpicks”), or “Lock”-link, and then have it either: A. Just locked.  Or B. Locked like the smelting levers in Cragscleft, which make a BUZZ, and lights up a lamp when it’s frobbed without unlocking or without them being unlocked.  Just find that lamp (open up an unstripped version of Cragscleft in DROMED, and find the smelting center, and the lamp), and make a “ScriptParams” link from the lever to the lamp, fill in the data with this: “ErrorOutput”, now, isn’t that something?

 

Containers

 

Okay, now you can make switches, you can make doors and lock them, make Garrett, make sound.  But you can’t make those nifty footlockers!

 

Find them in Physical-Containers-FootLocker.  Create one, and create an object to go in it.

 

Now, link the FootLocker to the contained object with a “Contains” flavour link.  There!  It works!

 

You can turn anything into a container by adding the script “Container”, and changing the FrobInfo>WorldAction to “Script”.

 

Also remember that you CAN place multiple things in a container, however this could become extremely confusing, unless two different types of things were placed in the container.  Example: A healing potion and a healing fruit are placed in the container.  The healing fruit is linked first, and the potion second.  Since links execute in order starting at the top, the healing fruit will go into your inventory, THEN the healing potion will slide into your inventory.  Since the item you acquired is displayed when it is acquired, the healing fruit will go UNNOTICED since it was de-selected a mere fraction of the millisecond after it was selected!  This could result in great confusion amongst players, as they may become frustrated if you should place a truly important item in a container in this fashion.  The FM “The Treasury” is confusing in this manner because a key AND some loot are placed in the same container, the key slides UNNOTICED into your inventory!  Even it’s sound isn’t audible since the loot sound is louder!

 

However, if you place…say, a blackjack and some loot in one container, BOTH will go noticed, since one is a weapon and the other an item.  When you successfully frob the container (search it), your blackjack will become selected, as well as your loot “item”…which really isn’t an item per se, but rather a space in your inventory list, which shows you how much loot you have, and a picture of the last loot item you acquired!

 

Also remember that the “Container” script sends a “TurnOn” ControlDevice signal when it’s frobbed.  That’s how the two arrow-firing treasure chests in “Down in the Bonehoard” worked.  They were ControlDevice-linked to the EmitterTraps which emitted a broadhead!

 

Lights

 

A light is anything that gives off light in Thief.  Please keep in mind that TDP and TG DO NOT support dynamic lighting, or moving light sources, as this is better known (or, so they say).  TMA, however, does support dynamic lighting.

 

There are many different types of lights.  There are torches, electric lights, and lightmushes.  Torches are the most common, followed by electric lights.  Torches are interesting in that they can be doused and re-lit, electric lights are interesting because they have the ability to be switched on/off, and the fact that they give off MUCH more light than a torch.

 

Please do remember to place light sources, because light_bright only illuminates brushes, and also makes for a very unconvincing game play, remember that Thief is about stealthiness, and shadows, so be sure there’s always away to sneak around!

 

There are two general types of lights, physical light sources, and hacklights.  Hacklights are invisible light sources, useful for illuminating tight spaces.  Hacklights can be found in the fnord category of the object hierarchy, while physical lights are under physical.

 

There are two different TYPES of lights.  Spotlights, and normal lights.  Spotlights give off a focused beam of light, and are useful for creating a lit room, with shadowed walls!  Normal lights give off light in all directions, and are useful for general rooms.

 

Okay, now, how to make a light switch able!  Create your electric light, and open it’s properties (please note that ANY light can be switched, however, switched torches are cheesy).  Now, look for an AnimLight property.  If it’s there, you’re safe, if it’s NOT, add it.  (If it’s not there, when you add “AnimLight” and configure it, remove the “Light” property.)

 

Note: If you’re planning on copying “AnimLight” sources, don’t delete the “Light” property, rather set it to “0” across the board, since whenever a light is created (by cloning, or using “Insert”, too), the “Light” property is automatically added if it isn’t there.

 

This is a good time to discuss the AnimLight menu.  Here you can adjust the light’s mode.  If you want your light to be off initially, set the mode to “Minimum Brightness”, and leave minimum brightness at “0”.  Now set a nice maximum brightness, and set the light’s radius.  There, you’re done!

 

Now Add-S-Scripts, and type “AnimLight” in the first available spot.  Now, if your light is on initially, you’ll also need an inverter.  Link the inverter to the light, and link a switch to the inverter.  There, you’re done!

 

Keep in mind the way to reverse the starting state of switches.  But remember, it looks better if the switch starts “up” and the lights are “on”.  We seem to associate switches that are “up” with “on” lights!

 

So, on the same token, if you have a light that’s off initially, reverse the switch and add an inverter…that way real life and Thief seem even more seamless!

 

Hit Tools-Light, and enjoy!

 

To create Lost City lights, lights that turn on when you (or another creature) enters a room, and so that they turn off when the room once again becomes unoccupied, create your light, and take all the steps necessary to turn it into a switchable light.

 

Now, read “Roombrushes”.

 

Now, create a concrete roombrush, and add the scripts “TrigRoomPlayer” and “TrigRoomCreature”.  Now ControlDevice link that room to the light.

 

Remember that for each set of individually switching lights you MUST create a new concrete roombrush archetype!  However, if you want two roombrushes to control the same light, create two of the same archetype…the scripts and links will automatically be inherited!

 

To create a light that switches itself, add a “FrobProxy” link to a hidden switch, and then link the switch back to the light.

 

Dynamic Lighting

 

I know, I know, I just told you that Dynamic Lighting in T1/G was impossible, but it is…technically!

 

Please read “Sources and Receptrons” before reading this.

 

Okay, now, create a “lantern”, Physical>Lights>lanterns>lantern.

 

Reduce all its “Light” properties to 0, and then Add>Renderer>Self Lit: 250

 

Go into the object hierarchy, go into: physical>Creature>Animal>Human>Swordguard>Grunts>sword guard, select “sword guard”, and press “Add”.

 

Type: “Normal”, and press “Enter”.

 

Repeat twice, naming the next two guards “High” and “Highest”.

 

Close the hierarchy, and save the gamesys!  (See “The Gamesys and You” for further details.)

 

Next let’s create a custom stim.  Open up the object hierarchy, and view Stims.  Press “Create” and name your new stim “LanternStim”.  Save your gamesys, and restart DROMED.

 

Now, go into the hierarchy, select “Normal”, and Add>AI>Utility Settings>Visibility Control.

 

Set the values as follows: Low Light: 13 Mid Light: 19 High Light: 44

 

“High”:

 

Low Light: 6 Mid Light: 10 High Light: 22

 

“Highest”:

 

Low Light: 0 Mid Light: 0 High Light: 0

 

Good!

 

Open up the lantern’s properties, and Add>Act/React>Source:

 

Object:
A lantern

Stimulus:
LanternStim

Propagator:
Radius

Edit Shape: Radius:
50

Edit Shape: Flags:
[None]

Edit Shape: Dispersion:
Linear

Edit Life Cycle: Flags:
raycast

Edit Life Cycle: Period:
100

Edit Life Cycle: Max Firings
1

Edit Life Cycle: Intensity Slope:
0

Edit Life Cycle: Intensity:
50

 

Now create a guard, any kind of guard…a sword guard, though.  Open the “Links” dialog, and Add:

 

Flavour:
CreatureAttachement

From:
LanternGuard

To:
A lantern

Data:
Left Fingers

 

The next step is to make this new “LanternStim” affect Garrett:

 

Open up the hierarchy, and “Edit”: Physical>Avatar>Garrett

 

Add>Act/React>Receptrons: In this dialog, press “Add”:

 

Object:
Garrett (-2099)

Stimulus:
LanternStim

Min Intensity:
NoMin (check the box)

Max Intensity:
25

Effect:
Set Property

Edit Effect: Prop Name:
AI_VisCtrl

Edit Effect: Target Obj:
Me

Edit Effect: Agent Obj:
Normal

 

Press “OK”, then “Add” again:

 

Object:
Garrett (-2099)

Stimulus:
LanternStim

Min Intensity:
26

Max Intensity:
38

Effect:
Set Property

Edit Effect: Prop Name:
AI_VisCtrl

Edit Effect: Target Obj:
Me

Edit Effect: Agent Obj:
High

 

Press “OK”, then “Add”:

 

Object:
Garrett (-2099)

Stimulus
LanternStim

Min Intensity:
39

Max Intensity:
50

Edit Effect: Prop Name:
AI_VisCtrl

Edit Effect: Target Obj:
Me

Edit Effect: Agent Obj:
Highest

 

Press “OK”, then “OK”.  If the window pops-up again, just dismiss it once more.  Now dismiss “Garrett”’s properties, as well as the hierarchy, then save your gamesys!

 

You might be wondering, then, how the actual LIGHT gets there, the light that lights up the guard’s path.  Well, dynamic lighting in T1/G IS possible, with the “Self Lit” property, however, this property, for some reason, doesn’t illuminate Garrett, so we’ve developed this clever work-around!

 

If you’re using DROMED for Thief 2, just use the >Renderer>Dynamic Light property.

 

Garrett and Dynamic Lights

 

So, now we’ve gone from: “Dynamic Lighting in T1/G is IMPOSSIBLE”, to describing a dynamic lighting technique in-depth!  Please read: “Dynamic Lights”, and “Conversations” first.

 

First, go into your object hierarchy, and create a new metaproperty, called it “MoveAndScript”.

 

Put this property on it:

 

Add>Engine Features>FrobInfo: Move,Script;[None];[None]

 

Create and roombrush a blueroom.

 

Create an AI in the blueroom, call him “LanternAI”.

 

Now, open up the hierarchy, select “Act/React Stimuli”, and create two new stims: “PassItOn”, and “LanternFStim”.  Then save your gamesys, and restart DROMED.

 

Go to your roombrushed blueroom, create four buttons.  Create 2: physical>Lights>lanterns>lantern, from the hierarchy.  Name the first: “UnlitLantern”, and the second “LitLantern”.

 

Add the following properties to “UnlitLantern”:

 

Inventory>Can’t Drop This: TRUE

Inventory>Object Name: Name:“Lantern: Off”

Inventory>Type: Item

Renderer>Light: 0;0;0;0

S>Scripts: StdButton;;;;FALSE

Engine Features>FrobInfo: Script;[None];[None]

Metaproperty>MoveAndScript (Only if you plan to have the player pick up the lantern)

 

And add these properties to “LitLantern”:

 

Inventory>Can’t Drop This: TRUE

Inventory>Object Name: Name:“Lantern: On”

Inventory>Type: Item

Renderer>Light: 0;0;0;0

S>Scripts: StdButton;;;;FALSE

Engine Features>FrobInfo: Script;[None];[None]

Metaproperty>MoveAndScript (Only if you plan to have the player pick up the lantern)

 

Now, place “UnlitLantern” somewhere either A. The player can pick it up.  Or B. Link the StartingPoint to it with a “Contains” link.

 

If “A”, there’s an extra step…which will be mentioned later.

 

Now, create three markers (fnord>Marker), four teleport traps (fnord>TrapTrig>TeleportTrap), four buttons (physical>Gizmo>Switches>Buttons>Button), and an OmniLightPoint (fnord>HackLight>OmniLightPoint).

 

Read: “Conversations”.

 

Add the following properties to the 3 markers (name them: “UnliteLantern”, “LiteLantern”, and “AddRemoveLinks”):

 

S>Scripts: TrapConverse;;;;FALSE

AI>Conversations>SaveConversation: TRUE

 

Link each marker in turn to “LanternAI”, with an “AIConversationActor” link…set the data to “1” for each.

 

Next, name the buttons: “RealButton”, “OmniButton”, “UnlitButton”, and “LitButton”.

 

Name the TeleportTraps: “RealTele”, “OmniTele”, “UnlitTele”, and “LitTele”.

 

Link each button to its respective TeleportTrap with a “ControlDevice” link (“LitButton” to “LitTele”, etc.).

 

Name the OmniLightPoint: “RealLantern”.

 

Link each TeleportTrap to it’s respective lantern…you’ll notice you have one (“OmniTele”) left over…link it to “RealLantern”…all links are “ControlDevice” flavour.

 

Next, add the following properties to “RealLantern”:

 

Renderer>Self Lit: 250

Renderer>Light: 0;0;0;0

 

Now we’re going to give “RealLantern” a source, which will make it able to follow Garrett around, so, open up it’s properties, and Add>Act/React>Sources.

 

Press “Add”, and a window will pop-up…fill it in like this:

 

Name: RealLantern

Stimulus: LanternFStim

Propagator: Radius

Intensity: 1

Edit Shape>Radius: 8

Edit Shape>Flags: [None]

Edit Shape>Dispersion: None

Edit Life Cycle>Flags: No Max Firings

Edit Life Cycle>Period: 100

Edit Life Cycle>Max Firings: 1

Edit Life Cycle>Intensity Slope: 0

 

Press “OK” to add this source…then add ANOTHER source:

 

Name: RealLantern

Stimulus: LanternStim

Propagator: Radius

Intensity: 50

Edit Shape>Radius: 50

Edit Shape>Flags: Line of Sight (raycast)

Edit Shape>Dispersion: Linear

Edit Life Cycle>Flags: No Max Firings

Edit Life Cycle>Period: 100

Edit Life Cycle>Max Firings: 1

Edit Life Cycle>Intensity Slope: 0

 

Press “OK” to add that source, then press “OK” to dismiss the sources box…it may pop back up, just press “OK” again…it’s a bug!

 

Now, in order for this stim to be able to have “RealLantern” follow Garrett, we need to make Garrett receive the stim and act appropriately!  So, open up the hierarchy, select physical>Avatar>Garrett (-2099), and hit “Edit”.

 

Then look for a property entitled “Receptrons”.  Hit “Edit” (Garrett already has receptrons, so you’d bugger up the game by adding “Receptrons” again…if a property exists, just edit, DON’T add…unless that property is hierarchied…then add!).

 

Now hit “Add” to make a new receptron!

 

A large box will pop-up, fill it in like this:

 

Name: -2099

Stimulus: LanternFStim

Min: 0

Max: No Max (check it)

Effect: Teleport Object

Target Object: Source

Agent Object: Me

Edit Effect>X: 0.1

Edit Effect>Y: 0.1

Edit Effect>Z: 0.1

 

That’s it!

 

If you remember from the “Dynamic Lights” section, Garrett already has receptrons for “LanternStim”.  If you didn’t alter your gamesys in the last section for Dynamic Lighting…then go back to “Dynamic Lights”, and add the necessary receptrons to the “Garrett” archetype…then return here!

 

Okay, you might remember we have a marker called “AddRemoveLinks”…if, in the A/B choice above, you chose “B”, then delete this marker.

 

Also, if you chose “B”, link “UnlitLantern” to “LiteLantern” via “ControlDevice”.

 

Select “OmniTele”, and position it overlapping the StartingPoint on all views.  Then Add>Act/React>Sources:

 

Name: OmniTele

Stimulus: LanternFStim

Propagator: Radius

Intensity: 1

Edit Shape>Radius: 8

Edit Shape>Flags: [None]

Edit Shape>Dispersion: None

Edit Life Cycle>Flags: No Max Firings

Edit Life Cycle>Period: 100

Edit Life Cycle>Max Firings: 1

Edit Life Cycle>Intensity Slope: 0

 

There, now the “OmniTele” will follow Garrett.

 

Add another Source to “OmniTele”:

 

Name: OmniTele

Stimulus: LanternStim

Propagator: Radius

Intensity: 15

Edit Shape>Radius: 1000

Edit Shape>Flags: [None]

Edit Shape>Dispersion: None

Edit Life Cycle>Flags: No Max Firings

Edit Life Cycle>Period: 100

Edit Life Cycle>Max Firings: 1

Edit Life Cycle>Intensity Slope: 0

 

Select “UnlitLantern”, and “LitLantern”, in turn, and add this Source to both of them:

 

Name: UnlitLantern OR LitLantern

Stimulus: PassItOn

Propagator: Contact

Intensity: 1

Edit Shape>Contact: Frob in Inv

Edit Shape>Velocity Coefficient: 0

Edit Shape>Frob Time Coefficient: 0

 

Next we need to make Garrett react to the source…edit Garrett’s receptrons again:

 

Name: -2099

Stimulus: PassItOn

Min: 0

Max: No Max

Effect: Frob Object

Target Object: Source

 

Ah, done!

 

Next, make sure that “RealLantern” in the blueroom, is AT LEAST 8ft away from any player-accessible areas on ALL SIDES, top, bottom, front, back, left, right, otherwise WEIRD errors will occur!

 

Now that everything is setup, it’s time to start setting up the conversations!

 

The first thing is to say, did I choose “A” or “B”?  If you chose “A”, just keep on reading, if you chose “B”, skip down to the place titled “Bs Start Here”:

 

Okay As, link “UnlitLantern” to “AddRemoveLinks” with a “ControlDevice” link.

 

Select the marker that you didn’t delete, “AddRemoveLinks”.  It should already have the framework of a conversation (if you followed this section of my tutorial word-for-word), “AIConversationActor” link, “SaveConversation” property, and the “TrapConverse” script!

 

Add>AI>Conversations>Conversation:

 

STEP 00:


 

Action 00:
Add Link


Actor One

Arg1:
ControlDevice

Arg2:
LiteLantern

Arg3:
UnlitLantern

 

Action 01:
Remove Link


Actor One

Arg1:
ControlDevice

Arg2:
AddRemoveLinks

Arg3:
UnlitLantern

 

Action 02:
Add/Remove Metaproperty


Actor One

Arg1:
Remove

Arg2:
MoveAndScript

Arg3:
LitLantern

 

Action 03:
Add/Remove Metaproperty


Actor One

Arg1:
Remove

Arg2:
MoveAndScript

Arg3:
UnlitLantern

 

Bs Start Here

 

Link “LitLantern” to “UnliteLantern” with a “ControlDevice” link.

 

Select “LiteLantern”, Add>AI>Conversations>Conversation:

 

STEP 00:

 

Action 00:
Remove Link


Actor One

Arg1:
Contains

Arg2:
UnlitLantern

Arg3:
Player

 

STEP 01:

 

Action 00:
Frob Object


Actor One

Arg1:
UnlitButton

Arg2:

Arg3:

 

Action 01:
Add Link


Actor One

Arg1:
Contains

Arg2:
LitLantern

Arg3:
Player

 

Action 02:
Frob Object


Actor One

Arg1:
OmniButton

Arg2:

Arg3:

 

That’s that conversation out of the way…onto the next conversation (“UnliteLantern”):

 

STEP 00:

 

Action 00:
Remove Link


Actor One

Arg1:
Contains

Arg2:
LitLantern

Arg3:
Player

 

Action 01:
Frob Object


Actor One

Arg1:
RealButton

Arg2:

Arg3:

 

STEP 01:

 

Action 00:
Frob Object


Actor One

Arg1:
LitButton

Arg2:

Arg3:

 

Action 01:
Add Link


Actor One

Arg1:
Contains

Arg2:
UnlitLantern

Arg3:
Player

 

Last, but certainly NOT least, add the following properties to “LanternAI”:

 

Add>AI>AI Core>Team: Neutral

 

Then add the metaproperties: “M-NoBabble”, and “M-NeverEfficient”.

 

Go in-game, and enjoy!

 

Candles

 

You might have played the T1/G FM “Lorgan’s Web”, which was FAMOUS for its candles that burned, and could be frobbed out!

 

I’m going to teach you how to make such candles!

 

First, you must know where to find the candles…they are under: physical>Lights>candles>

 

There are three different kinds of candles: Treasure Candles, Long Candles, and Short Candles.  Each one is different.  The only thing different between “Long Candles”, and “Short Candles” is the bounding box setting on the particle effect (the space off-set from center the actual particle effect can occupy)…however, treasure candles are more complicated, because they have to be allowed to move into the player’s inventory, too.

 

We’ll cover treasure candles first.

 

Create a torch: physical>Lights>torch.

 

Add the following properties to it:

 

Add>Metaproperty>IsLoot

Add>Dark Gamesys>Loot: Gold: 50

Add>Shape>Model Name: trcandle

Add>Tweq>Models>(change all “Model X” fields to “trcandle”)

Add>Renderer>AnimLight>(change min to 22, max to 30, change mode to “Random but coherent”)

 

There!  Now, if you go in-game, you’ll have a candle with a MASSIVE particle effect on top, whose light does weird things when it’s picked up.  So, let’s tweak the particle effect.

 

First off, delete the “TorchFlameSmoke”, so that only the “TorchFlameYellow” remains.

 

Open the “TorchFlameYellow”’s properties, and modify it’s SFX> properties so that it has a particle size of 0.08, a min Z-axis bounding box of 1.5, and a max Z-axis bounding box of 1.9

 

Next, add the following properties:

 

Add>S>Scripts: StdButton;;;;FALSE

Add>Engine Features>FrobInfo: Script;;

Add>Inventory>Max Pick Distance>7.00

 

Good!  Next, find a nearby object without any script- or tweq-driven functionality (example of ideal objects: a table, ladder, or banner), add the the script: “TrapInverter”.

 

Link the TorchFlameYellow to the object (which is now an Inverter), then link the object to the candle itself.

 

There’s one last thing to do.  To ensure that the player CAN’T take the candle right off the bat and cause weird lighting errors, add a “FrobProxy” link from the candle to the TorchFlameYellow.

 

There!  Now we know how to make a “Treasure Candle”, well, what about a “Long Candle”?  Do the SAME thing, only this time forget the “FrobProxy” link, the “IsLoot” metaproperty, and the “Loot” property.

 

So, what about a “Short Candle”?  Do the same thing as a “Long Candle” only this time, change the bounding box Z-axis min and max to: 0.5, and 0.65, respectively!

 

Note: Tinker with the “AnimLight” settings, changing from “Random but coherent”, to “Random” to make the candle flickering more apparent…you can also fiddle with the max and min brightness to make the light flicker over a wider or thinner selection of brightnesses.

 

AIs

 

Okay, here we are, AIs, the third most difficult DROMED concept to master.  Conversations are the most difficult, followed by S/R (Sources and Receptrons).  There are two processes that pertain to AIs, and these are:

 

Build Pathfinding Database
Tells the AIs where to go and how to get there

Build AI Room Database
Allows the AIs to “hear”, also integral to a conversation’s functioning.

 

Keep in mind that AIs are objects just like everything else, only, they’re special, they move, and think!

 

This is a good time to mention an extremely useful command: “aiawareofplayer”.  Enter this in the command window and hit ENTER, and the AI will become completely oblivious to your presence.  They will, however, notice if you hit something (like a torch) with your sword or blackjack, and they’ll become alert when you shoot them!

 

AIs are just like other objects, you can place them and leave them…they appear without portalizing.

 

Don’t get scared when you create your first AI because it’s as wide as it is tall, if not wider. This is because an AI’s default posture is with its arms out.  This changes when you go in-game, however.

 

Okay.  You’ll notice that if you create a servant, and scare him, he won’t run away, he’ll search for you (and never find you).  That’s cheesy!

 

Create markers at suitable flee points in your levels, and name them “FleePointX”, where X is the number of the flee point.  Add-AI-Utility-Flee Point to these markers, and set a desirability level.  0 is totally undesirable, and 100 is ultimately desirable.  If you set multiple flee points of the same value, fleeing AI will either run to the closest one, or run back and forth between them.  (You can observe this sort of behaviour by scaring the talking servants in the bedroom in Bafford’s, after which you’ll find them dashing frantically around in the halls.)

 

Remember to build the pathfinding database after you create flee points, though.

 

Okay, you have AIs that flee, and that stand around waiting for you.  But what if you want patrolling AIs?  Read on!

 

Create an AI, now, open the hierarchy, and create: Fnord-Marker-TrolPt.  Create them where you want the AI to patrol.  Now, take in mind that an AI will patrol at the closest patrol point, so, to make sure he doesn’t go gallivanting off into some Godforsaken corner of the map, create the first TrolPt inside him, or add an “AICurrentPatrol” from the AI to the TrolPt you want him to start at.

 

Now, link forwards all the TrolPts with AIPatrol flavour links.  Remember to link the first back to the last, or the last back to the second to last…on and on.  This is a common mistake, which causes the AI to patrol to the last linked TrolPt, then stop!

 

We have to tell the AI that he’s supposed to patrol.  So, pull up his properties, and Add-AI-AI Ability Settings-Patrol: Does Patrol.  Check the box, and hit “OK”.

 

Compute the pathfinding database, and go in-game…there, your AI patrols!

 

Let’s tackle sleeping AI next.  You must understand that Thief comes with a MetaProperty called “M-SleepingServant”, which was used to make servants sleep; never guards.  But since the advent of FMs in 1999, we’ve seen everyone and everything sleeping!

 

So, ignore the servant part.  There’s one defect in this sleeping metaprop, and that’s that the sleeper doesn’t wake up.  The OMs used AIWatchObj links to wake the AIs up…which was a bit cheesier than the method I have in-mind…we’re going to modify your Dark Gamesys.  Sound daunting?  Don’t worry, it isn’t.

 

Please read: “The Gamesys and You”.

 

First we have to change this M-SleepingServant metaprop, and then we must save the gamesys.

 

Open the object hierarchy, look up at the top, it says that you’re currently viewing archetypes.  Change that to MetaProperties.  Now browse until you find M-SleepingServant.  Select that and hit “Edit”.

 

I must tell you what a MetaProperty is.  A MetaProperty is a collection of properties, which create a desired effect.  M-FrobInert, for example, causes an object to become unfrobbable, or incapable of producing effects.

 

The benefit to MetaProperties is the fact that they can be added or removed by a Response or Conversation, both covered later.

 

Add-AI-Responses-Alert Response to the AI you wish to have sleeping! 

 

Set the alert level to 3, and the priority to “Very High”.

 

Change the first action to Add/Remove MetaProperty, and then type the following in Arg 1, 2, and 3.

 

Arg1:
Remove

Arg2:
M-SleepingServant

Arg3:


 

Please note that empty “Arg”s (from here on out) are not type-Os, but really are empty, with some actions they’re not necessary!

 

Okay, this means that when the AI becomes alerted, he/she will remove the M-SleepingServant MetaProperty from himself/herself.  If I wanted to remove the MetaProperty from another object, I would have typed that object’s unique name (must not be a number) in Arg3, but since I was targeting the AI itself, there was no need!

 

Get out of the Obj Hierarchy, then go File>Save Gamesys, and save over “Thief\dark.gam”.

 

Please note that adding this prop (M-SleepingServant) will cause the AI to change his stance, which will cause him to not move at all in the solid world, and make him appear twice in the wireframe world!  Don’t worry, just move and he’ll move in the solid world, or move him in the wireframe world to dismiss the errant copy!

 

This same error occurs when you rotate an AI to an angle NOT a multiple of 90 (0, 90, 180, 270), such as 45.  A larger box will appear, which is odd…only the middle slice of that box is “really” occupied.

 

Note: When you make an AI sleeping on a bed, sometimes he’ll actually exist INSIDE the solid of the object…such as in a bunkbed when he/she is sleeping on the bottom bunk.  When this happens, or when the AI is sleeping a top a “bunk”, when he/she stands up, they’ll end up INSIDE the object, so they won’t be able to move!  To workaround this, select the bed, and Add>AI>Utility>Path Avoid: [None].  This will cause the AIs to ignore the bed’s solidness, and merely walk right through it…do the same thing with chairs that an AI is sitting in.

 

Note: Don’t use beds from the “Beds” archetype…use beds from the “BedParts” archetype…the former will crash Thief!

 

Next question: How do I put a purse or key on an AI’s belt?  That’s simple!  First you create the purse/key, and modify the properties as necessary.  Then link the guard to the object via contains link.

 

But don’t close the links window yet!  Once you’ve hit “OK” to create the link, it appears in the link list.  Now, look under the “Data” column.  Right now this says “Generic Contents”.  Now, this is great if you want an AI to have a key so he can go through a locked door, but, not be steal able by the player, but, if you want it on his belt, that’s a no-no.  So, click on the link’s ID number, then hit the “Data” button.

 

This drop-down menu contains three choices: Hand, Belt, and Generic Contents.  “Hand” doesn’t appear to work, and right now we’re worried about the belt, so hit “Belt”, then “OK”.  There, it works!  Go in-game and check it out!

 

Now the all-together too popular AI trick, drunkenness!

 

Create the guard to be drunk, now, we have to edit his properties (you could make this a MetaProperty if you were going to use it enough).  First Add-MetaProperties…find M-AlertCapZero and click on it.

 

Now Add-Speech-Voice, change the default value to “drunk1”, and hit ENTER.

 

Now Add-AI-Responses-Threat Response, change the threat to “Raised Weapon”, and change the actions to:

 

Action00:
Add/Remove MetaProperty

Arg1:
Remove

Arg2:
M-AlertCapZero

Arg3:


 

Action01:
Play Sound/Motion

Arg1:
tolevelthree

Arg2:

Arg3:

 

Okay, here’s what the above does.  When the guard sees a raised weapon, including the bow, he removes the M-AlertCapZero MetaProperty, and plays a sound that indicates he’s become alert.  The Add-Speech-Voice made it so that his voice was drunken, you know, with all the hiccups and that!

 

Okay, now Add-AI Core-Awareness Capacitor, and change the value of all three fields to ten.  I think this makes him harder to alert…but I’m not sure, I just tore these properties configurations straight from the well-house guard in Bafford’s.

 

Add-Motions-ActorTagList, type: “WithSword 0, Drunk 0”, this changes the guard’s motion configurations so that he sways drunkenly, with his hands and sword flying about.  The “WithSword 0” part just makes it so that his motions are consistent with that of someone carrying a lethal piece of heavy metal around in their hand.  If you look at a guards “ActorTagList” by default, you’ll notice it reads “WithSword 0”.

 

Add-AI Core-AI, make that “Default”.  This just sets it up so he behaves in the default fashion.

 

This is all well, but it’s kind of cheesy.  We’ve got a drunk guard standing in the middle of no where.  Why don’t you put some bottles and goblets around his feet, hmm?  And how about a goblet in his hand…no, seriously!

 

First, create the goblet.  Now remember its number and open up the drunk guard’s links window.  Add a new link:

 

Flavour
CreatureAttachement

From:
Drunk Guard

To:
Goblet

 

Once you’ve pressed “OK” to create the link, change it’s data to “Left Fingers”, that’s where the goblet will attach to the guard.  Dismiss these windows, and pop in-game.  There!  A drunk guard swaying about madly, holding a goblet, who ignores you until either you alert some sober guards, or until you threaten him with a raised weapon!

 

Now you can make drunk guards, make patrolling guards, and put things in a guard’s inventory.  But what if you want to make an archer fire, fire arrows?  Or, what if you want an AI on Garrett’s team?  What if you want a super-talkative guard?  Don’t worry, I’m not going to leave you to figure those things out on your own!

 

First, let’s tackle super-talkative guards.  This is an easy one!  Pull up the guard’s property and Add-AI-Attributes-Verbosity.  Set the value to whatever it pleases you, and hit “OK”.  Please note that AI-Attributes are a good way to make your guard behave a certain way.  For example, a guard whose sloth is high will be lethargic; a guard with a high efficiency won’t miss any spots when he’s searching for you, and so on and so forth!

 

Now, an AI on Garrett’s team is also easy.  You Add-AI-AI Core-Team, change that to whatever you want, here’s the low-down on the teams:

 

Good
On Garrett’s team, against all BadXs

Neutral
Neutral, isn’t hostile to anyone

Bad 1
Bad, against Good and all other BadXs

Bad 2
Bad, against Good and all other BadXs

Bad 3
Bad, against Good and all other BadXs

Bad 4
Bad, against Good and all other BadXs

Bad 5
Bad, against Good and all other BadXs

Bad 6
Bad, against Good and all other BadXs

 

There!  You can also make being non-hostile by Add-AI-Ability Settings-Combat: Non-Hostile.  There are many different settings, all of which are quite literal.

 

Now, to tackle archers.  Please note that this is the same for ALL OTHER RANGED AIs, for example you can change a high priests spell to an arrow if you want.

 

Create an archer, found under Physical-Creature-Animal-Humans-Guards-Bowman-, any old archer will do.

 

Open up his links.  You’ll see that by default he has the following links:

 

Flavour:
Contains

From:
The Archer

To:
A Broadhead

Data:
Generic Contents

 

Flavour:
Culpable For

From:
The Archer

To:
A Broadhead

 

Flavour:
AIProjectile

From:
The Archer

To:
A Broadhead

 

We’re going to dissect these links.  The first one tells DROMED that the archer contains a broadhead.  The second tells DROMED that he CAN carry broadheads.  The third tells DROMED that when he fires, he fires a broadhead.

 

Create a firearrow (not firecrystal!).  Then delete all the archer’s links, and re-do them, all to the fire arrow.  Change the data of the AIProjectile link for a flat trajectory, as this is how fire arrows fly!

 

Note: All CulpableFor links are done automatically by DROMED.

 

And last, how to make an AI start out dead!

 

Add-MetaProperties.  Now find and add “M-PosedCorpse”.

 

Or, make a zombie who’s dead, but activates when you walk over him: “M-ZombiePossum”, and “M-FrobInert”.

 

And there, you’re done!

 

Ever wondered why Thief didn’t ship with a Hammer Archer?

 

You’re wrong!  Thief DID ship with a Hammer Archer!  And here’s how you can activate him!

 

Create a bowman.

 

Open the bowman’s properties and Add>Shape>Model Name

 

Type “HamBow”

 

Press enter.

 

Now Add>Speech>Voice

 

Type: “hammrs”.

 

Press enter.

 

That’s all fine and dandy.  Now, let’s do some more AIProjectile work.

 

We’re going to make a farting burrick!  Oh, yeah!

 

First, we’ll have to edit the archetypes a little.  So, “Edit” Physical>Creature>Animal>Burrick>DefectiveBurrick.

 

You’ll see that the “DefectiveBurrick” has an “AIProjectile” link to a “fart”.

 

Click on that link and hit “Edit”.  A link window will come up.  Select the only link and hit “Data”.  Now adjust the launch point to: “Butt”.

 

Lastly, save your gamesys (See “The gamesys and you”), and try him out!

 

Fnords

 

Fnords, they’re invisible, they aren’t physical, all they are, are tiny red boxes on your screen…WHAT DO THEY DO?

 

It’s pretty simple!  Below is listed the effects of the Fnords I know:

 

Marker
A generic Fnord, used for gotos, conversations, and StartingPoints

Inverter
Inverts the sense of a ControlDevice on/off link

RequireAllTrap
Sends “on” when all linked objects are on, sends “off” when NOT all objects are “off”, even if one turns off and the rest are still “on”

RequireAnyTrap
Sends an “on” signal if any of the ControlDevices to it are “on”, and an “off” when all ControlDevices are “off”.

RelayTrap
Relays a link signal

DestroyTrap
Destroys whatever it’s linked to via ControlDevice when it receives a ControlDevice

ReleaseTrap
Releases whatever it “Contains” when it receives a ControlDevice.

TrolPt
A patrol point (is just a re-named marker…)

TerrPt
See “Elevators”

LookBackPt
The patrolling individual looks back here, operates like a TrolPt.

QVarTrap
Changes mission objectives, see the “Objectives” series of topics

VOTrap
See “Garrett’s Comments”

EmitTrap
Emits projectiles, Bonehoard and The Sword style!

EmitStreamTrap
Emits multiple projectiles.  See “EmitTraps”

BoundsTrigger
“On” while occupied (by player or creature) “Off” while unoccupied

SoundTrap
See “SoundTraps”

CreateTraps
Creates whatever it “Contains” when it receives a ControlDevice

FnordLock
See “FnordLocks”

 

Note: RequireAll and RequireAnyTraps.  These traps use “ScriptParams” links with “On” data to signify which ControlDevice-linked objects are on.  If you’ve linked an object to the trap, and it starts off “On”, you should create the link with the appropriate data…otherwise the trap won’t function properly until you’ve turned that offending switch off then on again.

 

Useful Scripts

 

Okay, here’s a list of useful scripts.  Some of them require special properties, most of which can be gleaned by taking a peek at the object drawn from.

 

StdDoor
Makes the object a door, needs a “Door” property

StdElevator
Makes the object an elevator, requires “Moving Terrain” property

StdLever
Object transmits on/off ControlDevices, needs FrobInfo and “JointsState”

StdKey
Makes a key a key, see the section: “Keys” for more info

LootSounds
When picked up, the object produces loot sounds

LockSounds
The object produces lock sounds if locked

StdButton
The object transmits single-state ControlDevices, needs FrobInfo

TrapDestroy
Turns the object into a DestroyTrap

TrapInverter
Turns the object into an Inverter

TrapRequireAll
Turns the object into a RequireAllTrap

TrapRequireAny
Turns the object into a RequireAnyTrap

TrapQVar
Turns the object into a QvarTrap

TrapRelease
Turns the object into a ReleaseTrap

TrapTeleporter
Turns the object into a TeleportTrap

TrigUnlock
Sends an “On” when unlocked, an “Off” when locked

TrigSlain
Sends a single-state when the object is slain

TrigDoorOpen
Triggers “On” when open, “Off” when closed

TrigRoomPlayer
Place on concrete room, “On” when occupied by player, “Off” when not

TrigRoomCreature
Place on conctrete room, “On” when occupied, “Off” when not

TrigAIAlert
Triggers when an AI becomes alert

TrigWorldFocus
Triggers when an object becomes focused upon, make sure FrobInfo, WorldAction is: “FocusScript”

TrapRelay
Turns the object into a RelayTrap

TrapTweqEmit
Turns the object into an EmitTrap

EatFood
Makes the object Eatable

StdScroll
Makes the object a scroll, see “Readable Items”

StdBook
Makes the object a book, see “Readable Items”

SecureDoor
See “Undercover-Style Missions”

CollisionStick
The object sticks to wooden surfaces

AnimLight
See “Lights”

OnOffSounds
The object produces sounds when turned on/off, needs Schemas>Class Tags, or “SoundDescription” link

TrapConverse
Turns the object into a conversation, see “Conversations”

VictoryCheck
Must be placed on StartingPoint or the level cannot be completed

Extinguishable
The object’s light can be extinguished and re-lit, see “Sources and Receptrons”

LockPick
This is the lockpick script, see “Lock Picks”

WelcomeRoom
See “Objectives”

Container
Turns an object into a container.  See “Containers”

LoadoutCache
See “Making a Store”

SuspiciousToFrob
See “Undercover-Style Missions”

SuspiciousToTake
See “Undercover-Style Missions”

StickyWebs
Makes the object a SpiderBeasts sticky web…5 sticky webs for every repeat of the script!

WatchMe
See “The Infamous AIWatchObj Link”

AttackActivate
Activates all “ParticleAttachement” objects when an attack commences…is by default on the Hammer Priest

StdParticleGroup
??? – Must be on a particle effect for “AttackActivate” to work

ActivateAmbient
Activates ambients on “ControlDevice” linked objects on “TurnOn”, de-activates on “TurnOff”

ReloadTweqEmit
Allows and “EmitTrap” to fire more than once, but NOT in a stream!

 

Note: On the “Don’t Inherit” checkbox.  If you add scripts to an object for the first time, and you see scripts in the box, if you leave “Don’t Inherit” unchecked, you can delete them.  However, if you wish to alter these original scripts (remove some), check “Don’t Inherit”, that way the object won’t inherit scripts from the parent archetype.

 

Useful Links

 

Goodness…there’s links, Fnords, scripts!

 

ControlDevice
Creates effects…this one’s too broad!  See individual sections

Contains
Causes one object to contain another

CulpableFor
Makes an AI capable of containing something (automatic)

AIProjectile
Causes an AI’s projectile to be whatever it’s linked to, must be in AI’s inventory…set data to determine launch point…etc.

AIPatrol
Link from TrolPt to TrolPt to form a patrol route

AIWatchObj
See the section on this one!

Lock
Link from something to a lockbox (or fnordlock) to lock the something

AIConversationActor
Link from conversation to actor, see “Conversations”

SoundDescription
Link from a VOTrap to a sound archetype, then the VO will play that sound…can also be used with a SoundTrap…see appropriate sections

Weapon
Makes the linked to object the AI’s weapon

Corpse
Causes the object to become this object when “slayed”, not destroyed, “slayed”.

FrobProxy
A weird link…see the section on Frobbing

TPath
See “Elevators”

TPathInit
See “Elevators”

CreatureAttachement
Useful for attaching one creature to another creature/object

ParticleAttachement
Attaches objects and particle effects

AICurrentPatrol
The AI’s first patrol point.

AIAwareness
Is linked from an AI to the player if the AI is aware of the player.

PhysAttach
Used to attach two things.  See note.

ScriptParams
Like ControlDevice, too broad to do here.

 

Note: The links with tildes “~” in front of them do not concern the average DROMEDer, they are backwards links, and DROMED creates and manages them automatically.  For example, when you create the following link from your StartingPoint:

 

Flavour:
Contains

From:
StartingPoint

To:
A Sword

 

DROMED automatically creates this one:

 

Flavour:
~Contains

From:
A Sword

To:
StartingPoint

 

Note: The PhysAttach link.  The PhysAttach link functions differently in Thief 1 than in Thief 2.  In Thief 1 the object being PhysAttached is attached to the target object, and moves whenever that object moves, the same distance and in the same direction.  However, in Thief 1, when a PhysAttach link attaches something, that object is NOT automatically moved to that object.  In Thief 2, when a PhysAttach ink is added, the agent object is automatically pulled forcefully to the target object.  Also in Thief 2, the PhysAttach link data can be set for an off-set, originating from the center of the target object.  In Thief 1 this is unnecessary, since the PhysAttach link doesn’t move the agent object to the target object automatically.

 

FnordLocks

 

FnordLocks are like lockboxes, only they’re Fnords, and respond to ControlDevices rather than just frobbing.

 

Let’s try out a FnordLock now!

 

Create a FnordLock (Fnord>TrapTrig>FnordLock), a door, a switch, and an inverter

 

To have a FnordLock start out locked, Add>Engine Features>Locked: TRUE.

 

Link the door to the FnordLock (“Lock” flavour).

 

Link the switch to the inverter.

 

Link the inverter to the FnordLock.

 

Add the “Locked: TRUE” property to the FnordLock.

 

Try it out!  Flipping the switch will lock and unlock the door!

 

Note: When a FnordLock receives a “TurnOn” signal, it locks, “TurnOff” it unlocks.

 

Undercover-Style Missions

 

To me, as a DROMEDer, “Undercover” was a magnificent piece of work!

 

It had all sorts of complex stuff!  A. The AIs ignored you until you opened a forbidden door, or until you threatened them, OR until they saw you stealing something.  B.  It had a complex timer system.

 

I’m going to explain how YOU, yes, YOU can duplicate the style of “Undercover” in you’re missions.

 

Okay.  First, let’s learn about the MetaProperties, and scripts used in “A”:

 

SuspiciousToFrob
AIs seeing you frobbing this item become alerted…uncheck “Don’t Inherit” and remove all original scripts to avoid weird bug

SuspiciousToTake
AIs seeing you taking this item become alerted…see note on “SuspiciousToFrob”

M-FrontGateGuard
AIs ignore you until you threaten them, or until they “sense combat”

M-AlertCapZero
See the section on metaproperties to know the difference between “M-FrontGateGuard”, and “M-AlertCapZero”

 

So, create a hallway, with some guards patrolling (preferably a hallway they can walk out of sight), and a door, and a room.

 

Add the metaproperty: “M-FrontGateGuard” to all the guards.

 

Now, Add>S>Scripts.  Delete all the scripts, type “SuspiciousToFrob”, uncheck “Don’t Inherit”, and press “OK”.

 

A better script to use might be “SecureDoor”, adding it in the same way.  “SecureDoor” alerts guards if the door isn’t in it’s original state (“Open” or “Closed”), but in this case we want the guards to have to SEE YOU opening the door in order to be alerted.  (With “SecureDoor” the AIs don’t become alerted if another allied AI opens the door.)  Also note that “SecureDoor” uses “AIWatchObj” links…so, in order to get “SecureDoor” to work properly, also add the metaproperty: “M-SecureDoor”, for the proper watch link defaults!

 

So, now, go in-game, and open the door when a guard’s looking…he attacks, right?

 

Now, open it when he’s not looking…he ignores you, right?

 

If this doesn’t work, try typing: “script_load miss10” into the command box and hitting ENTER.

 

If this still doesn’t work, substitute “SecureDoor”.

 

Try the same thing with “SecureDoor”.  You’ll notice that this makes it much harder to intrude, because the guard notices THE DOOR, not YOU FROBBING THE DOOR.

 

Same thing with “SuspiciousToTake”.  The guards don’t notice the item gone, they notice YOU TAKING THE ITEM.  (This is also in miss10.osm, so try: “script_load miss10”, if that doesn’t work, you’ll have to see “The Infamous AIWatchObj” link, and make a line of sight AIWatchObj that adds a ControlDevice link from the object to a conversation which alerts the guard…then make another AIWatchObj that triggers when the guard is close and ISN’T aware of the player (should be a smaller cylinder), which deletes the AIWatchObj, both links should kill on completion, and both should create the others, so you’ll need to set-up “Watch: Watch Links Default”.)

 

Now, let’s resolve “B”:

 

Create five switches…hidden switches.  Now, decide on a time limit…say, 5 minutes, or, 300 seconds.

 

Knowing the number of seconds is VERY IMPORTANT!

 

In order for this to work, we must divide the number of seconds by 4.  300/4 = 75.

 

Now, lower the grid size (or raise it) accordingly, and create a blueroom 75ft wide, and say, 20ft long.

 

At the far end, create an EmitTrap, pointing across the room (so it has 75ft to go in a straight line until it hits the wall), and nestle the EmitTrap in a “fill air” hole so that it’s end just reaches the edge of the blueroom.

 

Open up the EmitTrap’s properties, and Add>S>Scripts and add the script: ReloadTweqEmit.

 

Next, create a button, and nestle it in another “fill air” hole DIRECTLY across the room from the EmitTrap…the DIRECTLY part of this is VERY important.  The EmitTrap and Button must be in a STRAIGHT LINE!

 

Read “Emit Traps”.

 

Open up the EmitTrap’s Tweq>Emit property, and make sure the projectile is “gasarr”, and that the firing speed is “0.25ft/sec”.

 

Light up the blue room, and rig a button to the EmitTrap, and experiment until the EmitStreamTrap fires a gas arrow towards the far button at one-quarter foot per second.

 

Now, everyone knows…of course, that arrows hit buttons and activate them…right?  Well…if you didn’t know that, they do.

 

So, why didn’t we use a broadhead?  Because broadheads fall as they fly!  Gas arrows and fire arrows don’t…we chose gas arrows over fire arrows because they don’t have so many particle attachments, which means they gobble up less precious object IDs.

 

Now, we need a servant.  Place the servant well away from our little arrow set-up, and rig him up with a conversation (See “Conversations”).

 

Create an Inverter, and link the button the arrow is destined to hit to the inverter.  Now link the inverter to all 5 of your hidden switches.  Also create a RequireAllTrap.

 

Link all 5 of your switches to the EmitTrap, also, link all five switches to the RequireAllTrap, and link the RequireAllTrap to your secret “thing” (use an Inverter if necessary).

 

Next link all 5 of your switches to the conversation.

 

Set-up the conversation to delete the links from the switches to the EmitTrap, and to destroy the links from the switches to the conversation.

 

Rig up ANOTHER conversation, with the same guy, to re-add the same links!  Link the button the arrow triggers to this conversation.

 

Create ANOTHER servant, with another conversation, and link the RequireAllTrap to this conversation, make this conversation add the MetaProperty “FrobInert” to THE button, then make the next step (I mean step, not action, step) to wait 300000 (that’s 300 seconds * 1000 milliseconds per second), then remove the property FrobInert (this remove metaprop action should be action 00 in step 02)…this is so that the arrow fired when the first switch was flipped on, won’t undo all your switch flipping once you’ve succeeded in flipping the switches.

 

There!  The secret of “Undercover” is out!

 

Assassins-Style Missions

 

Assassins is, without a doubt, one of the most complex OMs.

 

Want to know how you can do a similar mission?

 

Good, I thought you might!

 

First, create a room, with your StartingPoint, a man behind a counter, some weapons, a window, and a shadowy area outside!

 

Hide a ThiefBow in the shadows outside, and change his name to “Assassin”.

 

Next, add the metaproperty: “M-CannonFodder”, to the man behind the counter, this will make it so that one shot will kill him!

 

Read “EmitTraps”.

 

Create an EmitTrap, and nestle it in the window pointing at the man behind the counter, set it’s projectile to “broadhead”.

 

Find “BoundsTrigger”, in the “Fnord” section of the hierarchy, and place it near the StartingPoint…resize it to 8x8x8, and make sure that it completely contains the StartingPoint!

 

Create an Inverter.

 

ControlDevice link the BoundsTrigger to the Inverter which you should link to the EmitTrap.

 

Next, add AI>AI Core>Team Tag: Neutral, to the man behind the counter.

 

Go in-game.  Notice as soon as you move, an arrow kills the man behind the counter.

 

Next, create a bit of a city, and create a little house.

 

Add TrolPts and LookBackPts along the way to the house, and AIPatrol link them.

 

Read “VOTraps”.

 

Place a VOTrap in the middle of the shop, and SoundDescription link it to “garm0506” (“That shot was meant for me”), create another VO, linked to “garm0507” (“These creeps are going to lead me right back to whoever sent them to kill me, but only if I can tail them without them noticing me”), another VO, linked to “garm0501” (“So these are Ramirez’s boys, I think it’s time I dealt with Mr. Ramirez once and for all!”), then, last but not least, a fourth VO, linked to “garm0505” (“Damn, I guess I lost their trail”).

 

Next create four buttons in a blueroom, give them all specific names, and link them all to an appropriate VOTrap.

 

Okay!  That was long, and arduous, but it’ll be worth it once you see the fruits of your labours!

 

Create two QVarTraps, and some objectives (read the “Objectives” series).

 

The objectives should be (“Get 5000 loot in picked pockets” (No Type) “Follow the Assassin” (No Type, Final, Invisible))

 

Name the first QVar: “Succeed”, and the second “Fail”.

 

Set them up so that one makes your objective (the second one) succeed, and so that the other makes your objective fail.

 

Create two RelayTraps, and a DestroyTrap.

 

Link each the fail Relay to its appropriate QVar (but DON’T link the succeed Relay to its QVar), and link the Relays to the Destroy, and link the DestroyTrap back again.  So each Relay is linked to one QVar and the Destroy, and so that the Destroy is linked to both RelayTraps (all links are ControlDevice).

 

Now, create ANOTHER button (“QVarButton”), and link it to “Succeed”.

 

Create two more QVars, and set one up to mark the initial objective “inactive”, and set the other up to show the second objective.

 

Link one blueroom button (“HideandShow”) to them both (ControlDevice).

 

Next create a blueroom button for each Relay, give it a sensical name (“SucceedButton”, and “FailButton”), and link them to the appropriate RelayTrap.

 

Now create four servants in the blueroom.

 

Read “Conversations”.

 

Rig the first servant up with a conversation, make him actor one, create a RelayTrap, and a DestroyTrap.

 

Link the RelayTrap to the DestroyTrap (ControlDevice), and vice versa.  Then link the Inverter to the RelayTrap, and link the RelayTrap to the conversation.

 

Setup the conversation as follows:

 

STEP 00:

 

Action 00:
Wait


Actor One

Arg1:
1000

Arg2:

Arg3:

 

STEP 01:

 

Action 00:
Frob Object


Actor One

Arg1:
X (The button linked to the “That shot…” VO)

Arg2:


Arg3:

 

Action 01:
Add/Remove MetaProperty


Actor One

Arg1:
Add

Arg2:
M-DoesPatrol

Arg3:
Assassin

 

Action 02:
Frob Object


Actor One

Arg1:
HideandShow

Arg2:

Arg3:

 

Action 03:
Wait


Actor One

Arg1:
1000

Arg2:

Arg3:

 

STEP 02:

 

Action 00:
Frob Object


Actor One

Arg1:
X (The button linked to the “These creeps…” VO)

Arg2:

Arg3:

 

Read “Sources and Receptrons”.

 

Create a new stim called “FollowingStim”.

 

Save your gamesys and mission, then re-start DROMED.

 

Add a source for the FollowingStim to “Assassin”, make the propagator “Radius”, and make it radiate 50ft in all directions…DON’T make it raycast.  Make it fire 1.5 times per second (750).

 

Create a conversation for the second servant; rig it up to a button (“TimerConvButton”).

 

Then rig up a conversation for the third servant, link a new button (“FailConvButton”) to it, and then set-up the second servant’s conversation like this:

 

STEP 00:

 

Action 00:
Wait


Actor One

Arg1:
1000

Arg2:


Arg3:

 

STEP 01:
Frob Object


Actor One

Arg1:
FailConvButton

Arg2:

Arg3:

 

Then setup the third servant’s conversation:

 

STEP 00:

 

Action 00:
Frob Object


Actor One

Arg1:
X (The button linked to the “Damn…” VO)

Arg2:

Arg3:

 

STEP 01:

 

Action 01:
Wait


Actor One

Arg1:
2000

Arg2:

Arg3:

 

STEP 02:
Frob Object


Actor One

Arg1:
FailButton

Arg2:

Arg3:


 

Another conversation, for the fourth servant, to be activated by the succeed RelayTrap:

 

STEP 00:

 

Action 00:
Frob Object


Actor One

Arg1:
X (The button linked to the “So these are…” VO)

Arg2:

Arg3:

 

Action 01:
Wait


Actor One

Arg1:
2000

Arg2:

Arg3:

 

STEP 01:

 

Action 00:
Frob Object


Actor One

Arg1:
QvarButton

Arg2:

Arg3:

 

Open up your object hierarchy, and add a receptron to “Garrett (-2099)”, for the “FollowingStim”.  Set the response to be “Stimulate Object” and set the target to: “Source”…it’ll ask what stim we’re stimulating what with, we’re stimulating: “Source” with: “FollowingStim”.

 

Add a receptron to “Assassin”, for the FollowingStim, we want him to frob “TimerConvButton”.

 

You might ask why we’re not having Garrett himself frob the “TimerConvButton”.  That’d get REALLY complicated, seeing how Garrett could (theoretically), end up frobbing two things at once!

 

It’s simpler to go with this setup, so that we know there’ll be no conflicts!

 

Last, but not least, create a marker at the door of the house you’ve set up “Assassin” to go into.

 

Read: “The Infamous AIWatchObj Link”.

 

Create an “AIWatchObj” link from “Assassin”, to the marker.  Set up a VERY low radius, and a height of “8”.  Set the reuse delay to “5000”, don’t worry about kill or no kill, or “kill like links”, leave them unchecked.

 

Set action 00 to frob the “SucceedButton”.

 

Make sure that there’s one TrolPt INSIDE the house.  Rig up the “Assassin” with an AIWatchObj link that that TrolPt, then read “TeleportTraps”.

 

Place a TeleportTrap in a NEW blueroom, and rig it up to “TeleButton”.

 

Make the AIWatchObj link trigger when the “Assassin” comes near, and make the response be to frob “TeleButton”, link the TeleportTrap to “Assassin”, with a ControlDevice!

 

The last step is to add an alert response to “Assassin”.  Level 3, Absolute, Frob Object: “FailButton”.

 

You can alter this example!  Everything makes sense once you look at it:

 

Off the start, Garrett moves, the Emitter fires, and a conversation begins.  After a short delay (Garrett has to be able to think before he speaks), Garrett says: “That shot was meant for me!”, then, after another delay, the Assassin walks off.  Then, after another short delay, it’s “These creeps are going to lead me right back to whoever sent them to kill me, but only if I can tail them without them noticing me.” (Hence the Alert Response for “Assassin”), and new objectives.

 

The “FollowingStim” emanates from the Assassin, and whenever Garrett receives it, he stimulates the Assassin, who, in turn, frobs a button, starting a conversation.

 

You’ll remember, from the “Conversations” section you were instructed to read, that whenever an AI receives a conversation, he/she terminates whatever conversation he/she was participating in (if any).

 

Since the FollowingStim pulses 1.5 times per second, and the “TimerConv” waits one second before failing the mission, the mission won’t fail unless Garrett leaves the radius around the Assassin (50ft).

 

If Garrett succeeds in tailing the Assassin back to the house, the Assassin will frob and button to succeed the mission upon entering the front door.

 

Thanks to our unique RelayTrap/DestroyTrap setup, frobbing the “SucceedButton”, will destroy the relay, so no matter how many times the servant in “FailConv” frobs the “FailButton”, the ControlDevice signal will never reach the appropriate QVar, and as such, Garrett succeeds!

 

Probable alterations: If you’re using this in a REAL mission, you’ll probably want to change the fourth servant’s conversation around a bit, so that while succeeding a mission objective, several more are added.  In this setup, we have a “Wait” for 2 seconds so that the schema can finish before the mission ends in success.  Normally, the “QVarButton” would be linked to several QVars, one to succeed the “following” objective, and several more to reveal additional objectives…therefore, you wouldn’t want a delay, you’d want the comments, and succeeding/unveiling to happen simultaneously, therefore the “Wait” action wouldn’t be there, and the “Frob Object: QVarButton” would probably be STEP 00: Action 01.

 

You’ll probably want more assassins…if this is the case, have them stay together, have them BOTH have the fail mission alert response but have only one radiate the “FollowingStim”…it’s just easier that way.

 

You’ll probably want the first servant’s conversation to end BEFORE M-DoesPatrol is added, so that the assassins (you’ll probably have multiple) can have a very informative chat…otherwise it looks fake.  In this instance, instead of having the servant make Garrett say: “These creeps…” and have the assassin walk off, you’d have him frob a button which starts a conversation in which the assassins are the actors.  Then, at the end of the “AssassinConv”, you’d have the Assassins add M-DoesPatrol to themselves, then have them frob the button which unveils/inactivates the objectives and makes Garrett speak.

 

You’ll probably want to fiddle with the radius of the “FollowingStim”.  Maybe your city map has short streets, making it easier to tail closer, so you’ll set the radius down to 30ft…maybe you have long streets, and want Garrett to stay 70ft from the Assassins?

 

Readable Items

 

Making an item readable is fairly easy.  There are three things that are of concern:

 

The script:
StdBook or StdScroll

FrobInfo

Art

Text

 

Before you begin creating books, open up your “Thief” directory, and create a new folder, called “books”, under that folder, create “English”.  Now we’re ready to begin!

 

Let’s now explain how books work.  DROMED, when a book text is requested of it, searches the *.crfs and the “Books” folder for books of an identical name.  So, don’t go naming a book in your mission the same as a book from an OM…but I wouldn’t worry about that happening, because all the OM books have the prefix “mX”, where “X” is the number of the OM.  Since your mission HAS TO BE a number around 20, even if you use this convention, you’ll have “m20goblet”, rather than “m10skull”, which would overwrite the text from the plaque above the Skull of St. Yora, in Undercover.

 

Now, take note that all book files must be *.str, you can create them using NotePad.

 

So, pull up notepad.

 

Now, here’s the format for books, the pages start at “0” and work their way up, have as many pages as you want (although, remember, people aren’t going to read boring stuff forever, eventually they’ll dismiss it!):

 

page_0:”This is the first page…”

page_1:”This is the second page…”

page_2:”On, and on…”

 

Now, save this under “Books\English\Test.str”, inside your “Thief” directory, and restart DROMED (if it’s open), or start DROMED (if it’s closed), this is because if you create a book, then try and access it without restarting DROMED, DROMED won’t find the book, and will crash (of course)!

 

Now, he’s how things work.  You can have “Scrolls”, which are picked up and read from your inventory, or “Books” which are read in the world, and are stationary.  A “Scroll” can be a book object, and vice versa.  It’s just what you want to happen!  For example, a GoldPlaque is considered a “Book”, because it’s read in the world.  Here are the steps to create a “Scroll”:

 

Create an object (readable or not)

Remove the script: “StdBook” (if it’s there already)

Add the script: “StdScroll” (if it’s not in-place already)

Add FrobInfo: WorldAction: Move InvAction: Script

Add Book-Text, and make it “Test” (remember not to include complete directory or *.str)

Add Book-Art, and make it: “parch”, or “pbook”, you can make many more, just take a look in the books’ *.crf

 

Note: If you don’t want art, and want the text to be drawn onscreen, exclude the Book>Art property, but remember, only the first page will be drawn if you do it in this fashion!

 

Steps to create a “Book”:

 

Create an object (readable or not)

Remove the script: “StdScroll” (if it’s there already)

Add the script: “StdBook” (if it’s not in-place already)

Add FrobInfo: WorldAction: Script

Add Book-Text, and make it “Text”

Add Book-Art, and make it: “parch”, or “pbook”, or anything else fancy you’ve scrounged up!

 

There!  Objects you can read!

 

Note: A ControlDevice “TurnOn” signal will active “StdBook”, but not “StdScroll”…since one works in the inventory and the other in the world.

 

Advanced Book Techniques

 

Let’s say you want an object, that, when you pick up, displays the following text atop your screen: “This will be important later…much later.”

 

First, obviously, create the *.str file…you know how!  Make sure it’s only one page, though!

 

Now, create the object…say, the Horn of Quintus…yeah!

 

Now, go into its properties and change it’s FrobInfo.  Leave the defaults, but add the “Script” property to the WorldAction.

 

Add the following script: “StdBook”.

 

Add the Book>Text property, but DON’T add the Book>Art property…now, go in-game, and VOILA, it works!

 

Frobbing

 

Okay, all through this tut I’ve been talking about “frobbing”.  You might have gone to the dictionary and been dismayed not to find it there.  But, yes, “frobbing” is a word, and is to some, an art!

 

Frobbing is the art of activating an object.  But technically, activating implies a world action.  Basically, in order to “activate” you have to be near something!

 

That’s not the case with frobbing.  That’s the beauty of it!  Frobbing is completely internal!  There’s no default action when an AI “frobs”, you have to manually prescribe it, meaning you can do all sorts of nifty stuff with frobbing, when the button being activated is hidden, perhaps in a BLUEROOM!

 

There’s one link that concerns frobbing…FrobProxy, FrobProxy links make it so, if you frob the “From” object, the “To” object is frobbed.

 

Frobbing will be discussed more in-depth in the following sections: “Conversations”, “The Infamous AIWatchObj Link”, and “Responses”.

 

MetaProperties

 

You may be wondering about these “MetaProperties”.  Well, MetaProperties are collections of properties.  They are advantageous because they save time, in that you can add several properties at once, and their useful because most of them shipped with Thief, and can be used to produce effects that were used in the OMs.

 

Another good thing about MetaProperties, they can be added by AIWatchObj (see “The Infamous AIWatchObj Link) links, Responses (See “Responses”), and by Conversations (See “Conversations”).  Using the “Add/Remove MetaProperty” action.  But we won’t get into that now.  That’s covered by the section: “Conversations”.

 

Now, you want to create a new MetaProperty!  So, open the object hierarchy, and then, in the drop-down box at the top select “MetaProperties”.  Here are all the metaproperties currently in your gamesys (See “The Gamesys and You”).

 

Now browse through the archetypes until you find an archetype suitable to add your MetaProperty to!  Now click on the archetype, and hit “Add”.  Now type the name of your MetaProperty.  Then press “Enter”.  Now your new MetaProperty will appear.  Click on it, and press “Edit”, to add the appropriate properties to your MetaProperties.

 

Remember, if you modify and/or create new MetaProperties, you must save your gamesys!  See “The Gamesys and You”).

 

And here’s a list of useful MetaProperties:

 

M-AlertCapZero
The AI isn’t alerted unless nearby AIs are alerted or unless you take hostile action.

M-GoodGuy
Makes the AI good.

M-BaseRamirez
Makes the selected AI Ramirez.

M-BaseServant
Is a servant.

M-BaseGuard
Is a guard…useful for making non-hostiles into hostiles.

M-ServantWithTray
Makes a servant, into a servant with a tray.

M-PosedCorpse
Make an AI dead.

M-ZombiePossum
Makes a lying down Zombie that will activate when you walk over it.

M-CannonFodder
One shot kills.

M-CuttyCritter
Makes an AI into Cutty.

M-FrobInert
Sets FrobInfo to: “[None],[None],[None]”.

M-FrontGateGuard
The AI is non-hostile until alerted or threatened, however, there are some STRANGE repercussions with this one…see below!

IsLoot
See “Making Objects Loot”.

M-KnockedOut
The AI is Koed

M-NeverEfficient
See “Blueroom Conversations”.

M-DoesPatrol
The AI does patrol.

M-ResettingLockbox
The lockbox resets after a short period of time.

M-SecureDoor
Use in conjunction with “SecureDoor” script.

 

Tip: When making cities where the populace and guards shouldn’t be hostile unless attacked or alerted, or unless the player enters a door he shouldn’t, see “Undercover-Style Missions”.

 

Note: On “M-FrontGateGuard”.  This metaproperty is useful AND not useful at the same time.  It is most inhibitive to normal conversations (speaking rather than effects), since the metaproperty doesn’t KEEP guards from being alerted, but much rather forces them not to ACT as if they’re alert…this can also cause some truly WEIRD problems with pick-pocketing and raising your weapon!  Since alertedness is a lingering thing, and doesn’t merely vanish along with the player, AIs with “M-FrontGateGuard” will react to a raised blackjack EVEN IF YOU SNEAK UP ON THEM!  Meaning that these AI can’t be KOed normally.  They sense a raised weapon ANYTIME after they’ve seen you!  Same thing with pick-pocketing!  If you walk by the guard on the street, then sneak up on him a moment later and try and take his purse or key, he’ll react even if you’re behind him or in the shadows!  Basically, I’d avoid this metaproperty and use the much more useful “M-AlertCapZero” instead!

 

Making Objects Loot

 

First, select the object you want to be loot, and add the MetaProperty “IsLoot”.

 

Now Add>Dark Gamesys>Loot, and fill in the appropriate values.

 

Conversations

 

Okay, here we go, THE SINGLE MOST COMPLEX SUBJECT IN DROMED!  Yikes, you might be saying, I’d better turn this off…but don’t, and don’t skip it either.  Conversations can be used for more than talking, that’s what makes them so good!  You can add/remove MetaProperties, add/remove links, FROB, play motions and sounds, make AI go-to and wait!

 

If you ever hope to do ANYTHING cool with DROMED, you’d better get to know conversations, intimately!

 

First, what is a conversation?  A conversation is a marker (usually), with the script “TrapConverse”, it also has two other properties, but we’ll discuss those later!

 

You can have up to SIX actors in your conversation.  Remember, EVERY CONVERSATION MUST HAVE AN ACTOR, even if it doesn’t really use that actor…and EVERY ACTION MUST HAVE AN ACTOR, even if that actor isn’t involved in the least!  It’s another one of those crazy DROMED things.

 

So, make your marker, and add the script: “TrapConverse”.

 

Now link the marker to your actors:

 

Flavour:
AIConversationActor

From:
Conversation

To:
Actor

Data:
Actor# (CRUCIAL, must be defined)

 

There!  But we’re not doing much yet!  Firstly, the conversation doesn’t know what to do with itself, and it doesn’t know when to start!  Wow, so much left to explain (and read).

 

Now, let’s add the necessary properties.  First Add-AI-Conversations-SaveConversation.

 

Check the box and hit “OK”.  Now Add-AI-Conversations-Converation.

 

A HUGE box will pop-up.  Be sure your screen resolution is at least 1024x768 before attempting.  Just dismiss all the boxes with “OK” in succession, don’t even worry about the contents!

 

Now, the conversation has the properties (even if the values of the main conversation haven’t been filled out).  Now, we need to manipulate the actors.  If this is going to be a “conversation” per say, you’ll need to assign the actors the correct voices.

 

Let’s make the conversation between two servants…here are the lines:

 

MaleServant:
“Do you ever feel like there’s someone…watching you?”

 

FemaleServant:
“The sir you mean?”

 

MaleServant:
“No, I mean more like spirits…or someone hiding, watching you!”

 

FemaleServant:
“I think it’s just the house, the shadows, they…get to you.”

 

That conversation is sv_c09, there are four lines, LineNo 1, LineNo 2, LineNo 3, and LineNo 4.

 

Now, there’s something you must understand about conversations.  Each conversation and/or sound in the game is specified by a set of data files called “Schemas”.  They assign sounds to voices, and assign sound files to lines, and assign lines to sound files.

 

But, before you can edit the schemas to make your own conversations, you need the actual set of schema files!  There are two, schemas.zip, and schemas_update.zip.  Both are available HERE.

 

We’ll get into schema editing/creating later, for now, let’s worry about re-creating an existing conversation…here’s what you’ll need:

 

A MaleServant

A FemaleServant

A RelayTrap

A DestroyTrap

2 Markers outfitted to be conversations

A Button

 

So, you’ve created all these…what do you do?  Well, for convenience’s sake, name one conversation “ServConv”, and the other “AbortServConv”.

 

Now, you remember that huge window that popped up when you went: Add-AI-Converstions-Conversation.

 

That was the conversation box!  The first box was filled with options, as detailed below:

 

00

01

02

03

04

05

06

07

08

09

10

Abort Conditions

Abort Steps

 

You remember earlier, when we created an “Alert Response”.  Well, alert responses operate on the same principle as conversations.  Only a conversation is much, much bigger.

 

The numbers are each a “Step”.  There are eleven steps.  Each step has a certain number of actions…six or seven.  So, what’s the difference between a “Step” and an “Action”.

 

Here’s the difference…all the actions within a step occur SIMULATANEOUSLY!  So, if you want someone to talk, and make a motion at the same time, put both those in the same step.  If you want someone to talk, then someone else to talk AFTER, put one line in one step, the second in the second.

 

Basically, the next step begins when all the actions in the previous step are COMPLETE.  All the actions commence at the same time!

 

Okay, feel free to pull up “ServConv”, and “Edit” the conversation.  Choose “00”, and hit okay.  Remember that in DROMED, most lists start at zero, rather than one!

 

Now, the HUGE box pops-up.  If you’re using 1024x768, the bottom and top of the box are barely visible!  Now, you’ll notice that each “Action” is made up of an “Action”, a number, like “00”, three “Arg”s, and an actor.  These “Arg”s are the arguments you give each “Action”, so it knows what each action is supposed to do.  For example, click on the drop-down box next to “Action 00”, and note all the available actions.  Most of those actions do NOTHING without arguments.  For example, the “Goto Object” action needs an argument to tell it what object to go to.  The “Add/Remove MetaProperty” action needs two or three arguments!  The “Play Sound/Motion” action can have one, two, or three arguments.  The useful actions are listed below:

 

Noting

 

Arg1:

Arg2:

Arg3:

 

Note: If you set an action to “Nothing”, data currently in the arguments won’t be lost…but it won’t be used either.

 

Frob Object

 

Arg1:
What Object?

Arg2:
With what object? (Tool or key, not necessary)

Arg3:

 

Add/Remove MetaProperty

 

Arg1:
Add or Remove?

Arg2:
MetaProperty name?

Arg3:
Leave blank for self, otherwise, specify?  (Avoid leaving blank)

 

Goto Object

 

Arg1:
What object?

Arg2:
See “Speeds”, below

Arg3:

 

Face:

 

Arg1:
Angle (between 0 and 360…if “0”, leave blank)

Arg2:
What object?

Arg3:

 

Note: If both angle AND object, the angle will be off the object.

 

Play Sound/Motion

 

Arg1:
Sound?  Or Conversation?  If any

Arg2:
If conversation, what line?

Arg3:
Motion?  If any

 

Add Link

 

Arg1:
Flavour

Arg2:
To

Arg3:
From

 

Remove Link

 

Arg1:
Flavour

Arg2:
To

Arg3:
From

 

Wait

 

Arg1:
How long?  In milliseconds (1000 equals one second)

Arg2:

Arg3:

 

Become Hostile (Sets the non-hostility property to “Never”)

 

Arg1:

Arg2:

Arg3:

 

Note: No arguments are needed.

 

Enable Investigate (Sets the “Investigation Style” property to “Normal”

 

Arg1:

Arg2:

Arg3:

 

Note: No arguments are needed.

 

Mprint

 

Arg1: Text to print

Arg2:

Arg3:

 

Note: When Thief was being created, the designers designing the levels used two monitors, a colour monitor for DROMED and Thief, and a monochrome which Thief and DROMED “spewed” to, meaning any relevant data would be spewed to the monitor, such as errors or perhaps polycount figures.  The “MPrint” action is merely a diagnostic function which would have spewed text to the monochrome monitor…you can use “MPrint”, but it’ll spew to a file called “monolog.txt”.

 

Note: Here are the speeds you can use in “Goto Object”:

 

Stopped

Very Slow

Slow

Normal

Fast 

Very Fast

 

There, now, to teach you all you need to know to get these arguments working.  Here are some good tips:

 

Garrett isn’t an object.  If you want an AI to face “Garrett”, type “Player” in the place of an object.

 

Remember that you shouldn’t use object numbers in conversations, each object used must have a unique name!

 

And now, for the motions!  Remember that the motion database for Thief has not been cracked!  Therefore our choice of motions are limited to those used in conversations in the OMs (the missions that shipped with Thief)(don’t worry about the cryptic names):

 

Conversation 0, Quux 0
Cross arms behind back

Conversation 0, Baz 0
Jump and shake arms as if agitated

Conversation 0, Baz 0, Quux 0
Raise arms as if to say “I don’t know”

Conversation 0, Bar 0
Lean backwards as if surprised

Conversation 0, Bar 0, Quux 0
Cross arms in front

Conversation 0, Bar 0, Baz 0
Move arms as if conductor conducting music

Conversation 0, Foo 0
Raise left hand and nod as if in greeting

Conversation 0, Foo 0, Baz 0
Nod head as if in agreement

Conversation 0, Foo 0, Bar 0
Take a step forward with one foot, then back

Conversation 0, Foo 0, Bar 0, Baz 0
Look right

Conversation 0, Quux 0, Foo 0
Cross arms

Conversation 0, Quux 0, Bar 0
Keep arms crossed

WorldFrob 0, AtWaist 0, BellPull 0
The “Frob” action

WorldFrob 0, WithTray 0, AtWaist 0, BellPull 0
Servant with tray puts tray down

Search 0, Scan 0
Looks around for danger

Stand2Sit
Goes from standing to sitting

Sit2Lie
Goes from sitting to lying down

Lie2Stand
Goes from lying to standing (fast)

 

Now we’re REALLY going to set the conversation up, link from “ServConv” to each of your two servants with an “AIConversationActor” link, make sure the MaleServant is actor “1” and that the FemaleServant is actor “2”.

 

Next we need to worry about their voices, in order for this conversation to actually play, we need the Male Servant’s voice to be “normal1”, and the Female Servant’s to be “normal2”, so, open their properties and Add-Speech-Voice, and set them to the appropriate values.

 

Last thing with the servants, make sure that they each have their own unique name!

 

Now we’re going to setup the conversation’s start.  The button will start the conversation, but we don’t want the conversation repeating EVERY TIME you press the button, so, create the following links:

 

Flavour:
ControlDevice

From:
Button

To:
RelayTrap (this means the RelayTrap you created earlier, type it’s obj #!)

 

Flavour:
ControlDevice

From:
RelayTrap

To:
ServConv

 

Flavour:
ControlDevice

From:
RelayTrap

To:
DestroyTrap

 

Flavour:
ControlDevice

From:
DestroyTrap

To:
RelayTrap

 

Dissecting time.  What this does, is, when the button’s pressed, it sends a ControlDevice signal to the RelayTrap.  The RelayTrap relays that signal to the conversation (which starts it), and to the DestroyTrap.

 

Remember what I said about the DestroyTrap fnord, when triggered, it destroys whatever it’s ControlDevice linked to, so when it receives the signal from the RelayTrap, it destroys the RelayTrap, making it impossible for the conversation to start over once it’s started once!  This is the same system that was used in ASSASSINS! to make sure the alarm could only be triggered once.  Only then, since there were so many buttons, they all would have been linked to a RequireAnyTrap, which would have been linked to the RelayTrap…same principle, though!

 

Now we have a conversation that has actors, and that knows when to start…but it has no actions!  Eek!  Let’s fix that!

 

Input the following variables into the steps and actions specified

 

STEP 00:

 

Actor:
1

Action 00:
Play Sound/Motion

Arg1:
sv_c09

Arg2:
LineNo 1

Arg3:

 

Actor:
1

Action 01
Play Sound/Motion

Arg1:

Arg2:

Arg3:
Choose one!

 

STEP 01:

 

Actor:
2

Action 00:
Play Sound/Motion

Arg1:
sv_c09

Arg2:
LineNo 2

Arg3:

 

Actor:
2

Action 01:
Play Sound/Motion

Arg1:

Arg2:

Arg3:
Choose one!

 

Step 02:

 

Actor:
1

Action 00:
Play Sound/Motion

Arg1:
sv_c09

Arg2:
LineNo 3

Arg3:

 

Actor:
1

Action 01:
Play Sound/Motion

Arg1:

Arg2:

Arg3:
Choose one!

 

Step 03

 

Actor:
2

Action 00:
Play Sound/Motion

Arg1:
sv_c09

Arg2:
LineNo 4

Arg3:

 

Actor:
2

Action 01:
Play Sound/Motion

Arg1:

Arg2:

Arg3:
Choose one!

 

Okay, go in-game and try it out.  You’ll see that it works, but since the AI are aware, they run off to a flee point, but their lines still go on?  That’s so cheesy!  Let’s fix it!

 

Now, open up the conversation, and in the “Steps” dialog, choose “Abort Conditions”.  Set the abort level to “3”, and the priority to “Absolute”.

 

This means that when either of the servants reaches alert level 3, (s)he’ll abort the conversation without delay!

 

Okay, so, what if you use a gas arrow…they won’t be alerted if they don’t see you…oh no!  They’re lying on the floor, still talking?  That’s BAD!

 

Hence the “AbortServConv” conversation.  We’re going to add some receptrons!  For more info on both receptrons and their opposite, sources, see the section: “Sources and Receptrons”.

 

Before we do anything, create a button that the player can’t get to (blueroom) and link it to “AbortServConv”.  Then do the AIConversationActor links.  Now, slap a motion in there for both servants…don’t worry, if they’re knocked out, they won’t perform the motion!  Now, make sure the button has a unique name…how about “ServAbortButton”.

 

Now, go into the first servant’s properties and Add-Act/React-Receptrons, a dialog that looks like a link box should come up.  Hit “Add”.

 

This box is indeed VERY confusing.  But don’t worry, I’ll walk you through what we must do!

 

First, set the stimulus to “KnockOut”.  Then check the “No Max Intensity” box, and leave the “Min Intensity” at 0.  Now, set the action to “Frob Object” (yes, AI can frob while their knocked out), and set the object to be frobbed to “ServAbortButton”.  Now click okay, and dismiss both boxes.  Don’t worry if the receptrons box pops back up, it’s a bug, just dismiss it again!

 

Do the same thing for the other servant.

 

The principle here is that when an AI is in the midst of a conversation, that conversation can be overridden by the AI being told to participate in ANOTHER conversation…meaning that we can terminate this conversation by starting ANOTHER conversation that does absolutely NOTHING!

 

And remember that conversations are good for more than just talking!  And remember NOT TO HAVE ABORT CONDITIONS OR ABORTING IN ANY WAY on effect conversations…that is, one’s that DON’T make the AI talk.  If these conversations abort halfway through, weird things could happen!

 

Note: Make sure that all AIConversationActors are within a roombrush, otherwise they will fail to function.  Also, ensure that after you roombrush these actors, that you process the AI Room Database!

 

Blueroom Conversations

 

Please read: “Conversations” first.

 

When creating effect conversations with actor(s) in bluerooms, be sure to add the following metaproperty to the actor(s): M-NeverEfficient, otherwise the conversations won’t work when you’re outside a certain radius of the AI…also, make sure that the blueroom is roombrushed, and that the AI Room Database has been built since that roombrush’s creation.

 

Ambient Sound

 

Ambient sound is exceptional!  It adds depth!

 

To insert an ambient sound, create a marker, and Add-A-AmbientHacked.

 

The following options are in this dialog.  Here’s what they do:

 

Radius
The radius of the sound (feet).

 

Override Volume
Volume, -1 is loudest, lower than that is softer.

 

Schema Name
The name of the sound.  See Sounds-Schemas in the obj hierarchy.

 

Aux Schemas 1 & 2
More schemas to play.

 

Flags, see below:

 

Environmental Sound
Turns the sound into an environmental sound.

 

DestroyObj
Destroys the object upon completion of the ambient sound.

 

RemoveProp
Removes A-AmbientHacked at the completion of the ambient sound.  Note that with this flag active the ambient sound will NOT activate until the player enters a radius within which he/she would be able to hear it (the number in “Radius”)

 

TurnedOff
Mutes the sound

 

DoAutoOff
Adds “TurnedOff” at the completion of the sound.

 

NoSharpCurve
The sound fades gradually as you approach and walk away from it.

 

You can fiddle with sounds by opening their properties in Sounds-Schemas.

 

To see how you can create schemas of your own, see “Schemas”.

 

Garrett’s Comments

 

Okay, you want Garrett to talk.  Now, Garrett can’t be an actor, per say, because he’s not really an object.  Sure, you can have AIs face him (Face object “Player”), but he can’t be an actor!  Or what happens if you just want him to say something cool, like…“Inside at last.”

 

Is that so much to ask?

 

No.  I’ll explain.

 

First, create a VOTrap…anywhere.  VOTraps aren’t like normal sounds.  They don’t fade as you get farther away.  They’re omnipresent, because they’re not really sounds…the AI can’t “hear” them, like they can hear your footsteps!

 

To learn more about creating custom comments, see “Schemas”.

 

Now.  Since Garrett can’t actually speak in a conversation…what do we do?  Well, you read “Schemas” and create the lines you want as if they’re comments!  Now, in a blueroom create as many VOTraps as you’ll need (one for every line), a button for each, linked to them all, and an AI to talk to.

 

Now give the AI his lines, and have him frob a button when Garrett’s supposed to talk.  Now, the problem is, that the AI won’t wait for Garrett to finish talking!  So, you’ll have to listen to each of Garrett’s comments, and see how long they are, then, after the AI frobs the button, have him “Wait” for the correct amount of time before moving on.

 

Okay, so you’ve created this setup.  But nothing happens, the AI talks, sure, but that’s old hat.  We want GARRETT to talk.

 

So, we must find the name of the comment we want Garrett to say.  Say, “garm1101”.  That’s valid!

 

Now, in order to have a VOTrap play a sound, you must link a VOTrap to the object archetype of the sound.  So, open up the VOTrap’s properties, and Add a “SoundDescription” link from it, to the archetype.

 

Now test it out!  There, Garrett speaks!

 

SoundTraps

 

It is recommended you read “Garrett’s Comments” before reading this.

 

SoundTraps work EXACTLY the same as VOTraps, with one exception, the sound they create originates from the EXACT point in space they occupy, and disperses!

 

Responses

 

A response is an AI’s way of dealing with something they see.  For example, if you want an AI to push a button when it becomes alert, you’d setup the Alert Response like a conversation telling the AI to push the button.

 

There are four different responses:

 

Alert Response
What an AI does when the player alerts it.

 

Threat Response
How the AI responds to a certain threat.

 

Body Response
What the AI does when it sees a knockedout or dead AI.

 

Sense Combat Response
What the AI does when it senses combat nearby.

 

If you need the AI to do more actions than actions in the response box, make the AI frob a button starting a conversation when a response is triggered!  See “Conversations”.

 

The Infamous AIWatchObj Link

 

The AIWatchObj links is like a mini-conversation, triggered when either the player enters a radius around the watched object, or when it enters a radius around the object.

 

AIWatchObj links are more reliable than BoundsTriggers, and are unique in the way that they’ll trigger even if they’re created when the watched object is INSIDE the radius…BoundsTriggers won’t trigger if they’re ControlDevice link is created after an object has entered them.

 

There are many fields in an AIWatchObj.  The lower half of the dialog is just a conversation, and you already know about those, so I’ll explain the interesting fields:

 

Watch Kind:
Self or Player?  Who enters the radius in order for trigger?

Height:
The height is centered on the watched objects center

Radius:
What radius off the center of the watched object?

Required Awareness:
How aware does the AI have to be of the player?  None means any

Line Requirement:
Three options, raycast, none, and Line of Sight…explain below

Minimum Alertness:
Minimum AI alertedness

Maximum Alertness:
Maximum AI alertedness

Kill Like Links?:
Kills all similar links emanating from the watching object

No Test Once Trigger?:
See below

Link Kill Options:
Don’t Kill, After Trigger, After Completion

Reuse Delay:
See Below

Reset Delay:
See Below

 

Most of the fields are pretty easy to use, but some of them are awfully complicated!

 

“No Test Once Trigger”, means that all the actions will run, doubtless whether the watched object leaves the watch cylinder.

 

“Reuse Delay” specifies how long after link completion until the link can re-run.

 

“Reset Delay” specificies how long after termination until the link will reset (be reuseable)…note the “termination” is different than “completion”…termination means that the watching AI stopped the progress of the “pseudo-script” (all the actions in the watch link’s action fields) before it’s completion.  This will ONLY occur if the AI receives a conversation to perform or he terminates the pseudo-script because the watched object leaves the “watch cylinder”.

 

Please note that “Required Awareness” applies ONLY to “Player Intrusion”.

 

“Line Requirement” is also a bit ambiguous.  The three options mean:

 

None:
The link will trigger doubtless where the object is, as long as it’s in the “watch cylinder”

Raycast:
There must be some direct line, uninterrupted by objects that block vision, between the watching object and the intruding object.

Line Of Sight:
The watching AI must be able to “see” the intruding object.

 

Also note that “Link Kill Options”, “Don’t Kill”, means just that, the AIWatchObj link will remain forever, unless removed by a conversation, or unless the watching AI is slain or destroyed.  “After Trigger”, means that the pseudo-sript will execute, but the link will kill itself as soon as it triggers.  “After Completion” means that should the pseudo-script EVER fully execute, it will be killed then.

 

AIWatchObj links are GREAT for triggering player-involved conversations.

 

Here’s how you do it.  Link a button to a conversation with the player involved.

 

Next, create an AIWatchObj link to a “Marker” centered on the AI conversing (you could CreatureAttach this marker, should this AI be moving).  Make the AI “watch” the object, with the following parameters:

 

Watch King:
Player

Height:
10

Radius:
10

Required Awareness:
3

Line Requirement:
Line Of Sight

Minimum Alertness:
0

Maximum Alertness:
3

Kill Like Links:
True

No Test Once Trigger:
True

Link Kill Option:
After Trigger

Reuse Delay:
10000

Reset Delay:
10000

 

Then make the sole action be to frob the button.

 

What does this do?  It triggers as soon as the AI can “see” the player!

 

There’s but one thing, two scripts that relate to “AIWatchObj”, “WatchMe”, and “SecureDoor”.

 

“SecureDoor” adds an “AIWatchObj”-link from every AI to that object when the door opens, removes on close.  You can make the “AIWatchObj” function properly by, after adding this script, add the property: “M-SecureDoor”.

 

“WatchMe”, adds an “AIWatchObj”-link from EVERY AI in the level to that object as soon as the simulation commences.

 

Please note that “AIWatchObj”-links CAN be added in-game, however, if you want any data in the link, you’ll have to Add>AI>Utility>Watch: Watch Link Default, to the object TO BE WATCHED.  This way, any “AIWatchObj”-flavour link added mid-game will default to those settings…but only on the object having this property.

 

Making a Bow Object

 

So, you’re just clipping along through your FM.  But, you’ve created an armory, and you want a few bows lying around along with your swords.

 

You’ve searched the obj hierarchy, but haven’t found one.

 

So, let’s create one!

 

Create a Physical>Debris>Rubble>broke_sword

 

Now, open up it’s properties, and Add>Shape>Model Name.

 

Type: “bow”.

 

Hit enter.

 

And you’re done!

 

Making a Quiver

 

So, you want a quiver?

 

Okay, let’s do that!  Create Physical>Container>Footlocker.

 

Now open the footlocker’s properties and Add>Shape>Model Name, change it to: “quiver2”.

 

Now add a “Contains” link FROM the quiver TO some arrows!

 

Then Add>Schema>Class Tags:

 

That’s right, make the field BLANK!

 

DONE!

 

Try using “CreatureAttachement” (See “Useful Links”) link to attach the new quiver to an archer’s back, then people can sneak up behind the archer, and take his arrows!

 

Stairs

 

Stairs are a must-have in Thief, but they’re exceptionally hard to make.  You must turn the grid size down to at most 13, then make each individual stair from a solid brush.

 

That’s just for a square staircase!  Circular staircases actually require some mathematical skill!

 

Don’t worry, I’ll show you the formulae:

 

The basic principles are:

 

A circle is 360 degrees around

 

The stairs are 1 foot high and 1 foot deep (as big as they can go for AI)

 

The circumference of a circle is (R x 2) x pi

 

Okay, make your air brush that you want your stairs inside…then make a solid core (if you want, not mandatory).

 

Now, here’s the formulae:

 

Variables:

 

SH = Stair Height

SD = Stair Depth

R = Radius

C = Circumference

SW = Stair Width

D = Diameter

P = Pi, or 3.14, which is the ratio of a circle’s diameter to its circumference

SC = Numbers of stairs in a circle (unknown at first)

SA = Degrees each stair should be rotated from the last (unknown at first)

IC = Stairs in circle

RH = Height of one full rotation of stairs

 

Formulae:

 

D/2 = R

 

(R*2)*P = C

 

360/C = SA

 

360/SA =  IC

 

IC = RH

 

So, what do we do with all this?  First, we create a block of solid whose width is equal to the circle’s radius, or diameter divided by two.  Then we rotate it the number of degrees specified by SA, then we line it up with the center, and rotate it another SA degrees, and so one until we reach the desired height.  The number of feet the stairs will rise in one full rotation is equal to RH.  Here’s the formula if you’re stairs AREN’T 1 foot high and 1 foot deep:

 

D/2 = R

 

(R*2)*P = C

 

C*SD = X

 

360/X = SA

 

360*SA = IC

 

IC*SH = RH

 

Same instructions as above.

 

Elevators

 

The first thing to do is create a shaft in which the elevator may move.

 

Create TerrPts at the exact locations (and headings), you want the elevator to stop at.  Remember that the elevator DOESN’T have to move up and down, but can move diagonally, horizontally, or any way.  Link the TerrPts to one another with TPath-flavour links, just like you’d link patrol routes…only this time fill in the link data to match the appropriate speed (in feet per second), delay time (in milliseconds…this is the amount of time (if any), that the vator on this route will pause at the TARGET TerrPt), and whether or not the path between these two TerrPts is limited (can the vator stray a bit from it’s path as a result of forward/backward or up-and-down motion?  Basically, when the vator hit the next TerrPt, does it stop, or recoil a bit as a result of inertia?).

 

Create an elevator (Under physical>TerrainLike), and place it anywhere (ANYWHERE).

 

Next, link it to the first TerrPt with a “TPathInit”-link.

 

Lastly, decide if you want this vator to start out moving.  If not, adjust it’s “Moving Terrain” property to be: Is Active?: FALSE.

 

Now, link buttons to the appropriate TerrPts OR link a switch to the VATOR ITSELF.  In the switch/lever setup, the vator will automatically decide which extreme of the route to go to.  You’ll just have to figure it out and adjust the lever’s starting position!

 

Note: The vator will AUTOMATICALLY move itself to, and orient itself with, the TerrPt it’s TPathInit-linked to.

 

TeleportTraps

 

Like frobbing, teleporting is an art.  Use TeleportTraps if you want your level to be dynamic, rather than static.

 

Let’s say you want a mission where you have to kill someone, and get out.  So, create a room with the special somebody, connected to the starting room via a hall.  Now, we’re not going to have real objectives…we’ll just pretend!

 

Now, create a blueroom…that’s a room off in space with no lightsources where the player could never go.  It’s for storing things used behind the scenes, like plaques or buttons used exclusively by the AI.  Or, we can hide our teleporting AIs there!  Let’s do that!  Make two RamirezGuards, and put them in the blueroom.

 

Now, create Ramirez.  How?  First create a merchant, then Add-MetaProperty, and add the MetaProperty “BaseRamirez”.  There.  Good!

 

Next we add a script to Ramirez: “TrigSlain”.

 

Now, add two TeleportTraps, one where you want each guard to be.  Create the following links:

 

Flavour:
ControlDevice

From:
Ramirez

To:
TeleportTrap1

 

Flavour:
ControlDevice

From:
Ramirez

To:
TeleportTrap2

 

Flavour:
ControlDevice

From:
TeleportTrap1

To:
RamGuard1

 

Flavour:
ControlDevice

From:
TeleportTrap2

To:
RamGuard2

 

There, now set up your StartingPoint and give yourself a sword…now go in-game, and go slaughter Ramirez in a duel!  Mace against sword!  Of course, you, being the super-Thief you are, did kill Ramirez…without loosing a health point.

 

Now go back to the room you started off in…surprise surprise!  There’s two RamGuards waiting for you!

 

Wonderful, huh?

 

To see bluerooms and TeleportTraps in real-life action, check out ASSASSINS!  Make sure you get the unstripped version from www.thief-thecircle.com/teg-old/tools though.
 

Emit Traps

 

Emit Traps are ultra-cool.  They make the player think in an all-new Thiefy way!

 

You can set up emit traps to shoot the following (these are the names of the objects in the emit trap dialog as well):

 

broadhead

magicmissile

rock

apple

sword

webshot

Tiltawirl

 

Keep in mind that an emit trap is invisible, but it’s always good to put it in a hole in the wall!

 

Okay, now, create an emittrap (if you want your emit trap to fire only once), or emitstreamtrap (if you want your emit trap to shoot forever while “On”…or at least the number of times defined in “Max Frames”), and place it in the world.

 

Now open it’s properties, and edit “Tweq-Emit”.

 

There are a few options in here:

 

Halt
Ignore

AnimC
Sim for emittrap, Sim,NoLimit for emitstreamtrap

MiscC
Ignore

CurveC
Ignore

Rate
1 for emittrap, 1000 for emitstreamtrap

Max Frames
1 for emittrap, 0 for emitstreamtrap

Emit What
What is going to be emitted.

Velocity X
How fast the projectile moves along the X axis, see below

Velocity Y
How fast the projectile moves along the Y axis, see below

Velocity Z
How fast the projectile moves along the Z axis, see below

 

Okay, now to explain the “Velocities”.

 

X
North and South.  Negative is north (south is “down”)

Y
East and West.  Negative is west

Z
Up and Down.  Negative is down

 

Now all we need to do is link something to the emit trap via ControlDevice.  Make it anything, a pressure plate, a concrete room (See “Roombrushes”) with “TrigRoomPlayer”, a BoundsTrigger…anything!

 

Note: If you want an EmitTrap that fires multiple times, but NOT in a stream, then create an EmitTrap, open it’s properties, and Add>S>Scripts: ReloadTweqEmit.

 

Sources and Receptrons

 

Before you go fooling around with Sources and Receptrons (S&R) or Act/React (A&R), be sure to save your mission…or at least be aware of the S/R window bug.  When you choose to add a Source or Receptron, a window appears.  You can use this window to add/remove S/R, but if you try and close it with “OK”, and leave the window empty, the box will pop back up again…this will happen even if you add a source or receptron (but only the first time), if you press “OK” again, and STILL leave the box empty, then DROMED crashes…so, if you’re stuck in an S/R window you don’t want, add a fake source or receptron, then dismiss the box, after you’ve added a source or receptron, you can safely open the box, remove the incriminating S or R, then dismiss the now-empty box!

 

Next I’ll explain what, exactly, S&R is.  Act/React is one of the systems Thief uses to manage object interactions…links are a second, and frobbing is a third.

 

Act/React is a very useful tool…and employs the useage of “stims”.  These stims are nothing at all…the only things you’ll see in the properties of a stim (all the Thief stims can be found by opening the object hierarchy, then select “Act/React Stimuli”, in the drop-down box at the top.), are the properties “Damage Type” and “Is Knockout”.  You’ll never see properties like “Dimensions”, or “Scripts”.

 

Now, to list the relevant Thief stims that are default:

 

Weaponstim
Any weapon has this
Pokestim
Broadhead Arrows have this
BugPoke
Insects have this
Slashstim
Specific to a sword
Bashstim
Blunt weapons such as a blackjack
Water
Water arrows have these, as does any “water” in Thief
Fire
Fires, and fire arrows
Touch
I believe this has to do with contact with terrain brushes
Holy
Holy Water Arrows have this
Knockout
A blackjack has this
Restore
Healing potions have this, as does healing fruit
KOGas
Gas arrows
MagicZapStim
Wizard and trap zaps
LightBright 
Flashbombs
Toxic
Poisonous gas
Stench
From a burrick's maw
Earthstim
Moss arrow

 

You’ll see that there’s the “Knockout” stim, and there’s the “Bashstim”.  The blackjack possesses both of these…you might have experienced blackjack-killing at one time or another, and we’ll find out how, exactly, Thief decided that a guard should/shouldn’t be blackjacked…you might think it’s an internal thing…but how, then, can you explain that servants and other bystanders can be KOed on the first whack EVERY TIME?  You’ll learn about this in the “receptrons” section…look for an effect called “Awareness Filter”.

 

First, we’ll explain the magic of Sources.  A source is where a stim originates.  An object with a “Source” propagates a stim in some way or another, and we’re going to learn how!

 

Create a dummy object (a chair?) to experiment with…we’ll use this for both receptrons and sources.

 

Open up the dummy object’s properties, then Add>Act/React>Sources.

 

There will be four buttons and a list in this next dialog.  The list is where the current sources appear, the buttons are labeled: “Add”, “Delete”, “Edit”, and “OK”…remember the bug when using “OK”.  “Edit” will edit a selected source, “Delete” will, of course, remove the selected source, and “Add”, adds a new source…let’s add a source NOW.

 

Okay, in the next dialog, you’ll see three buttons, and four fields…first we’ll discuss the fields, because they’re CRUCIAL to what buttons are applicable (excepting “OK”…of course)…the fields are:

 

Name
The name of the object you’re working with

Stimulus
The stim you want to add (or edit) a source for

Propagator
How is the stim to be propagated (discussed later)?

Intensity
Of what numerical intensity do you want the stim to be?

 

The first two fields are self-explanatory…please note that there’s a weird bug…if you fill in “name”, then change the stim…the name disappears!  If you fill in “intensity”, then change the stimulus or propagator…the intensity disappears?  Be aware of this when editing or adding stims!

 

It’s the last two fields that need explaining…propagator is how the stims will be propagated…here are the options:

 

Contact
Contact (you can choose what kind)

Radius
The stim is spread over a certain radii from the object

Script
A script is responsible for propagating this stim (think: “Healing Potion”)

Flow
Step inside the flow brush, you’re stimmed!

 

Okay, of the last two buttons, “Edit Shape” and “Edit Life Cycle”, “Edit Shape” is applicable for only “Contact” and “Radius”…“Edit Life Cycle” is applicable for “Flow” and “Radius”…why?  Because area stims (stims spread over a certain area…like “Radius”), pulse every how often (you set), and may have a max number of pulses (called “firings”) (you set), or their firings may decrease or INCREASE in intensity (you set).  “Edit Shape” is applicable for “Contact” because you have to set the TYPE of contact, or the velocity the objects involved must equal to, and is applicable for “Radius” because you have to set-up the radius or dispersion (how much does the stim increase/decrease the farther or closer to the source it gets?).

 

Now that you know all this, select “Radius” first…because for user-created stims, it’s usually “the one”.

 

Type an arbitrary intensity (say “50”?), and select a cool stim (PokeStim), type the object number, and then hit “Edit Shape”.

 

Okay, there is one button (“Flags”), a drop-down box, and a field…here they are:

 

Radius
What’s the radius of the stim? (In feet)

Flags
Only one “Line of Sight (raycast)”…does the stim propagate through opaque objects?  Like walls?

Dispersion
Linear (weaker the farther away), or Inverse Quadratice (weaker the closer)

 

Set the radius to…say: 50, put the “Line of Sight (raycast)” flag in-place, and then select: “Linear” as the dispersion (you can select “None”).

 

Next, let’s edit this thing’s life cycle…so hit “Edit Life Cycle”.

 

This time you have four fields, and one “flags” box:

 

Flags
Is there a number of max firings?

Period
How long, in milliseconds, between firings?

Max Firings
Leave at “1” if the flag is in-place…otherwise, numerical

Intensity Slope
How much does the intensity increase (negative for decrease) each firing?

 

Set the “No Max Firings” flag in-place, set the period to “5000”, and leave “Max Firings” and “Intensity Slope” alone.

 

There!  Dismiss the dialogs, then go in-game.  Get close to the chair (within 50ft), and you’ll start loosing health, why?  Because the chair is simulating an arrow-hit every 5 seconds within an radius of 50ft!  The closer you get to the chair, the more health you loose every 5 seconds!

 

Go out-of-game, then go back in and edit this stim…let’s try out “Contact”, in “Edit Shape” (the only available option) there is one selection box, and two fields:

 

Contact Type
Collision, Frob in Inv, Frob in World, World->Inv, Inv->World, Weapon Swing High, Weapon Swing Med, Weapon Swing Low, Weapon Block

Velocity Coefficient
The total of the objects’ speed necessary for the stim to be propagated

Frob Time Coefficient
How long you must frob for the stim to propagate

 

Okay, in “Contact Type”, there are nine options:

 

Collision
When this object and another collide in the world

Frob in Inv
When this object is frobbed in the inventory

Frob in World
When this object is frobbed in the world

World->Inv
When this object transitions from the world into the inventory

Inv->World
When this object goes from the inventory into the world

Weapon Swing High
A full-powered weapon hit

Weapon Swing Med
A medium-powered weapon hit

Weapon Swing Low
A normal weapon hit

Weapon Block
When a weapon is blocking

 

Note: “Frob in World”, you can’t frob in world unless the FrobInfo/WorldAction, has an action…you can workaround this by adding the script: “StdButton”, and making the WorldAction: “Script”, if the object start out FrobInert…this way you don’t have to link it to anything, yet it’ll still frob (bug-free)!

 

In all cases, the stim is propagated to the other object involved (the object that is struck by a weapon hit…the object frobbing this object…the other object in the collision)…remember that in order for a source to have an effect, the object being stimmed must have a receptron to that stim!

 

Now that sources have been covered, let’s cover receptrons!

 

Create another dummy object nearby.  A table, perhaps.

 

Open up its properties, and Add>Act/React>Receptrons…remember THE bug!

 

Now, “Add” a receptron…you’ll be faced with a daunting dialog.  The following fields are available:

 

Name
Name of the object you’re working with

Stimulus
The stimulus you want the object to react to

Min
The minimum intensity the object will react to (check the box for none)

Max
The maximum intensity the object will react to (check the box for none, but both min AND max can’t be “None”)

Effect
What does the object do to react?

Target Object
Only some effect need this…more in-depth later

Agent Object
Only some effects need this…more in-depth later

Edit Effect
Certain effects need extra data, this will bring up a dialog

 

Next I’m going to list the effects, and tell about each one:

 

None – This is a bug…DROMED will crash if it’s selected!

Amplify – Amplifies the selected stim when it’s received…zombies have this for the HolyStim, use “Edit Effect” to specify the multiplication or addition to the intensity of the stim.

Awareness Filter – Use “Edit Effect” to specify when to abort and when not to.

Add Metaproperty – “Target Object” is the object to add the metaproperty to…“Agent Object”.  There’s a bug, though, the “Target Object” is always “Me”, no matter what you tell it be.

Change Object Model – “Target Object” is the object whose model you want to change.  “Edit Effect” and type in the name of the desired model.

Clone Properties – Allows you to completely clone the properties of another object…INCLUDING position!

Create Object – “Target Object” is the archetype number of the object you wish to create…“Agent Object” is the object where you want to create the object…use “Edit Effect” to off-set the create position from the “Agent Object”.

Damage Object – Damages the “Target Object”.  Use “Edit Effect” to add and multiply…remember that you can use different stimulus’, since AIs have different motions and sounds depending on which stim injures them!

Destroy Object – Totally annihilates the “Target Object”…be careful, “Slay Object” is different in that a slain object has a corpse (usually), whilst a destroyed object just sort of…vanishes!

EnvSound – ???

Freeze AI – Freezes “Target Object” for a duration (in milliseconds) specified in “Edit Effect”.

Impact Result – This has something to do with “Contact”>“Collision”-type stim propagation…?

Knockout – KOs the target AI.

Permeate into Container – Stims all “Contain”ed objects.

Poke Object – T2 Only…useless…basically the same as “Damage Object”.

Remove Property – Removes a property from the target AI…be careful with this one, use “list_props X” in the command box to list the properties referencing codes to a file.  Use only the codes in that file…same goes for “Set Property”.

Send to Scripts – Sends to the scripts…and example would be the script: “Extinguishable” on a torch.

Set Property – Sets a property on the “Target Object” from the “Agent Object”…remember the special property referencing system described under “Remove Property”.

Set Quest Variable – Use this one in the place of QVarTrap.

Slay Object – Kills and corpses the “Target Object”.

Stimulate Object – Stims the “Target Object”, courtesy of the “Agent Object”…you can set which stim and multiplication and addition in “Edit Effect”.

Teleport Object – Teleports the “Target Object” to the “Agent Object”…remember that you can off-set the teleport location using “Edit Effect”.

Tweq Control – Ooh…a toughie…adjusts “Tweq” properties…you don’t have to worry about Tweq properties at this time.

Weak Point – T2 Only.  Allows amplification of a stim ONLY if it hits a certain co-ordinates on the model…look at the CombatBot to see this in action…their boiler is a weak point.

Weapon Block – Doesn’t work…a bug.

Weapon Hit – Doesn’t work…another bug.

 

There you go!  Now you know ALL that there is to know about S&R!  Use your knowledge well!  And remember to think of UNCONVENTIONAL ways to use S&R!

 

Note: When altering the hierarchy, try not to refer to objects in-world directly…for example, if Garrett receives “ScrollStim” (this stim doesn’t actually exist, but you could create if you needed it…see below), and you want him to frob “A table (765)”, don’t set the effect to “Frob Object”, and set the Target to “765”, because doing this could result in WEIRD gamesys errors if you open your gamesys with any other mission than the one you’re working on!  Try to have Garrett do ambiguous things, like “Frob Object”, “Target Object”: Source…then give the target object a “ControlDevice” link to a conversation in which an AI frobs the object in question…it may be excessively complicated, but it’s worth it in the long run, because you’ll end up with a stable (at least as stable as DROMED gets) mission!

 

Note: When creating new stims, you must save your gamesys (See “The Gamesys and You”), then re-start DROMED in order for the new stim to appear in any of the “Stimulus” drop-down boxes…or for it to even work AT ALL!  Just another one of those odd DROMED bugs we come to love/hate!

 

Note: Receptrons execute from top-to-bottom, but that only counts for receptrons on individual objects, hierarchies, and metaproperties!  Here’s how the receptrons execute (top-to-bottom for all):

 

Object

Metaproperties

Parent Archetype (and then any metaproperties)

Next Parent Archetype (and then any metaproperties)

So on and so forth

 

Remember that an “Abort” effect will stop the stim from propagating any further down the line…same with an “Awareness Filter”…“Amplify” will only effect receptrons that come after it in line…“Weak Point” (only in T2), works the same way.

 

Note: When Garrett (or any other AI), are told to “Frob Object” as a result of being stimmed (a receptron), they always frob in the world, even if the item is in the inventory!

 

LockBoxes
 

LockBoxes, in my books, are the greatest!  They don’t look cheesy, and you can create completely awesome effects!

 

Anyway, there are two things you must understand about LockBoxes.  Firstly, they lock/unlock JUST like a door, secondly, there are two different ways of implementing a LockBox.

 

The most loved way is to add “TrigUnlock” to the LockBox, and then ControlDevice it to whatever you want opened.  That way, when the lockbox is unlocked, the door is open, and vice versa!

 

Secondly, you can lock things with the “Lock” link, link a door or switch, or just about anything frobbable FROM itself TO the lockbox.  The flavour, naturally, is “Lock”.

 

Now, I know I’ve dealt with this before, but if you have a door that’s opened with a lockbox (not locked with, opened with), or opened with a switch, please make the item unfrobbable.

 

Now that that’s done, why don’t we deal with AI?  Hmm?

 

Now, if you’ve read the AIWatchObj link section, you should know how to do this, so, if you haven’t read it, read it now…I can wait!

 

Back?  Good.  Now, implement the same system as used, with the markers and links, only this time we have one of two options.  Option 1 if you used “TrigUnlock” to open the door, Option 2 if you used Switch locked via LockBox to open the door.

 

Option 1:

 

This gets a bit tricky.

 

Create a lockbox (with “TrigUnlock” and a ControlDevice to the door), and a door.  Make the door’s FrobInfo WorldAction: Script,Ignore.  Now create a servant in a blueroom, make sure he has the key to the lockbox.  Put a conversation there also (if you already haven’t, read the section on conversations), and make the servant the only actor.

 

Now link the lockbox to the conversation. 

 

Now make the conversation’s actions as follows:

 

Step 00:

 

Actor:
1

Action 00:
Wait

Arg1:
5000

Arg2:

Arg3:

 

Step 01:

 

Actor:
1

Action 00:
Frob Object

Arg1:
(The lockbox’s unique name)

Arg2:

Arg3:

 

Since the servant is in a blueroom, and since this is an effect conversation, we don’t need abort conditions!

 

Next, open up the door’s properties, Add-S-Scripts.  Delete all the scripts there, and add “TrigDoorOpen”, then uncheck “Don’t Inherit”.  Link the door to the conversation.

 

Now create concrete roombrush (See section “RoomBrushes”) extending outwards about 4 feet from the door on both sides.  Add the script: “TrigRoomCreature” to the roombrush.

 

Now create another conversation with that SAME servant as the sole actor.  Set-up this conversation to just frob the lockbox.

 

Create a RequireAllTrap and an Inverter.

 

Link the lockbox to the Inverter (ControlDevice), and the Inverter to the RequireAllTrap (ControlDevice), and link the concrete roombrush to the RequireAllTrap (ControlDevice), then link the RequireAllTrap to the second conversation, the one that only frobs the lockbox.

 

There, you’re done!

 

That wasn’t QUITE so tricky…hmm?

 

Go in-game, and admire your handy-work!

 

Want to know what happens?

 

Okay, if the player opens the door, the servant closes it five seconds later.  If an AI comes along, the servant opens the door, waits 5 seconds, then closes the door.

 

Option 2:

 

This is the same as Option 1, except!

 

The RequireAllTrap is linked to the switch, rather than the conversation.

 

The servants Step 00 goes as follows:

 

Actor:
1

Action 00:
Frob Object

Arg1:
Lockbox

Arg2:

Arg3:

 

Step 01:

 

Actor:
1

Action 00:
Frob Object

Arg1:
Switch

Arg2:

Arg3:

 

Step 02:

 

Actor:
1

Action 00:
Frob Object

Arg1:
Lockbox

Arg2:

Arg3:

 

There, lockboxes are COVERED!

 

Keys

 

Keys are pretty straightforward.  To make any object into a key, you need three things:

 

A script

FrobInfo

KeySrc

 

You already know how to set KeySrc up, so that’s fine.  Now we need to add the script.  It’s “StdKey”.  That simple.  Now, the FrobInfo…here’s how you should set it up:

 

WorldAction
Move

InvAction
[None]

ToolAction
Script,Deselect

 

There, now when you frob the key in the world, it moves to your inventory.  When you use it in your inventory, it does nothing, unless you’re going to use it as a tool, then it executes a script, and deselects itself.

 

The checkbox “MasterBit” in the KeySrc dialog is actually quite useful!  Let’s say you have a city map, with three main buildings.  You want to have Master Keys in each one of these buildings.  Set the “RegionMask” of all the locks in building 1 to “1”, in building 2, “2”, and building 3, “3”.

 

Now create your three master keys.

 

Check the “MasterBit” box in the KeySrc for the building 1 Master Key, and set the RegionMask to “1”, leave LockID alone.

 

There!  That key will unlock any lock with a RegionMask of “1”.

 

So, what does the “MasterBit” in KeyDst do?  This makes this door easily unlockable…quite simply, a door with MasterBit: True, and RegionMask: 1, can be unlocked by any key with a RegionMask of 1!

 

Lock Picks

 

One of the greatest thieving tools ever are the lockpicks.  They make you a nearly unstoppable force, unlocking the locked, and taking the secured!

 

Unless, you don’t know how to set them up!

 

First, we’re going to tell you how to make something into a lockpick, then we’ll tell you how to make a lock pickable.  So, in order to make something into a lockpick, here’s what you need:

 

A script

FrobInfo

PickSrc

 

Okay, the PickSrc is the PickBits of the lockpick…confused?  Well, PickBits is how Thief tells one lockpick from another, and is how you assign a lock to a lockpick.  Here’s how pickbits work:

 

1
Square Lock Pick

10
Triangle Lock Pick

11
Both Picks

 

Now, that’s fine and dandy, but say you make a NEW lockpick…say a hook-toothed LockPick.  And you want its pickbits to be different from Triangle and Square.

 

The problem with pickbits is that they are BITS.

 

Here’s an example:

 

What?
PickBits

 

Door
11

Pick
10


1 – A match!

 

Door
11

Pick
01 – A match!

 

Add your new pick, and make its pickbits 100.

 

Door
111

Pick
100 – A match!

 

Door
001

Pick
100 – No match!

 

See, the ones have to line up!  So, now we have these three picks:

 

1
Square

10
Triangle

100
Hooked

11
Square and Triangle

111
All

110
Triangle and hooked

101
Square and hooked

 

Get the hang of it?  Good!

 

Now, create a door, and lock it.  Add-Engine Features-Locked.

 

In order to make the door pickable, we must add PickCfg, and fill it out properly!  So, Add-Dark gamesys-PickCfg.

 

Don’t let this window confused you!  You’ll see that there are three sets of identical fields.  Each set represents a stage.  Each stage can be set up differently.  Now, let’s take the first one for example.  The top box is “PickBits”.  We already know about those!  Fill in “10”, for the triangle lockpick.

 

Now, look down to “Pins”.  This is the number of pins in each stage.  For each pin within a stage, you’ll hear a click.  Set this to “5”.  Now, TimePct.  This is the time it takes to pick each pin.  Set this to “1”.

 

Keep in mind that if you leave everything blank, the game will ignore that stage!  So, right now, if you were to give Garrett the lockpicks and go in-game (don’t), you’d be able to pick this in a couple seconds with the triangle lockpick.

 

Now, you’ll see that there is a “Flags” box.  There are two options:

 

Reset on fail
Doesn’t seem to work…maybe it’s a bug?

Randomize time
Randomizes the time it takes to pick each pin

 

Add the flags you want, then hit “OK”.  Now, to give Garrett the lockpicks.

 

Lockpicks are found under Physical-Tulz-LockPicks.  But there are THREE options…LockPickSG (Square) LockPickLG (Triangle), and LockPickBoth.  Only use LockPickBoth if you’re building a store…which we’re not, so give Garrett LockPickLG and LockPickSG.

 

NOW go in-game, and enjoy!

 

Gates

 

You may have experienced with switch-controlled portcullises or other non-handled doors (doors without door handles which are somewhat cheesy when frobbable)…however, you’ve noticed that while have them switch open/shut is a GREAT effect, the effect is more than lost when an AI attempts…in VAIN, to walk through the gate…all he ends up doing is walking perpetually into the gate!

 

This sort of destroyed my view of the OM creators…in “The Break from Cragscleft Prison”, something similar happens if you set off the alarm, prisoners start walking into the portcullises that keep them in their cells…that’s fake.

 

So, how do you fix this problem without transforming the door into a normal, frobbable, cheesy door (in this case…anyway)?

 

I instructed you earlier in this tutorial to set the “FrobInfo” or gates to “Script,Ignore”.  Find all the gates that the guards walk into, then change their “FrobInfo” to “Script”…also, set the Inventory>Max Pick Distance to “-10.00”…this will prevent the player from frobbing the door, but will allow the AIs to open and close the door as normal.

 

Triggering From Inventory Frobbing

 

This is one of the biggest puzzles of all DROMEDing time!

 

And, if ignored, it can lead to exceptionally cheesy levels.

 

Say, for example, you want new objectives to appear when Garrett reads a scroll…you know, of course, that scrolls must be picked up, THEN read in the inventory.

 

One work-around, would be to have Garrett read the scroll AND pick it up at the same time, then be able to read it from the inventory whenever it pleased him.

 

However, this would look cheesy, and be annoying since people are used to reading scrolls ONLY in their inventory.

 

So, here’s how we workaround…if you’ve already modified your gamesys from the section “Garrett and Dynamic Lights”, don’t worry about the part about creating a new stim, you’ve already created this stim.

 

If you haven’t already, read “Sources and Receptrons”.

 

Create a new stim, “PassItOn”, then save your gamesys and re-start DROMED.  As I’ve already stated, people who did the section “Garrett and Dynamic Lights” already have this stim, so they DON’T have to add it again!  

 

Create a servant in a blueroom (if you’re creating a mission, and already have a blueroom servant (not a servant used in specific effects, like “LanternAI” from “Garrett and Dynamic Lights”, just a generic AI who participates in conversations here and there, but DOESN’T participate in a conversation that has the potential to conflict with one of our conversations (basically, none of his conversations can be so long that a player could trigger ANOTHER effect conversation before he’s done with the first)), 2 markers, a scroll, a button, and a QVarTrap.

 

Name the AI “ScrollFrobber”, name the QVar “NewScrollObj” (create a QVar for every objective that’s to be unveiled…then read the “Objectives” sections until you’ve learned about QVars (read in order)), name the button “RevealObjs”, name the marker “ScrollConv”, name the other marker “FrobbingConv”, and name the scroll “ObjScroll”.

 

Read the section “Conversations” if you haven’t already.

 

Now, it’s time to set-up the sources.  Go into the scroll’s properties, and Add>Act/React>Sources:

 

Name: ObjScroll

Stimulus: PassItOn

Propagator: Contact

Intensity: 1

Edit Shape>Contact Type: Frob in Inv

Edit Shape>Velocity Coefficient: 0

Edit Shape>Frob Time Coefficient: 0

 

There!  Now, we have to add a receptron to Garrett…if you’ve done the section “Garrett and Dynamic Lights”, this step is unnecessary…skip it.

 

Open up the object hierarchy, find physical>Avatar>Garrett.  Press “Edit”, then select “Receptrons”, and hit “Edit”.

 

Add a new receptron:

 

Name: -2099

Stimulus: PassItOn

Min: 0

Max: No Max

Effect: Frob Object

Target Object: Source

 

Save your gamesys.

 

Now, select “ObjScroll”, and open up it’s properties…add the following properties:

 

S>Scripts: StdButton;;;;FALSE

Engine Features>FrobInfo: Script,Move;Script;[None]

Book>Text: (I’ll leave this up to you)

Book>Art: (You choose)

 

Next, link the scroll to “ScrollConv” via “ControlDevice” link.

 

Link “ScrollConv” to “ScrollFrobber”, “AIConversationActor”, Data: 1.

 

Link “FrobbingConv” to “ScrollFrobber”, “AIConversationActor”, Data: 1.

 

Setup “FrobbingConv” and “ScrollConv” as conversations.

 

Link the button to the QVar(s).

 

Open up “ScrollConv”’s “Conversation” property, and edit it like this:

 

STEP 00:

 

Action 00:
Remove Link


Actor One

Arg1:
ControlDevice

Arg2:
ScrollConv

Arg3:
ObjScroll

 

Action 01:
Add Link


Actor One

Arg1:
ControlDevice

Arg2:
FrobbingConv

Arg3:
ObjScroll

 

Okay, that’s it!

 

Next, edit “FrobbingConv”, like this:

 

STEP 00:

 

Action 00:
Remove Link


Actor One

Arg1:
ControlDevice

Arg2:
FrobbingConv

Arg3:
ObjScroll

 

Action 01:
Frob Object


Actor One

Arg1:
RevealObjs

Arg2:

Arg3:

 

Okay!  That’s all!  Now, go in-game and try it out!

 

How does it work?

 

You remember the last note in the section “Sources and Receptrons”?  Well, when Garrett “frobs” an object in his inventory as a result of a receptron, he frobs it in the world, which is lucky for us.  So, when Garrett picks up the scroll, a link is removed, and a link is added, meaning that if you “frob” the scroll in the inventory, then you’ll frob it twice, once in the inventory (you’ll end up reading it), and once in the world (the conversation will trigger, revealing the new objectives)!

 

The only bug is if you drop the scroll with the key “R”.  Is there a workaround?

 

Isn’t there always?

 

Just add this property to the scroll: Add>Inventory>Can’t Drop This: TRUE.

 

There!  Now they CAN’T drop the scroll!

 

The Player and the StartingPoint

 

You may be wondering how you can reference to the player in-game…after all, the player isn’t an object…or is he?

 

Yes, he is.  He’s as concrete as the arrows an archer fires…even though these particular arrows are created at the spur of the moment.

 

However, quite unlike archer-created arrows, which have a random number, and no specific name (they’re “A broadhead”, like every other broadhead on the map.

 

Therefore, without an S&R relay system, it’s almost impossible to reference to a spur-of-the-moment object (an object created in-game).

 

However, the player is: Physical>Avatar>Garrett…so you’d suspect that in-game, he’d be “A Garrett”…but no, mercifully, when Thief creates “Garrett” through the “PlayerFactory” link, it names him “Player”…which is why if you have multiple objects with “PlayerFactory” links, then you’ll get a relation.ccp error…which basically means something doesn’t jive…you’ll get a relation.ccp error if you try and remove a link (with a conversation) that isn’t there, if you try and create an object that’s named the same as something else (try to have 2 objects named: “Frobby”).

 

Also note that properties placed on the StartingPoint are inherited by the player (not the parent archetypes, JUST the “StartingPoint” concrete object!), so if the StartingPoint has the property: Game>Dark>Hit Points: 2, then no matter what difficulty, the player will always start out with but 2 hit points rather than the regular amount!

 

So, if you want any sort of effect (conversation), to do ANYTHING to the player, use the object name: “Player”…however, you can’t reference to the player with S&R, because the S&R system functions the same as the link system…therefore, you’ll have to think up a work-around!

 

This is why we added a “Contains” link to “Player” to give the player the lantern in “Garrett and Dynamic Lights”.

 

Difficulty Levels

 

In order to make an object only appear at a certain difficulty level, you must Add-Difficulty-Destroy, and enter in the difficulty levels you want it to be destroyed on.  0 is normal, 1 is hard, and 2 is expert…there are 10 selectables, however 3-9 do nothing!

 

There are also options to close (open) a door, or lock (unlock) something.  These will just toggle a doors open or closedness, or toggle the lockedness of something.  So if you have a locked lockbox, and you set Difficulty>Lock (Unlock): 0,1 on it, then the lockbox will unlock on “Normal” and “Hard” difficulties but lock on “Expert”.

 

You may be wondering how you can cause different effects based on difficulty levels?  Easy!  Create three EmitTraps, not EmitStreamTraps, EmitTraps, side-by-side, but still far apart.

 

Line buttons up with all of them (not far away, the broadhead emitted by default is subject to gravity, UNLIKE gas and fire arrows), and make sure that he buttons button side is facing the EmitTrap.

 

Next, create another button BEHIND the EmitTraps/Buttons setup, and link it to all three EmitTraps via ControlDevice.

 

Next, set the following on the first EmitTrap/Button pair: Difficulty>Destroy: 1, 2.

 

And on the next: Difficulty>Destroy: 0, 1.

 

And the third: Difficulty>Destroy: 2, 0.

 

So, what’s going to happen?  The EmitTraps are going to be destroyed depending on the difficutly.

 

This setup if fine for a conversation…if you want a different conversation to happen on each difficulty level, just set this up so that at the beginning of the conversation, the actor frobs the button…or, better yet, ditch the button and link the trigger to the EmitTraps…a BoundsTrigger a concrete roombrush…you name it.

 

Next, link each button to the appropriate conversation!

 

So, let’s say you want a metaproperty to be added to the player at the start (this is practical if this is the ONLY mission you want it added for…if it’s a permanent addition to the player, just place the metaproperty on the “Garrett” archetype, and save the gamesys (See “The Gamesys and You”).

 

 

 

Brush Timing

 

When you portalized, brushes are processed sequentially, in the order specified by the number in the lower right-hand corner.  For example, if a solid brush is encased by an air brush, and the air brush’s timing is later, or higher, the solid brush will be air.  If the solid brush is later, then solid will be solid!

 

You can change the timing by typing and pressing ENTER, or by using the left and right buttons, OR you can click the “To End” button, to make the brush the last brush.

 

Creating Outdoor Areas

 

Before reading this tutorial, please read “Brush Timing”.

 

You’ve created a nice manor, or cave network…or, anything indoors, and you want to create an outdoors area.  Okay.  Now, find the first brush you created, change it’s brush timing to “3”, and change the timing of the second brush to “4”.

 

Now create a solid brush around the part of your indoors that will be visible outside.  Make sure you account for walls.

 

Before you portalize to check out this magnificent thing, set it’s timing to “2”.

 

Now create an airbrush encompassing this solid brush, let it’s timing be “1”.

 

Okay, portalize!

 

Now, since the exterior of your building/structure/formation won’t be lit, activate light_bright, and then go have a look!

 

Remember not to be afraid of decahedrons; they’re most useful for forming odd-shaped things, like caves, mountains, hills.  And if two of them intersect…that’s where it gets REALLY interesting!  If you’ve ever looked at the caves in the OMs, and wondered how they were done, decahedrons are the answer!

 

Okay, that looks good!  Now, how to roombrush!

 

You’re going to have to use multiple roombrushes for this.  If your structure is square, it’s easy.  If it’s ten-sided cylindrical, it’s hard.  If it’s a mountain…talk about hard.

 

You can’t allow this roombrush to intersect/encompass the interior roombrushes, otherwise sound will propagate between them, BUT, if you have an exterior doorway, make SURE they intersect/touch, because sound SHOULD propagate through a doorway.

 

But also, don’t allow these roombrushes NOT to touch/go into the walls, otherwise, if the player’s sneaking along the exterior wall, his sound will drop out, and he’ll get angry, and send you hate mail!

 

Now, set all these roombrushes to “Large Normal” EAX.  (If you’re doing EAX).  Why?  Because echoing exteriors sound fake, unless it’s a canyon or something that WOULD echo.

 

Create a cityscape the same way.  If you want sloped streets, you can do it one of two ways: 1. Slope the brush, 2. Add wedges to the floor to slope it.  The first way is preferable, because you don’t have to include extra brushes.

 

Remember that cities take a long time because of the variety and painstaking detail required.

 

If you want a good, believable cityscape, you could always download the unstripped version of ASSASSINS! (Grab that here: http://www.thief-thecircle.com/teg-old/tools) and base it on that.

 

If you have problems, see the “Troubleshooting” section.

 

U, V, and Scale – Aligning Textures

 

If you’ve tried your hand at creating a “B” for Bafford sign, you’ll notice it’s not in the hierarchy, but a texture, in the “Bafford” family.

 

When you try and put it on a solid brush, it’s off-center, and too small (or too big).

 

How do you solve this?

 

Well, first, set your DROMED window size to 800x600 or greater (enter this line: edit_screen_size 800,600 in your user.cfg, save, and restart DROMED).  You’ll notice that when you select a side of a brush, you’ll see a “U”, “V”, and “Scale” box beside the standard brush controls.

 

“U” adjusts a texture’s position horizontally, “V” adjusts the texture’s position vertically, and scale increases and decreases the size of a texture.

 

Fool around with them and you can create FABULOUS effects.  Instead of creating an intricate cathedral, you can load up a texture family, and using your texturing knowledge, create a fabulous temple with a SINGLE BRUSH!

 

For more info on architecture and texturing, see Alexius’ texturing and architecture tutorial!

 

Roombrushes

 

In order to create some effects, you must create a “Concrete Roombrush”.  These include “TrigRoomPlayer” and “WelcomeRoom”, as well a “TrigRoomCreature”.

 

It is imperative that you understand that each room archetype acts as one object.  This can be used to your advantage.  Say you want to use a roombrush as an objective (See “Roombrushes as Objectives”), you must create a concrete roombrush type and add the script: “WelcomeRoom”.  Now say the area you want the player to get to has multiple entrances, and in turn multiple roombrushes.  Then, instead of complicating things by using QVars (See “Objectives: QVars”), you could use the same archetype!

 

Please note that using concrete roombrushes does NOT require you to re-save the gamesys.

 

To create a concrete roombrush, click the roombrush you want to make concrete, and hit “Create”, in this pop-up click “Add” and type the name of your room…make it descriptive!  Now hit ENTER.  You’ll be asked if you want a concrete brush, say yes, then select your new roombrush, and click “Create”.  This will make your “Default Room” your new concrete brush!

 

Now, press “Edit” to add scripts, or “Links” to add links!

 

Please remember that if you have two roombrushes, and you make them both “TriggerRoom”, they will inherit scripts and links from each other!

 

The GameSys and You

 

If you’ve ever poked around in your “Thief” directory, you’ll notice that there’s a file called “dark.gam”.  This is the single most important file in the entire game.  It specifies all objects, metaproperties, stims, sounds, and textures.

 

So, at some point, if you want to alter these things, you’ll have to tamper with the gamesys.

 

DROMED and dark.gam operate as one unit.  Therefore, you can edit the gamesys without knowing it!  Say you edit the “Sword” archetype.  You’ve just modified the gamesys, and unless you File-Save GameSys, and save over dark.gam, you’re changes will disappear once you restart DROMED.

 

Now, let’s say you’re paranoid, or are creating multiple gamesyses.  You can maintain several gamesyses, but it gets confusing.  What I do is constantly tinker with dark.gam until it’s PERFECT!  But, if you want gamesyses altered for each mission, go ahead!

 

Let’s say you are creating a mission called “BaffTaff”.  And you save your gamesys as “BaffTaff.gam”.  The next time you start up DROMED you are startled to find all your gamesys changes GONE!  Don’t fret!  Type the following in the command line:

 

set_gamesys BaffTaff.gam

 

Hit ENTER, save your mission, then restart DROMED.  BOOM!  All’s fixed!

 

Remember than when setting a gamesys, the gamesys MUST be in the main Thief directory, otherwise you’ll have to type the whole path, like this:

 

set_gamesys C:\My Documents\My Thief Folder\BaffTaff.gam

 

And that’s plain boring…PLUS, if you do this, things will get complicated once you try to make your level DarkLoader-compatible!

 

Remember, if you alter your gamesys, you must include it in your DarkLoader archive!  See the section on DarkLoader-compatibility for more information!

 

Schemas

 

Before we begin editing/making our own schemas.  Let’s download the schema files for TDP/TG.

 

Click here to begin the download!
 

Once you’re done, extract those files to “Thief\schema\”

 

The only files which worry us are the *.sch files.  Those are the schema files.

 

Before we begin fooling around with the schema files, you must understand exactly what a schema file is.  It’s not a sound file, it is a file that contains all the data Thief needs to find your files, and understand what to do with them.

 

First we’ll deal with ambient sounds.  Open up “Ambient_m01.sch”.  Take a look around.  You should understand what everything means, take the first entry for example:

 

//Start Mission

schema m01start

archetype AMB_M01

volume –500

keehit_s

 

Okay, let’s break this down.  Below is a list of what everything means:

 

//Start Mission
A comment.  Anything preceeded by “//” is a comment.

 

schema m01start
The name of the schema: m01start

 

archetype AMB_M01
The archetype.  Make sure the archetype is previously created.

 

volume –500
Volume.  –1 is loudest, below that is softer.

 

keehit_s
Name of file in snd.crf, without extension.

 

Note, for convenience, you can decompress snd.srf into a “Thief\snd\” folder.  Keep in mind that you may place all your sounds under the proper voice and language.  Example: “Garrett\English\”.

 

Note you may also insert the following flags after the archetype statement:

 

mono_loop X Y
The sounds will loop, separated by a break between X and Y.

 

poly_loop 2 X Y
Multiple sounds will be played at once, looping with a break between X and Y.

 

no_repeat
Means no two identical sounds will play twice in a row.

 

For poly_loop, the “2” must always be present, and multiple sounds should be specified in the file names area.  Example, you have BaffWind1, BaffWind2, and BaffWind3, and you want them all to play at the same time!

 

schema BaffWind

archetype AMB_BaffTaff

poly_loop 2 2000 3000

volume –1

BaffWind1 BaffWind2 BaffWind3

 

Let’s say we want these BaffWind sounds to loop infinitely, playing separately, and no two identical ones ever playing in a row:

 

schema BaffWind2

archetype AMB_BaffTaff

mono_loop 0 0

no_repeat

volume –1

BaffWind1 BaffWind2 BaffWind3

 

Now let’s create AI sounds!

 

Here’s an example AI sound entry:

 

//Unaware (Alert Level 0)

schema sv1a0hu

archetype AI_NONE

no_repeat

mono_loop 3000 15000

volume -500

sv1a0hu1 sv1a0hu2 sv1a0hu3

sv1a0hu4 sv1a0hu5

schema_voice normal1 2 atlevelzero

 

The only thing different about this schema is the last line:

 

schema_voice normal1 2 atlevelzero

 

This line means that this is the voice “normal1”’s comments “atlevelzero”, which means he’s totally unalerted.  The number “2” is a priority, 1 being absolute, and numbers greater being less likely.

 

Let’s look at the way the files are named.  If this file naming system was good enough for LGS, it’s good enough for us FM makers:

 

sv1a0hu1

 

Means: SerVant #1 at Alert 0 HUm #1

 

Just a quick note, sv1 is a male voice, sv2 is a female voice.

 

In DROMED these are: “normal1” and “normal2”, respectively.

 

Keep in mind, if you create a new AI voice, you must enter the following line in “Speech.spc”:

 

voice x

 

Where “x” is the name of your new voice.

 

Now, last but certainly not least, custom conversations:

 

//CONV 1  "Peaceful, i'nt it?"



schema sv1c0101

archetype SV_CONV

sv1c0101

schema_voice normal1 1 sv_c01 (LineNo 1 1)

 

schema sv2c0102

archetype SV_CONV

sv2c0102

schema_voice normal2 1 sv_c01 (LineNo 2 2)

 

schema sv1c0103

archetype SV_CONV

sv1c0103

schema_voice normal1 1 sv_c01 (LineNo 3 3)

 

schema sv2c0104

archetype SV_CONV

sv2c0104

schema_voice normal2 2 sv_c01 (LineNo 4 4)

 

Let’s break this down:

 

schema sv1c0101
Name of schema.

 

archetype SV_CONV
Archetype…make sure this is created before processing!

 

sv1c0101
Name of *.wav, minus extension.

 

schema_voice normal1
Voice required to play.

 

1
Priority.

 

sv_c01
Conversation concept name.

 

(LineNo 1 1)
Line number.

 

Remember that each time you change the schemas you must reprocess the schemas, with the following command in DROMED:

 

reload_schemas

 

Once you’ve done this, resave your gamesys (See “The Gamesys and You”).

 

If you’re creating a new conversation concept, example of a built-in concept is: sv_c09, the lines of which are stated in the “Conversations” section of this tutorial, you must define the concept for DROMED.  Open up “speech.spc” and add the following below the rest of the concept definitions:

 

concept XXX

 

where “XXX” is your custom concept.

 

Save speech.spc.

 

Remember to reload schemas and save your gamesys after this change.

 

Also keep in mind that DROMED doesn’t need your custom schemas after it’s loaded them, and saved them in the gamesys.  Therefore, just include your custom gamesys in your DarkLoader (See “DarkLoader”) archive, not the custom schema files!

 

Another note.  You don’t have to compress your custom sounds into snd.crf, you can just place them in a “snd” directory in your “Thief” directory.  Keep in mind that custom sounds should be placed in an “English” folder, and try not to create any subfolders aside from “English”, as otherwise it can get confusing.  But if you are creating lots of sounds (like whole new voices) sort by voice, then by language.  Example, you’re creating a new voice: “Farkus”:

 

snd/Farkus/English/fa0mu1.wav
Farkus at alert level 0, mutter number 1

 

One last all-important word: Save your Thief sound files as “IMA ADPMC” format audio, at a quality of: “8.000kHz, 4 bit, Mono”.

 

Remember that “format” and “extension” are different.  The extension should still be *.wav, but the format should be the aforementioned.

 

If you’re using Windows Sound Recorder, you can alter the quality from the save dialog, by pressing “Change” beside “Format”.  Note that when using Windows Sound Recorder, you will be unable to apply any effects to the sound, after saving them in this format and quality.

 

Remember that you will probably have to increase the volume of your sound in Sound Recorder by 100%, otherwise it will be inaudible, to do this hit Effects>Increase Volume (25%) four times!

 

When you’ve created a new voice, be sure to add the following in “speech.spc”:

 

voice XXX

 

Wherein “XXX” is the name of your new voice as defined in the bottom line of the schemas.

 

Note: If you want a schema to only play once, find its ARCHETYPE, once you’ve reloaded the schemas, type: “find_obj [your schema here]”, then Add>Schema>Play Params: Play Once.

 

How to Get Effects Started at the Mission’s Beginning/Loops

 

Before reading, please read: “Conversations”, and “The Infamous AIWatchObj Link”.

 

This is a very good question, how, exactly, does one start something rolling with the mission?

 

It’s complicated, and simple at the same time.

 

Say you want a guy, patrolling back and forth, pausing every once and a while, using ordinary TrolPts and AIWatchObj links doesn’t seem to work, therefore, let’s setup a conversation.

 

I used this in Lord Bafford the Tafford.  Lord Bafford walks from his throne, into his office, stops, looks at a painting, continues into his bedroom, looks at another painting, walks back, stands on his throne for a little while, then repeats.

 

This adds a BEAUTIFUL sense of realism.  People might find it hard to believe that a prestigious lord like Bafford just sits on a throne all day.

 

So, here’s what I did!

 

I created three TrolPts.  One at the throne, one in the office, and one in the bedroom.

 

I created a conversation, and a button nestled in the wall, out of any roombrushes.

 

I made Bafford the sole AIConversationActor.

 

I created the two pictures.

 

I linked the conversation to the button.

 

I added all the conversation properties.

 

I setup the conversation:

 

The interesting part is in how I started the “ball rolling”.

 

I linked Bafford with an AIWatchObj link to the throne TrolPt (Bafford spawned a couple of feet off the floor, directly above this TrolPt).  I made the link kill itself, and had the sole action be to frob the conversation-starting button.  Then I set the radius to 8 and the height to 8, the initiator was “Self Intrusion”.

 

Then I made the last action of the conversation, to frob the button, starting the conversation all over!

 

So, you can make loops by having conversations that re-start themselves by frobbing a button linked to themselves (make sure this button is out-of-reach of the player, or poky-poky players will start giving themselves a good laugh by royally screwing your AIs!).

 

You can have instantly starting effects using AIWatchObj links to markers the start off at the same place as an AI!

 

Another way to have instantly starting effects is to use Garrett!

 

Create a BoundsTrigger that completely surrounds the StartingPoint, and ControlDevice link it to your effect…please note that this method has it’s disadvantages: 1.  When the player leaves the BoundsTrigger, a “TurnOff” ControlDevice is sent.  2.  The player actually has to order Garrett to move before the effect is triggered…you can see this sort of effect by looking at “Assassins”, there’s a BoundsTrigger surrounding the StartingPoint in Farkus’ shop…you can learn about how to make “Assassins”-style setups in the section: “Assassin’s-Style Missions”.

 

Saving Precious Object Ids

 

You know, of course, that the T1/G Dark Engine has an unchangeable object ID limit of 2048.  If you have more than 2048 objects, your mission will, indeed, crash!

 

However, even though the upper limit of T1/G is 2048, it is recommended that you have LESS than 2000 objects.  Lorgan’s Web (by Shadowspawn), has in excess of 2000, and, by Shadowspawn’s own admission, is an extremely UNSTABLE FM (however, it is also an excellent example of skillful DROMEDing).

 

So, you’re approaching that so frightening object limit!

 

How do you avoid it?

 

Here are some tips:

 

Cut down on the number of braziers (TG only), torches, and streetlamps, all of these have attached particle effects, and therefore gobble up obj IDs fairly fast.  Braziers take up 2 obj IDs, torches take up 3, and streetlamps take up 4.

 

Avoid any sort of major particle effects.  Like fireplaces.  These gobble up 5 obj IDs, plus the burnt out campfire object that goes underneath, making the object count for a simple fireplace: 6.

 

Try and merge TragTrigs, conversations, and effect buttons with idle objects.  Banners, sofas, chairs, trophies, tables, candles (except lit candles and “GoldCStick”…which is treasure), electric lights (unless you’ve made them switchable), and beds are all good examples of objects that can be used but aren’t!

 

To make an idle object into a conversation, give it a descriptive name that you’ll remember (use the command find_obj XXX if you can’t find that particular object), then add the “TrapConverse” script, the properties, and link it up as normal.

 

To make an idle object into a button, add the script: “StdButton”, add the FrobInfo: Script,[None],[None], and then Add>Inventory>Max Pick Distance, and set it to a negative number GREATER than the object’s biggest dimension…negative 10 or 11 are usually good, but for bigger objects try lower numbers just to be safe!

 

To make an idle object into a TrapTrig (example: An Inverter), just add the necessary scripts and links (example: “TrapInverter”, then a ControlDevice link(s) to and from).

 

To conserve object IDs, you can also try using textures instead of objects…so, rather than using a locked and unlockable door object in your cityscape, use a texture door which can be found in the family: “City” or “NewCity”.

 

Tweq

 

Note: If you don’t yet feel comfortable with DROMED, don’t attempt to understand the “Tweq” system enough to create your own Tweq-effects.  Merely use it to alter existing Tweqs, such as the “Tweq” property on an EmitterTrap.  You may not feel comfortable doing even that…do if you don’t, don’t…no one says you HAVE to know this, as a matter-of-fact, most beginning DROMEDers do quite well WITHOUT knowledge of the Tweq-system…but for many complicated effects, Tweq knowledge is a must…that’s why it’s in CompleteTut!

 

Tweq is the last DROMED subject that we have to cover.  Other than that, you know EVERYTHING, except objectives and DarkLoarder compatibility, those are covered below.

 

There are eight types of “Tweq”:

 

Emit:
Creates objects

Rotate:
Rotate objects

Scale:
Makes objects bigger/smaller

Joints:
Changes the states of objects’ joints

Flicker:
Used for script events

Models:
Change an objects model

Delete:
Destroy an object

Lock:
Used for lock effects…you don’t have to fiddle with this often

 

For each tweq, there’s two properties: “X”, which is the name of the Tweq, and “XState”, which defines how “X” is to run.  There are many different properties for Tweq, and each one is VERY confusing, which is what makes the Tweq system simple and complex at the same time.

 

Let’s look at the fields you’ll encounter with Tweq:

 

Halt: Determines what the Tweq does when it ends, here are the flags that can be set:

 

Destroy Obj:
Destroy the object…POOF, it disappears

Remove Prop:
Removes the Tweq property

Stop Tweq:
Stops the animation, but doesn’t remove the property

Continue:
Reverses and continues

Slay Obj:
Destroys, but allows to go through death stages (if any)

 

AnimC: Animation flags:

 

No-Limit:
The Tweq continues without ever stopping (no halt)

Sim:
The Tweq animates always, even when the player is far away

Wrap:
The Tweq re-starts when it reached the end

One-Bounce:
The Tweq resets but DOESN’T re-start

Small Sim-rad:
The Tweq will only simulate when the player is close or looking

Large Sim-rad:
Bigger “Small Sim-rad”

 

MiscC: Miscellaneous flags:

 

Anchor:
Anchors object animations at the bottom rather than the center

Scripts:
Sends script messages on “interesting” Tweq events

Random:
Tweq Emit only…choose lauch velocity randomly

Grav:
Tweq Emit only, applies gravity to projectiles that don’t have it

Zero-Vel:
Tweq Emit only, doesn’t add Emitter velocity to projectile velocity

Tell-Ai:
Let the AI know about emitted projectiles…???

Push-Out:
Pushes projectiles away from physical emitters

Negative-Logic:
???

Relative-Velocity:
Makes the Tweq Emitter’s velocity relative to it, not the world

 

CurveC: Animation curve flags:

 

Jitter-lo:
Jitter the animation rate (random noise)

Jitter-hi:
Jitter the animation rate (random noise)

Mul:
Apply jitter effects multiplicately rather than additively

 

AnimS: Sets the animation state:

 

On:
The animation is currently on

 

CurTime: The animations’ current time (internal clock).

 

Frame: The current “frame” of the animation…use to start somewhere OTHER than the beginning.

 

There are also some properties specific to each Tweq…this list will help you:

 

Scale:

 

There are three rate/min/max boxes…one for each axis.  The rate is how fast the expanding/contracting occurs, and the min/max boxes are how far the model will expand/contract as a fraction of the original.

 

Model:
 

This is used to change object models, and is used on the “torch” object.  There are six boxes, in these you should type the models you want to be rotated between.  The “Rate” box specifies how long Thief should wait before going on to the next model, in milliseconds…of course.  Jitter-hi and –lo create some interesting effects, and are used on the torch archetype.

 

Emitter:

 

Creates objects.  The “Rate” parameter specifies how often objects should be produced.  The “MaxFrames” specify how many objects should be produced.  “EmitWhat?” refers to the archetype of object that should be produced.  You can use the velocity boxes to impart additional velocity to the emitted objects, however, if you have an object that has a starting velocity (example: the “broadhead” or anything else from the “projectile” archetype), you don’t need to fill these in!

 

Delete:

 

This is used to delete the object after a certain amount of time.  “Rate” specifies how long the object will last after this Tweq is activated.

 

Flicker:

 

This one doesn’t actually “do” anything, but since Tweqs produce script messages, it can be used to drive random events.

 

Joints:
 

There are six fields, which define joints.  Each joint has it’s own AnimC and CurveC fields.  There’s also an entry for the animation of each of the joints, and an entry for overall animation.

 

Rotate:
 

This property is used to rotate objects on any of the three axises.  X-, Y-, and Z-axises.  You can set rate, min and max for each axis…the state property has separate entries for each axis animation.

 

Lock:
 

Used to toggle the lock states.  You shouldn’t really have to use this much, although it is automatically added to every door and lockbox.

 

Objectives

 

Before we go on, I’d like to congratulate you on making it this far.  Very few DROMEDers ever grasp what comes before this!  Now we’ll learn about objectives!

 

First, I’ll tell you that doing objectives directly through DROMED is an ABSOLUTE CHORE!  So don’t do it…it’s boring, not to mention a waste of time, considering there’s Thief Objective Wizard!

 

Okay, so, if you haven’t already downloaded it, zoom over to http://www.thief-thecircle.com/dromed/ and find and download Thief Objective Wizard (or TOW).  Install it as per the readme, then run it.

 

Okay.  This program pretty much explains itself.  If you’ve decided on objectives, just enter in the first objective’s data, hit “Add” then enter the next objective’s data.  A few things to point out.

 

Objective numbering starts at zero

If you want to use objective type: “Goto a location, see “Roombrushes As Objectives””.

Ignore the “Special Flags” under loot goals

Ignore everything marked “T2 Only” if you don’t use DROMED 2 or DedX…I said this at the beginning!

 

Here’s the explanation of the TOW functions:

 

Reverse
This reverses the sense of a goal.  Turns don’t kill into kill.

Final
This goal is the last one…don’t use this on more than one goal.

Irreversible
This goal can’t be reversed.

Invisible/Visible
Goal’s visibility.  See “Objectives: Invisible/Visible”.

Difficulty Levels
Check the difficulty levels you want this goal to appear on.

Incomplete
Goal requirements have not yet been met (Nothing).

Complete
Goal requirements have been met (Green check).

Inactive
Goal is no longer applicable (circle with a slash).

Failed
The goal is failed.  If one objective is failed, you fail the mission (X).

Steal an object
Input object number to be stolen.

Kill a creature
Self-explanatory, input creatures’ object number.

Get a certain amount of loot
Get a certain amount of loot, either gold, gems, goods, or total.

Goal Number
Goal number, from 0-30

No Type
Goal has no type.  See “Objectives: QVars”

Add
Adds the goal

Reset
Resets all goals

Raw Objective List
These are the raw commands

 

Once you’ve finished inputting all your goals, hit File-Save, and save it as XXX.cmd.

 

Now go back into DROMED, and type the following: run XXX (XXX is path of *.cmd file).

 

There, objectives!

 

Objectives: QVars

 

Please ensure that prior to reading this, that you’ve also read “Objectives”.

 

Now, the ConVict (Conditions for Victory) script is quite limited, really.  It doesn’t actually support the switching of objectives from visible to invisible.

 

But, there is a workaround!  The Fnord QVarTrap!  A QVarTrap, upon receiving a “TurnOn” ControlDevice, can change a goal state!

 

Say you want an objective:

 

Kill joe, bob, and billy

 

Now, with ConVict’s basic objectives, here’s what you’d HAVE TO HAVE:

 

Kill Joe

Kill Bob

Kill Billy

 

That’s really quite stupid!  So, create a QVar, add “TrigSlain” to Joe, Bob, and Billy, then link them to a RequireAllTrap, and link that to an appropriately setup QVar, in the meantime, set the TOW objective type to “No Type”.

 

First, let’s show you the QVar commands:

 

goal_visible_X
Changes goal visibility, 0 is invisible, 1 is visible.

goal_state_X
Changes goal state, 0 is incomplete, 1 is complete, 2 is inactive, 3 is failed.

goal_final_X
Makes a goal final/not final, 0 is not final, 1 is final.

goal_reverse_X
Sets a goal’s “Reverse” property, 0 is normal, 1 is reversed.

goal_mindiff_X
Sets a goal’s minimum difficulty, 0 is normal, 1 is hard, 2 is expert.

goal_maxdiff_X
Sets a goal’s maximum difficutlty, 0 is normal, 1 is hard, 2 is expert.

goal_irreversible_X
Makes a goal irreversible, 0 is reversible, 1 is irreversible.

goal_type_X
0 is steal object, 1 is kill creature, 2 is loot, 3 is goto room.

goal_target_X
See below.

goal_loot_X
Total loot.

goal_gems_X
Total gems.

goal_gold_X
Total gold.

goal_goods_X
Total goods.

 

Okay.  First I’ll explain the property you must add to make a QVar run properly, then I’ll show you the syntax, THEN I’ll give you the info for all the commands marked “See below”.

 

A QVar needs a property: Add-Trap-QVar.  That wasn’t so hard, now you’re faced with a pop-up.  Syntax time!

 

First things first: The “X” in the commands above is the goal’s number.  The value you want to set whatever you specified to goes BEFORE.  Take a look:

 

=Y:goal_visible_X

 

Now, let’s say you wanted to make goal #15 visible.

 

=1:goal_visible_15

 

So, what you want to change the variable to goes before the colon.  And after the colon you input the variable, and the goal number.  Don’t get confused or do it backwards or weird errors to occur!  And be sure to include the “=” it’s crucial!

 

The goal_target_X variable is very tricky.  This variable applies to three of the five types of goals.  Get to a certain room, kill a creature, and steal an object.  Remember the reverse variable, though.  For example, the servant archetype number is “-52” (all archetype numbers are negative.   Just like “Garrett” is “-2099”).  So, if you set: goal_type_X,1, goal_target_X,-52.  That would be “Kill a servant”.  If you set the following:

 

goal_type_X,1

goal_target_X,-52

goal_reverse_X,1

 

This would be a: “Don’t kill any servants” objective.

 

Remember, you can use archetypes no matter how broad!  If you want to have a “Don’t kill anything” objective, here’s what you’d set:

 

goal_type_X,1

goal_target_X,-8

goal_reverse_X,1

 

That would work, because “-8” is the number of the “Creature” archetype…and all AI are contained within this archetype!

 

If you look at the hierarchy, it’s set up VERY well for these kinds of goals.  Say you want a “Don’t steal anything” goal.  Why you’d want one is beyond me…but anyway.

 

goal_type_X,0

goal_target_X,-224

goal_reverse_X,1

 

There, done!  (Note: -224 is the number of the “Treasure” archetype.  Please not the treasure vases and goblets, and treasure candles ARE NOT in this archetype.  So, use QVars for these types of things.)

 

Objectives: Invisible/Visible

 

Please ensure that, before you read this, you’ve read the other “Objectives” sections that come before this.

 

Normal objectives are great, but certainly you could create a better storyline with invisible objectives!

 

Yes…definitely!

 

So, how can you make the flip?  Use QVars!

 

=Y:goal_visible_X

 

What’s a good way to trigger this?  How about a roombrush with “TrigRoomPlayer”?  A scroll/book with StdButton?  A guard with “TrigSlain”, or with a “Frob Object” receptron?  A conversation that has an actor frob a button linked to a QVar?

 

Objectives: Text Description

 

Please ensure that before you read this, you’ve read the other “Objectives” sections that come before this.

 

Creating objectives is all fine and dandy.  But all you have are these blank boxes…what’s the scoop?

 

You need a goals.str file.  You can create this file with notepad, so, open it up.

 

There are two different things that must be inputted for each goal, fiction text, and text.  Fiction text is displayed at the initial load-out, and text is displayed on the in-game screen.  So, say we have these two goals:

 

Steal the scepter

 

Don’t kill any servants.

 

Here’s the fiction text:

 

You’re short on cash, and stealing the scepter should be a good way to make a quick buck.

 

Servants are harmless…don’t harm them!

 

So, here’s what we type in our text file:

 

fiction_0:“You’re short on cash, and stealing the scepter should be a good way to make a quick buck.”

text_0:“Steal the scepter.”

fiction_1:“Servants are harmless…don’t harm them!”

text_1:“Don’t kill any servants.”

 

See?  fiction_X:”Y”

 

X is the goal number, and Y is the fiction text.

 

Or:

 

text_X:”Z”

 

X is the goal number, and Z is the text!

 

So, you’ve saved this file as “goals.str”.  Now, what do we do with it?

 

Make sure the following directory structure is in place in your Thief directory:

 

Thief\Books\English

 

Thief\intrface\English

 

Thief\intrface\missX\English\

 

Thief\Strings\

 

X is the number of your mission…make sure that this number is greater than fourteen!  Twenty is good.

 

We’ll use all these directories LATER when we make the mission DarkLoader-compatible, but for now, move “goals.str” into “Thief\intrface\English”.

 

Remember that all your books go into “Thief\Books\English”.

 

Now, restart DROMED, then play your mission, hit “O” to access the objectives screen, and there are your objectives!

 

Objectives: Don’t Alert Anyone

 

The question of how to make a “don’t alert anyone” objective has been asked over and over throughout the history of DROMED.

 

Here’s how.

 

Create a button off in your handy blueroom, and then create a QVarTrap.

 

Add>Trap>QVar: =X:goal_state_3

 

Now we have a QVar that will fail a certain objective!  Now go, and set-up the objective in TOW as “No Type”.

 

Link the button to the QVarTrap via ControlDevice.

 

Before we go on, ensure that your button has a unique name, how about: “SeeButton”.

 

Select each of the AI you want Garrett to not be seen by in turn, and add the following:

 

ALERT RESPONSE

Level 3

Absolute

Action 00: Frob Object

Arg1: SeeButton

Arg2: 

Arg3:

 

So on and so forth!  Remember that AIs only go to level 3 alertedness when they’ve confirmed your presence through some concrete evidence (finding a person dead or knocked out, seeing blood on the floor, taking damage, seeing Garrett) that you’re actually there.

 

Objectives: KOs

 

If you want a KO-related objective, you’ll first need some S&R experience…go gather that (if you haven’t already), then return.

 

Create an EmitTrap in a blueroom.  Then create a BaffBanner oriented so that any projectile fired from your “EmitTrap” will strike the banner’s broad-side.

 

Add the following script on the EmitTrap: “ReloadTweqEmit”.

 

Create a button near the EmitTrap, and name it “IfKOedFrobHere”.

 

Go onto EVERY AI in your level, and give them receptrons for “Knockout”, and “KOGas”, to frob that button.

 

Next, decide whether this is a “Don’t KO Anyone objective, in which case delete the banner and EmitTrap, and link the button DIRECTLY to a QVar that fails the objective (See Objectives – QVars).

 

If you want a “Don’t KO more than five people” objective, then open up the banner’s property, and Add>Game>Damage Model>Hit Points: 6 and Add>Game>Damage Model>Max Hit Points: 6.

 

Why six?  Because we want the player to be ALLOWED five KOs, and fail on the sixth.

 

Next, create a QVarTrap, and give it the correct Trap>Quest Var property to fail the objective.

 

Add the following script to the banner: “TrigSlain”, then link the banner to the QVar.

 

Give the banner a receptron for “PokeStim”, to damage the object, target: Me, agent: Source:

 

Type:
0

Use Stimulus As Type?
TRUE

Multiply By:
0

Add:
1

 

This way each arrow damages the banner, until on the sixth KO, the banner is slain, and the objective is failed!

 

Objectives: Kills

 

If you want a “Don’t Kill Anyone”, or “Don’t Kill Any Servants” objective, see: “Objectives – QVars”

 

If you want a “Don’t Kill X”, or “Kill X” where X is an integer, then create a setup similar to the one in “Objectives: KOs”, only this time, rather than a button, have every AI in the level have a “TrigSlain” script, and link every AI to the EmitTrap.  Then link the banner to the appropriate QVarTrap!

 

Roombrushes as Objectives

 

Before reading this, please ensure that you’ve read the “Roombrushes” section as well as all the “Objectives” sections that come before this.

 

In order to use a roombrush in the “Goto” objective, you must create a new concrete roombrush, and add the script: “WelcomeRoom” on it.  Then type its number into the “Goto Location” field in Thief Objective Wizard.

 

Reverse and Final

 

People making QVar goals must be aware of how the “Final” and “Reverse” goal tags function when combined.

 

A “Reverse” goal is a goal with the sense reversed.  Now, think about it, can a reversed goal EVER be completed until the mission is over (QVars aside).  The answer is NO.

 

Therefore, when ConVict notices a “Reverse” goal, it exempts it from the list of goals that must be complete for the “Final” goal to be complete.

 

Therefore, when you have a QVar goal that won’t be completed until the mission is over (See “Objectives: KOs”), you must mark this goal as “No Type” AND “Reverse” in TOW, that way you won’t wander aimlessly because ConVict won’t mark the “Final” goal as complete, because your QVar goal, which can’t be completed until the end, isn’t marked “Complete”.

 

Making a Store

 

You’ve created your mission.  It has extra-cool effects, it has extra-complicated objectives, it has conversations, MetaProperties, doors, lockboxes, complicated scripts, act/react!  But it’s missing a store!

 

Fret no longer!

 

It is recommended that before you read on, you read the section “Inventory”.

 

First, make sure that everything you’re trying to sell has a long description, an object name, and a purchase price.

 

Now, create two markers near your StartingPoint.  Name them “Store” and “LoadoutCache”.

 

Open the properties of “Store”.  Add-Inventory-Store, check!

 

Next, open “LoadoutCache”’s properties, and Add-S-Scripts: “LoadoutCache”.

 

Link everything that’s “Starting Gear” to the StartingPoint (Contains flavour).  Link everything that’s up for sale to “Store” (Contains), and link things that you want to be inserted AFTER the store (Compass, maybe sword and/or blackjack) to the LoadoutCache (Contains).

 

If this is the first mission in a series, you might want to link some loot to the StartingPoint so that the player can spend it!

 

Make sure that you remove the following flag for your mission from “missflag.str”: “no_loadout”.

 

There, a store!

 

Note: The store will NOT appear when you play from DROMED.  Note that loot left over after purchasing will be deleted automatically.  If you have multiple missions in a series, note that loot will be carried over automatically from one mission to the other.

 

CamVator Sequences

 

Before reading this, please be sure to have read “Elevators”, “Converastions”, and “Sources and Receptrons”…if it’s been a while, refresh yourself.

 

A CamVator Sequence is essentially a briefing, only without the *.avi file, and it features in-game graphics, and is easier to make than a *.avi briefing.

 

You may have played games, which imply built-in CamVators.  Wherein you see the player walking about, talking and interacting, when you’re not actually participating.

 

Thief didn’t feature this…as a matter-of-fact, there was really only one conversation in Thief: The Dark Project, wherein Garrett actually spoke!

 

First, think about your CamVator, who do you want to participate?  What do you want them to say?  Where do you want them to go?  Place all the actors where you want them, create and schema the sounds.  If you need Garrett, you can either ask someone at TEG for the model, or create it yourself.

 

Now that you have everyone arranged, decide how you want the player to observe this sequence.  Then create an elevator (Under physical>TerrainLike), name it “CamVator”, and set-up the elevator with TerrPts, and TerrPath, and TerrPathInit links (a speed of “3” is just right for following a walking AI).  Next, make the elevator invisible (Add>Renderer>Render Type: Not Rendered), and non-physical (Add>Physics>Misc>Model: None).  Then create the StartingPoint above the vator…only slightly, though.

 

Add the following property to your vator: Add>Schema>Class Tags:

 

That’s right, delete all the information in “Class Tags”, this will stop the vator from making sounds as it moves.

 

Add this property as well: Moving Terrain: FALSE.  This will make sure that the vator isn’t moving off the start!

 

Grab your blueroom guy, and find something that’s near him.  Make him watch the nearby object for Self-Intrusion.  Then make him frob an object that will begin THE converstation.

 

Next, create your conversation that you want the player to watch, remember to create (and give unique names to), buttons off in a blueroom which are ControlDevice-linked to TerrPts you want the vator to move to during the conversation.  When you want the vator (and the player) to move, just have an AI in the conversation frob the appropriate button!

 

Before we go any further, compute the pathfinding database so that the vator will actually know where to go.

 

Next, find your blueroom AI (the guy who does all your dirty work), and create a conversation for him.  Call this conversation “Immobilize”.  Setup your blueroom AI as actor one.  Then do this:

 

STEP 00:

 

Action 00:
Add Link


Actor One

Arg1:
PhysAttach

Arg2:
Player

Arg3:
CamVator

 

This will attach the player to the elevator so that he can’t jump off or look around.

 

Make sure that the TerrPts are facing the proper way, so that the player will have a good view.

 

At the end of the conversation, you can have the player drop to the ground (just UN-PhysAttach him…since the vator is un-physical), or you could teleport him off someplace (link a TeleportTrap to the StartingPoint).

 

Now, to get all these conversations started…remember that you’ll probably want a wait at the beginning of the conversation (that makes people talk…not the one that PhysAttaches the player), so that the player can actually realize what’s going on!

 

You remember we created “RecepSim”, and “SourceSim”.

 

Create a button (name it: “StartTheCamVator” that is ControlDevice linked to “Immobilize”, and the conversation that start the actually briefing (wherein everyone talks).

 

Add a receptron to “RecepSim”:

 

Name: RecepSim

Stimulus: InitStim

Min: 0

Max: No Max

Effect: Frob Object

Target Object: StartTheCamVator

 

There!  A beautiful in-game briefing…a CamVator!
 

Remember that CamVators aren’t beginning-mission exclusive…you can have them ANYTIME!  You can just teleport the player to an invisible and non-physical vator, then PhysAttach him, and have a little cutscene!  You could even have Garrett participate!  Have a Garrett off in the blueroom (an AI), then teleport him to Garrett’s position at the exact moment you teleport Garrett to the vator!  Remember that a TeleportTrap linked to the StartingPoint will end up linked to Garrett when you go in-game!

 

To see how you can have things follow the player (markers, SoundTraps, StimEmitters), see “Garrett and Dynamic Lights”, and see how “LanternFStim” works with TeleportTraps!

 

Remember that Garrett doesn’t have a voice, so, to have a Garrett AI talk, make some SoundTraps follow him around, then have those SoundTraps “SoundDescription” linked to a comment…have an AI frob an object and wait the appropriate length of time when it’s time for Garrett to talk!  Remember that SoundTraps actually sound like they’re coming from the location they’re at!

 

DarkLoader

 

There are several things that DarkLoader needs to run your mission:

 

XXX.mis

missflag.str

titles.str

goals.str

page001.pcx

readme.txt

missX.mis

newgame.str

XXX.gam (only if you created a custom gamesys)

 

Let’s explain each of these:

 

XXX.mis
Your mission!

missflag.str
Let’s DROMED know to skip the OMs

titles.str
Specifies a title for your mission

goals.str
Specifies objectives text for your mission

page001.pcx
Page one of the map, you can have multiple pages.

readme.txt
Your readme

missX.mis
The mission file

newgame.str
Specifies the names of the buttons at the “New Game” menu

objnames.str
Specifies object names (See “Inventory”)

objdescs.str
Specifies object descriptions (See “Inventory”)

XXX.gam
See “The Gamesys and You”

 

And let you know where they go:

 

missflag.str
strings\English\

titles.str
strings\English\

objnames.str
strings\English\

objdescs.str
strings\English\

page001.pcx
intrface\missX\English\

goals.str
intrface\missX\English\

newgame.str
intrface\English\

Books/Scrolls/Plaques
books\English\

Custom Schemas
schemas\

Custom Sounds
snd\VOICE\English\ OR snd\English

XXX.gam
[DEFAULT DIRECTORY]

XXX.mis
[DEFAULT DIRECTORY]

 

Now, rather than create all those *.strs by HAND, why don’t you just up and download the Thief Book Wizard (TBW) and Thief Text File Wizard (TFW or TTFW).  And use THEM to create these files!  They work MUCH better.

 

As for the map, I can’t help you with that.  It’s up to YOU how much (or how little) detail to include.

 

Now, for multi-mission archives!

 

These are quite daunting.  Inside “intrface\” create a missX for each mission (20, 21, 22), now alter your original missflag.str so that it does NOT include “end” for your original mission, and so that you add lines for your other missions:

 

miss_15: “no_briefing,no_loadout”

miss_16: “no_briefing,no_loadout”

miss_17: “no_briefing,no_loadout,end”

 

Things to know about missflag.  If you want missions NOT to play, add the following line:

 

miss_1: “skip”

 

If you want a mission to play with a briefing, with a loadout, and not being the end of the campaign, write this:

 

miss_2: “”

 

This is an example for a three-mission archive.

 

Remember that if you don’t include the “no_briefing” line, you must make a movie briefing for your mission, these should be stored in “movies\English\”.

 

Also note that they must be named: “bX.avi”.  X is the number of your mission.  If you want an end-of-game cutscene to play after your last mission, make the missflag like this:

 

miss_17: “cutscene,end”

 

Cutscenes must be named: “cX.avi”.  Where X is the mission they come after.

 

If you’re still confused, take a look at the Thief missflag, found in “strings.crf”.

 

Remember to compress your missions at “Normal” compression setting in winzip, and to include a “readme.txt”.

 

If you’ve made changes to your gamesys, include it also!

 

Also, under Editors>Mission Parameters>Dark Mission Description, enter the filename of your mission, and it’s series number (should be 20 or above).

 

DROMED Maxes

 

Here is a list of the maximum…things in DROMED:

 

Maximum Objects (including objects created in-game):
2048

Maximum Brushes (terrain):



4000

Maximum Roombrushes:



999

Maximum Named Roombrushes:



35

Maximum Cells (pathfinding):



65535

Maximum Ambient Objects:





 

Garrett’s Comments List

 

GAR001          This door is bolted, and there is no way to open it

GAR002          Locked!  I'd better get the key to open it

GAR003          It’s locked, I can try picking the lock or finding the right key

GAR004          Ah, got it!

GAR005          A container like this might have something good inside it

GAR006          That's too high

GAR007          Crystals are good for powering up arrows

GAR008          This will be useful

GAR009          Rope arrows will only stick in wooden surfaces

GAR010          Always good to grab loot

GAR011          Now this is worth the price of admission

GAR012          Now the bow will shoot fire arrows

GAR013          Now the bow will shoot water arrows

GAR014          Now the bow will shoot moss arrows

GAR015          Now the bow will shoot gas arrows

GAR016          I'd rather not walk out there into the light

GAR017          If I stick close to the walls I have a chance of not being seen

GAR018          I better wait till his back is turned

GAR019          Too many for me to take all at once

GAR020          I'd be better off looking for another way around

GAR021          I shouldn't leave the body lying around

GAR022          Perfect. Only one, and he's looking the other way

GAR023          Just keep looking the other way...

GAR024          I think I lost him

GAR025          I hate blind corners - you never know what you're going to run into

GAR026          It almost always pays to listen at a door before opening it

GAR027          If I can hit him with the blackjack without being spotted, he'll drop without a sound

GAR028          That was bloody. I should move the body, but if someone walks by here they might figure out something’s up

GAR029          Ooh... This is not good!

GAR030          I can pick that guy off with an arrow, but if I miss, I'll give myself away

GAR031          Lots of pyrotechnics but not very stealthy I've got to be careful with those

GAR032          Water arrows are most useful for putting out torches

GAR033          Moss arrows are meant to be fired at noisy surfaces so that I can walk on them without making a racket

GAR034          Not much point in firing those into the floor

GAR035          I should remember that splashing around can make a lot of noise

GAR036          I can't stay underwater too long or I'll drown!

GAR037          I've only got a few seconds of air left!

GAR038          I'll never make any headway against this current!

GAR039          Barrels like these, can provide good cover in a pinch

GAR040          Crates like these are useful for concealment

GAR041          Every key opens something, somewhere

GAR042          Aah, not so secret anymore, is it?

GAR043          Aagh, I'm making too much noise walking on this tile

GAR044          Walking over metal is noisy, I have to be careful

GAR045          I have a bad feeling about this

GAR046          Hmm...this looks interesting

GAR047          I wonder what happened here

GAR048          Looks like this hasn't worked in years

GAR049          I wonder how I can get up there

GAR050          Hmm...there must be a way down there

GAR100          No luck here

GAR101           I'm not opening this

GAR102          Can't get through here

GAR103          Can't go this way

GAR104          Not this way

GAR105          Ah, no point in going here

GAR106          I needn’t bother here

GAR107          Nothing useful this way

GAR108          Nothing back here I care about

GAR110          Doesn't seem to do anything

GAR111          Doesn't do much

GAR120          Hmm…this can't be opened now

GAR121          Looks like I can't open it

GARC0101        Alright old man, lets get you out here and me my money

GARC0103        Good thing you're dying Cutty, or I'd have to kill you for stiffing me, again.

GARHMMM      Hmm...

GARM0101        The keepers were training me to be one of them, but I found other uses for those skills

GARM0201        Hmm...a few too many to try to get by here

GARM0202        Only one guard, still it would be nice to get the drop on him

GARM0203        Inside, at last

GARM0204        Hah! Could you possibly be any more helpful?

GARM0205        Better not leave too many bodies lying around

GARM0206        I wonder if reads them or if it's just for show

GARM0207        Since I'm in here, I might as well pick up something for myself

GARM0208        Hah! It’s a throne room, how pretentious can you get?

GARM0209        Here we go...

GARM0301         I should be near the prison entrance by now

GARM0302        He can't see me while I stick to the shadows, but I'll have to cross into the light to get to the stairs.

GARM0303        Aagh, clanky metal grating, I better tread softly

GARM0304        Blocked from the other side

GARM0305        Hmm, better not let anyone bang that gong, or I'll have more company than I can handle

GARM0306        Heh! Just what the world needs - more hammers

GARM0307        More than one guy, that'll make things trickier

GARM0308        Looks like I'm on the right track

GARM0309        I hate blind corners, you never know what you are going to run into

GARM0310        I have a bad feeling about this

GARM0311        Better stick to the shadows here, if they see me I'm in trouble

GARM0312        Right, cell block 4, Cutty you better appreciate this

GARM0313        This seems too easy

GARM0314        How many guards do they have in here anyway?

GARM0315        But which one is Cutty, and how am I going to get the door open?

GARM0316        Just keep looking the other way

GARM0317        I bet the door controls are in there

GARM0318        Well this was a lost cause, time to get out before I end up in the cell next door

GARM0319        Heh, this must be how they spend all those tithes

GARM0320        I wonder if I have time for to stop for a snack

GARM0321        No point going that way, it'll be crawling with hammers

GARM0322        They take all this stuff way too seriously

GARM0323        If I keep going up, I'm going to run out of building

GARM0324        No good going this way, nowhere to hide

GARM0325        Cutty won't be needing this anymore

GARM0326        Aah, this is what I'm looking for

GARM0327        At least I can swim better than anyone carrying a sledgehammer

GARM0328        So long hammers

GARM0329        Interesting ride, I wonder if any of the hammers take it

GARM0330        Well there's Basso. If he weren't unconscious it would be simpler, but now I have to carry him out

GARM0401        Not my most elegant entrance, but it worked

GARM0402        Felix, you don't look so good

GARM0403        Damn, there has to be another way in

GARM0404        What's that sound?

GARM0405        Whoa! You know you can't take it with you, but I can

GARM0406        The horn of Quintus, I presume?

GARM0407        So this is the fabled horn of Quintus. Hope no one minds if I just take it with me.

GARM0408        So much for Felix, then

GARM0409        Its a long way down

GARM0410        Heh, how rude

GARM0411        Heh, tombs with piped-in music. How classy

GARM0412        Nice view, I wonder if the dead appreciate it

GARM0413        Good thing I'm not afraid of heights

GARM0414        Sounds like I'm getting close

GARM0415        Heh, these guys don't look too mean

GARM0501        So these are Ramirez's boys, I think it's time I dealt with Mr. Ramirez once and for all

GARM0502        It may be time for me to move along now, don't want to wear out my welcome

GARM0503        Maybe I should head back to my own neighborhood, those fellows don't seem too friendly

GARM0504        What sort of a lunatic keeps these things as pets

GARM0505        Damn, I guess I lost their trail

GARM0506        That shot was meant for me

GARM0507        These creeps are going to lead me right back to whoever sent them to kill me, but only if I can tail them without them noticing me

GARM0601        A glass gem, this sword was just a waste of time!

GARM0602        Damn, it’s a fake!

GARM0603        Information on Constantine, almost as good as gold

GARM0604        Time to take my new sword and get out of this crazy place

GARM0605        Magical traps, I guess he's serious about his privacy

GARM0701        Looks like this place was built by my old pals the keepers. I wonder what they're hiding in here

GARM0901        What have we here?

GARM0902        I'm not swimming across there

GARM0903        Creepy

GARM0904        Anybody home?

GARM0905        I wonder if the keepers have seen this

GARM0906        One down, one to go

GARM0907        How can the keepers keep this place a secret?

GARM0908        Looks like this must have been some sort of library

GARM0909        According to the map, this was probably a market place

GARM0910        Time to raid some tombs

GARM0911        I'm not too crazy about the neighbourhood

GARM0912        For me to make use of my map, I'm going to have to find some sort of landmark to go by

GARM0913        So this is the lost city... heh heh, its not lost no more

GARM1001        Damn, I took too much time

GARM1002        I am a wall builder...this is no place to be reading poetry

GARM1003        I am a wall builder, let my walls endure from season to season, year to year, and age to age. Let my walls stand while families toil, armies march and empires fall.  I am a wall builder and my walls will stand always as a shield against evil.  This I pray that will the master builder grant.

GARM1101        I don't like the looks of this

GARM1102        Uh oh

GARM1103        Hmm...

GARM1104        What do we have here?

GARM1105        These stairs have seen better days

GARM1106        Looks like this doesn't work anymore

GARM1107        If I don't get this thing to work, I'm not going to get very far

GARM1108        What was that?!

GARM1109        Now how am I going to get out of here

GARM1110        Oh master builder, we ask thee to bless our brother who hath died in thy service. Forgive him the transgressions of his living days and look with favor on his works in thy name. Pum and plain, fire and forge, purify his spirit and draw from him all which does not meet thy plan. Take him to serve with thee in thy home where he may rest in peace eternal.

GARM1202        Well! This is interesting, but it doesn't say anything about the eye

GARM1203        Wow! Not even the hammers can make heads or tails of this, but it doesn't look good

GARM1301        What happened here, and where are all the Hammerites?

GARM1302        Damn, looks like Constantine got here before me

GARM1303        This looks like it'd make a good escape route for me and the high priest

GARM1401        Well this is my way out, better not mess with it

GARM1402        That can't go anywhere pleasant

GARM1403        All you other demon things, you can just stay home now

GARM1404        Let's not try that again

GARM1405        You’ve gotta be kidding me

GARM1406        Heh... Now that's big!

GARM1407        Ahh... Interesting

GARM1408        I've had enough of this

GARM1409        Let's just disable that portal and give the hammers a fighting chance

Troubleshooting

Problem: I’ve created an object, but for some odd reason, it’s invisible in-game!

Solution: Open it’s properties and Add>Renderer>Has Refs?  Check the box and hit OK.

Problem: My conversation isn’t working!

Solution: Make sure the conversation has the script: “TrapConverse”, that it has the property “SaveConversation” and that that’s set to TRUE, and make sure that there’s something controlling the conversation, and make sure that the conversation has AIConversationActor flavour links forwards from the conversation to the actors, with the proper data number.  With this in mind check in your “Conversation” property to see if the “Actor” drop-downs are set right.  Also check to make sure that the actor you’re trying to make talk has the right voice property (Add>Speech>Voice), and make sure that if the motions aren’t working, the motions are entered in correctly, with a space between the word and the “0”, and with a space after the comma:

Conversation 0, Foo 0

Also, ensure that the AIConversationActors are contained within a roombrush…if they are, and it still doesn’t work, try processing the AI Room Database.

Problem: My DROMED window is 640x480 even though my screen resolution is 1600x1200!

Solution: Open up the file “User.cfg” under “Thief” in notepad, and add the following line: “edit_screen_size 1024,768”.  Make sure the resolution is always one step lower than your screen size, otherwise DROMED will run off the edges, for example, if you’re screen resolution is 1024x768, add this line: “edit_screen size 800,600”.

Problem: My screen resolution is 1024x768, but I can’t see the bottom of the AIWatchObj dialog!

Solution: Unless you have a HUGE monitor (21” or higher) I wouldn’t recommend going to 1600x1200, so just make sure you don’t have any dialogs selected (no drop-downs highlighted in blue) and hit ENTER to dismiss the dialog…same with Responses or Conversations.

Problem: DROMED keeps crashing, telling me that I have too many polygons!

Solution: Open up “dark.cfg” in notepad, and add this line: “max_polygons 99999”.  (Make sure you include the new “dark.cfg” in your DarkLoader archive, though.)

Problem: Everything’s messed!

Solution: Open DarkLoader (if installed) and “Install Only” “Thief 1”…if that doesn’t work, back up all your custom files (gamesys, levels, dark.cfg, user.cfg, custom sounds and schemas, saves) and then uninstall Thief and DROMED.  Then re-install.

Problem: I played an FM with DarkLoader, and now everything is totally messed-up in DROMED!

Solution: Go into DarkLoader, select the top mission option (is the default campaign) and click “Install Only”.  Once it’s finished, close DarkLoader and open DROMED.  Do this each time you play an FM.  Remember that save-games for each FM are saved when you un-install them!

Problem: I’ve created a custom door…but it’s got this black box, so I can’t see the door!

Solution: Go into the door’s properties, edit the Door property and uncheck: “Blocks Vision?”.

Problem: Things aren’t working the way they’re supposed to be…my doors aren’t frobbable…etc..

Solution: Make sure you’ve loaded ConVict (script_load convict).

Problem: I type “load_script convict” into the command window, and DROMED tells me that there’s no such command!

Solution: The command is actually “script_load convict”.

Problem: I have two separate installations of Thief, one has DROMED and the other doesn’t.  I’ve installed DarkLoader on my non-DROMED copy, and the FMs don’t work, everything is non-frobbable, the weapons don’t appear, etc..

Solution: Copy the file “convict.osm” from your DROMED copy of Thief’s main folder, to your DarkLoader copy’s folder.  Like DROMED, FMs can’t run without the convict scripts.

Problem: I have a large area, and my solids are starting to disappear when viewed from far away!

Solution: Either decrease the size of the outdoor area, or use other buildings so the player can’t see far-off solids…sorry, that’s the only way, the Dark Engine wasn’t designed for spacious outdoors, it was designed for claustrophobic indoors!

Problem: Everything is blurring.

Solution: You either have too big an open space, so decrease the size, or you have too many solid brushes contained within an air brush…cut back.

Problem: My water is Jorge…

Solution: Is your water flowbrushed?  If not, flowbrush it, if so, does that incriminating flowbrush share the same center as a solid brush?  Or is the flowbrush’s center in solid?

Problem: My mission crashes when I try to DarkLoader it.

Solution: Be sure that your mission has objectives, be sure that “VictoryCheck” is in place on your StartingPoint, make sure “missflag.str” is intact.

Afterword

Well, congratulations!  You are now an officially qualified DROMEDer!  Go out, create your own FMs, use my knowledge well!  And don’t forget to check out Lord Bafford the Tafford, and my other FMs!

Also, don’t be afraid to use the “DROMED” button in DarkLoader to check out other people’s FMs to see how they did things!

Don’t be afraid to download unstripped versions of the OMs and look around at them!

Don’t be afraid to create FMs and release them to the FM community!

And remember, no matter how outdated, there will ALWAYS be loyalists to TDP.  Not all of us run off and abandon Thief’s origins to play T2, a story of insane cultists, which doesn’t even begin to compare with TDP’s story!

And remember, if you have TDP and yearn for TG, download the patch from http://www.thief-thecircle/teg-old/tools/, unstripped versions of the OMs (the missions that ship with Thief) can be found here, so that they can be examined and/or have an FM based on them.  For example, ASSASSINS is a particularly popular mission for an FM to be based on because of the popular cityscape.  Examples are “Lorgan’s Web” and “The Gem”. 

If you have ANY questions, or wish to suggest additions, e-mail Spike14, author, at spike14dromed@yahoo.com
Check out my website, home of BaffTaff, at http://www.dromed.tk
Remember to experiment with DROMED, write your own tutorials, AND, experiment with insane ideas, remember, this is DROMED, the editor that wasn’t supposed to be released to the public, we had to petition for it, and remember that DROMED is UNSUPPORTED!  Neither Eidos Interactive, Looking Glass Studios, nor Activision Publishing provides technical support of any kind for DROMED.

If you need help, go to DROMED Central, or Through the Looking Glass forums!

I look forward to seeing your FMs, and seeing your tutorials and ideas at TTLG, and DROMED Central!

And remember, TTLG is always looking for new members to its VERY friendly community!  Sign-up, post, help other newbies (and oldies) out.  You’ll be surprised what can be dreamt up in a single discussion thread!  Sometimes it’s slow, but it’s worth it!

Note: If you have NO IDEA where to look for FMs check out The Keep of Metal and Gold!  Thanks KoMaG!  Or http://www.thiefmissions.com/ for epithumia’s Cheap Missions Download Site.  If you cross-reference between these two sites, you can grab EVERY FM TO DATE!  Have fun playing other people’s FMs, and opening them up in DROMED to see how they were done!

DROMED is obsessive…you know what you’re getting into.

Oh, yes, remember not to cross the streams…also remember that DROMED IS UNSUPPORTED!  I can’t re-iterate this point enough…you asked for it.

Legal Stuff

This tutorial is copyright Spike14.

Distribution and or publication of this tutorial without the express permission of the aforementioned copyright holder is expressly forbidden!

If a person should violate this agreement, he/she shall find themselves the focal point of legal action.

Please do not proceed with the distribution or publication of this tutorial until you see permission in this section of the tutorial as hosted at the following URL:

http://www.jasonotto.net/tutorials/Hosted/Tuts/CompeteTut.htm
When visiting this site to check for updates, be sure to click “Refresh”.

If you should use any of the methods described in this tutorial, thanks in the readme for the FM in question would be appreciated, but is only necessary on in the first FM these methods are used in, after that, including thanks in the readme is unnecessary but appreciated nonetheless.

Jason Tibbits AKA epithumia has express permission to host my tutorial at the following URL:

http://www.thiefmissions.com/tutorials/Spike14CompleteTutorial.html
MadBull#34 has express permission to host this tutorial here:

www.thiefworld.de.vu
He also has permission to translate this tutorial into German.

Balan Sergey has permission to host here:

http://thief-darkfate.narod.ru
He also has permission to translate this tutorial into Russian.

Spike14 can be contacted here: spike14dromed@yahoo.com
Or here: http://www.dromed.tk
Keep in mind that neither Activision Publishing, Spike14, Eidos Interactive, nor the deceased Looking Glass Studios, nor TTLG nor any of it’s descendant sites/employees/members/volunteers takes any responsibilities for the consequences of DROMED, FMs, ConVict, or Fan-Made Tools usage on your computer, you, your family, you friends, your school/business/organization, or your property.

DROMED is obsessive…you’ve been warned.  You know what you’re getting into.

